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Preface 

Software Philosophy 
TDT’s philosophy on software development is simple.  We design 
comprehensive drivers that control all aspects of the hardware from circuits 
developed in a drag-and drop circuit design environment.  With minimal 
programming, scientists can design customized experiments.  This approach 
works quite well in most research environments.  However, there has been an 
increasing demand for an interactive environment that allows the auditory 
researcher to design custom signals, present stimulus signals, and gather 
response data.  In response to this need, TDT has raised its approach to software 
development to a higher level by designing two powerful and flexible software 
packages, SigGenRP and BioSigRP.  SigGenRP offers a signal generation 
environment that is above the level of ‘C’ or Pascal programming.  It is a 
complete stimulus design application that is the basis for a suite of TDT 
programs specifically developed for auditory research.  BioSigRP provides the 
user with an easy-to-use, yet flexible, means for presenting stimulus signals and 
collecting response data. 

Traditionally, systems designed to present stimulus signals and acquire response 
signals have been of two types:  turn-key clinical systems and custom systems 
written from scratch.  With turn-key systems, type and frequency of stimulus 
signals are restricted.  Such systems are good for clinical settings, but are too 
restricted for research.  Custom systems, while providing the ability to control 
all aspects of stimulus presentation and data acquisition, often require tedious 
hours spent programming and debugging software.  Because BioSigRP utilizes 
custom signals generated in SigGenRP, it allows users to design and present 
complex stimulus signals without writing a line of code. 

As with all software applications, SigGenRP and BioSigRP have their inherent 
limitations.  For this reason, TDT still maintains as its highest priority continued 
support of its software drivers. 
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Organization of the Manual 
The BioSigRP User’s Guide is divided into three parts:  

+ Part 1 BioSig Fundamentals 

+ Part 2 Illustrative Examples 

+ Part 3 Appendices

BioSigRP Fundamentals 
Part 1, BioSigRP Fundamentals, presents all the basic BioSigRP concepts 
necessary to present a stimulus signal and acquire data.  It also serves as a 
general reference tool.  Part 1 provides: 

 General information about BioSigRP. 

 Basic information about BioSigRP's features. 

 A detailed explanation of data acquisition and processing. 

General Information 
General Information includes a description of the purpose and uses of BioSigRP, 
BioSigRP installation instructions, and basic BioSigRP concepts.  General 
information is presented in the following chapter: 

 Chapter 1   Introduction 

Basic Information 
Basic information about BioSigRP’s features is provided in the following 
section: 

 Chapter 2   Learning the Basics 

Data Acquisition and Processing 
The steps required to acquire and process data are listed below along with their 
associated chapter. 

Step Chapter 

1. Configure the system Chapter 3   Configuration  

2. Present the stimulus and acquire 
response data 

Chapter 4   Data Acquisition 

3. Analyze data Chapter 5   Data Analysis 
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Illustrative Examples 
Some typical examples of data acquisition and processing are presented in: 

 Chapter 6   Quick Start Examples 

 Chapter 7   Advanced Examples 

Appendices 
Additional information for System II and System 3 is presented in: 

 Appendix A   Using BioSigRP with System II 

 Appendix B   Eliminating 60 Hz Noise  
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Chapter 1   Introduction 
Welcome to BioSigRP, TDT’s windows-based stimulus presentation and data 
acquisition package.   

What Is BioSigRP? 
BioSigRP is a powerful, yet easy-to-use, tool designed to automate the process 
of presenting stimulus signals and acquiring response signal data.  BioSigRP is 
part of a suite of TDT applications designed to work with System 3 hardware 
and files generated by TDT’s signal design software, SigGenRP. 

BioSigRP for Windows 
BioSigRP for Windows was created for today’s preferred PC environment.  It 
combines the advantages of Windows support with the advanced capabilities of 
TDT’s System 3 hardware.  BioSigRP uses standard Windows techniques for 
saving and loading files, selecting parameters, and printing.   

BioSigRP Capabilities 
BioSigRP is especially designed to meet the needs of auditory scientists.  
BioSigRP’s capabilities include: 

 SigGenRP file support 

 System calibration 

 Stimulus schedule customization 

 Dual-channel stimulus 

 Multi-channel response 

 Artifact rejection 

 Averaging 

 Stimulus schedule override 

 Historical data display 

 Comparison data 

 Calculator 

 Displays 

 Cursors  

 Report generation 
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SigGenRP File Support 
BioSigRP takes advantage of the powerful signal generation capabilities of 
TDT’s SigGenRP.  BioSigRP reads SigGenRP files (.sig files) and uses the 
signal parameters stored in these files to generate stimulus signals over 
successive SigGenRP Indices (SGIs). 

System Calibration 
BioSigRP’s System Calibration window provides a means for calibrating your 
system through use of a pure tone or through use of the actual stimulus signal.  
Microphone effects may be removed to determine the true frequency 
characteristics of the system. 

Stimulus Schedule Customization 
The manner in which stimulus variables change as a function of the SGI is 
stored in the SigGenRP file.  BioSigRP reads this information to determine the 
stimulus schedule.  You may customize this schedule from within BioSigRP. 

Dual-Channel Stimulus 
BioSigRP allows you to present dual-channel stimuli. Each channel may be 
assigned its own SigGenRP file. 

Multi-Channel Response 
BioSigRP allows you to acquire up to four channels of response data. 

Artifact Rejection 
BioSigRP’s artifact rejection provides a means for rejecting signals with 
anomalous amplitude values. 

Averaging 
BioSigRP maintains a running average as signals are acquired.  BioSigRP 
allows you to view this running average.  Averaging continues until the desired 
number of signals are acquired. 

Stimulus Schedule Override 
BioSigRP provides several command functions that allow you to manually 
override the stimulus schedule during stimulus presentation.  These functions 
include:  Advance, Skip, Repeat, and ReDo. 

Historical Data Display 
As averages are completed, resulting waveforms are displayed in an area of the 
screen known as the History Plot and are also appended to a file known as the 
BioSigRP Record file (.arf file). 
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Comparison Data 
You may choose a record from the History Plot to serve as a comparison record.   

Calculator 
Through use of the Calculator, you may perform a variety of mathematical 
operations on acquired data. 

Displays 
You may view any record displayed in the History Plot in more detail.  
BioSigRP provides two detailed displays:  a detailed Time-Domain Plot and a 
corresponding Frequency-Domain Plot.  Additionally, you may zoom-in on any 
portion of either display. 

Cursors 
BioSigRP allows you to obtain information about instantaneous level at various 
points in time through the use of cursors. 

Report Generation 
You can generate custom reports consisting of historical signal data.  The 
Worksheet area of the BioSigRP main window may be used to build these 
reports. 

Hardware Support 
BioSigRP supports TDT’s System 3 instrumentation, including TDT’s Real-
time processors and programmable attenuators.  BioSigRP also continues to 
support the System II hardware platform.

Who Can Use BioSigRP? 
Anyone with a PC, Windows 2000 or higher, and TDT System II or System 3 
instrumentation can use BioSigRP.  BioSigRP was designed to meet the needs 
of auditory scientists requiring the use of complex stimuli without complex 
programming. 

BioSigRP can be used to collect and analyze data such as auditory brainstem 
response (ABR) data and otoacoustic emission data. 
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How to Use BioSigRP 
BioSigRP is used in conjunction with TDT’s signal generation package, 
SigGenRP.   

 

 

BioSigRP enables you to acquire and process bioelectric signal data in response 
to a customized stimulus signal.  The process is as follows: 

1. Design the stimulus signal using SigGenRP. 

TDT’s signal generation package, SigGenRP, provides a simple, yet 
powerful, means for designing your stimulus signals.  Signals generated 
with SigGenRP may be saved as SigGenRP files (.sig files) for use with 
other TDT signal processing applications, including BioSigRP. 

2. Acquire and process response signal data using BioSigRP. 

BioSigRP is an easy-to-use tool for acquiring and processing response 
signal data.  The process is relatively simple: 

a. Configure BioSigRP. 

b. Present the stimulus signal. 

c. Acquire response data. 

d. Analyze and process the response data. 

Before You Begin 
With a bit of preparation, processing signals with BioSigRP is quick and easy. 

BioSigRP 
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What You Need 
 
See your Microsoft 
Windows 
documentation. 
 
 
See Digital Signal 
Processing 
Applications, 
Chapter 1. 
 
See SigGenRP User’s 
Guide, Chapter 2, 
“How to use 
SigGenRP.” 

 Windows fundamentals   

 You should be comfortable with Windows basics:  starting Windows; 
using the mouse; manipulating windows; opening, closing, and saving 
files; and selecting items from a list. 

 Signal processing  

 A basic knowledge of signal processing is necessary.  You should 
understand the parameters necessary for specification of a signal in the 
frequency and time domains.   

 Basic SigGenRP concepts 

 You should be comfortable with signal design using SigGenRP and should 
recognize the term SigGenRP Index. 

Installing the Software 

Requirements 
In order to run BioSigRP, you must have the following: 

 Computer running windows 2000 or higher 

 TDT drivers (4.2 or higher) 

 SigGenRP 

 Super VGA (1024 x 768) resolution graphics (recommended) 

 Two System 3 RPx devices (RP2, RP2.1, or Medusa amplifiers). RPx 
devices must be in the same caddie. (See Appendix A for System II 
requirements.) 

Installation 
To install BioSigRP 
1. Make sure your TDT hardware is installed and functioning properly. 

2. Refer to the System 3 Installation Guide. 

3. Insert the software CD in to your CD-ROM drive. 

4. Click Install TDT drivers, click System 3, and click Install BioSigRP. 

Hardware Configuration 
BioSigRP uses System 3 hardware devices to acquire and average signals.  
System 3 hardware allows for increased flexibility in acquisition.  Users and 
TDT can develop acquisition circuits for Oddball responses, MMN, P300, as 
well as generate Standard Deviations around the mean response.  BioSigRP and 
SigGenRP allow users to view signal responses to complex stimulus patterns.   

Note: To learn more about how to generate RCO files for acquisition in 
BioSigRP please contact TDT. 
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BioSigRP was designed to work with TDT’s powerful and flexible System 3 
hardware.  All System 3 configurations must include two RPx devices:  

 RPx device for acquisition (must have analog inputs) 

 RPx device(s) for signal generation (must have analog outputs) 

Note: all configurations must include separate devices for stimulus and 
acquisition. 

The exception to the above minimum configuration requirements is a 
configuration for acquisition only, which may use an external trigger and does 
not require a separate RPx device for stimulation. 

The minimum configuration may be expanded in a variety of ways.  Below are 
examples of three configurations. 

Minimum Configuration 
The minimum System 3 configuration is illustrated below.  In this system two 
RP2.1s provide analog to digital and digital to analog conversion. 

 

Typical ABR Configuration 
Most systems require more functionality than that provided by the minimum 
configuration.  A typical System 3 configuration for ABRs is illustrated below.   

 
In this system an RP2.1 provides digital to analog conversion and an RA4LI or 
Medusa Base Station, Preamp, and Headstage provides data acquisition and 
analog to digital conversion. The two PA5s provide programmable attenuation 
for two stimulus channels.  The ED1 drives TDT’s ES1 or EC1 electrostatic 
speakers to present the stimulus.  The HB7 Headphone Buffer or SA1 Speaker 
Amplifier can be substituted for the ED1 to support other transducers. 
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Typical DPOAE Configuration 
A typical System 3 configuration for DPOAEs is illustrated below.   

In this system one RP2.1 provides stimulus generation and another PR2.1 
provides signal acquisition. The two PA5s provide programmable attenuation 
for two stimulus channels.  The ED1 drives TDT’s EC1 electrostatic speakers to 
present the stimulus.  The HB7 Headphone Buffer or SA1 Speaker Amplifier 
can be substituted for the ED1 to support other transducers, such as the ER2C.  
The MA3 provides amplification for the incoming signal.   

 

Using RX Devices with BioSigRP 
BioSigRP has been designed to work optimally with the RP2.1 Real-time 
Processor and RA16BA Medusa Base Station. RX processors, such as the RX6, 
may also be used; however, there are several issues that should be addressed. 

See tech note #840 regarding RX device configuration for more information. 

Voltage Scaling and Atrifact Rejection 
In BioSigRP, voltage scaling is implemented based on the voltage input range of 
the selected acquisition device. When using an RX device for acquisition, 
BioSigRP assumes that the input voltage range is +/- 10 V. However, when 
using the Medusa Preamplifier with the RX devices, the voltage range is +/- 4 
mV. This discrepancy between the actual and expected voltage range renders the 
artifact rejection feature ineffective. The smallest artifact detectable would be 
1% of 10 V or 100 mV. This is well outside the possible range of values that can 
be acquired from the Medusa preamplifier.  

http://www.tdt.com/technotes/0840.htm
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RX Channel Numbering 
The standard circuit files use channels 1 and 2 to acquire analog signals during 
DPOAE recordings. The analog input channels on the RX6 are numbered 128 
and 129. When using the RX6 for DPOAE acquisition, the analog input channel 
numbers must be modified in the recording circuits. See the RPvdsEx Manual 
for information on using RPvdsEx for circuit design or contact TDT Support for 
assistance. Channel configurations on the RX8 can vary; refer to your individual 
configuration for channel numbering. 

Digital Output Control 
Digital control bits are not automatically configured for RX devices. Digital I/O 
on many RP devices (including the RP2 and RA16BA) do not need to be 
configured and will output the digital control signals from the standard stimulus 
and acquisition circuits. In order for an RX device to correctly output these 
signals, the device configuration register must be set to output the necessary bits.  

 

RX Delays 
The delays associated with RX devices are different from those associated with 
the RP2 and this can affect the apparent latency of a biological signal. Most of 
the differences in delays are negligible. The most apparent difference occurs 
when using the RX6 for stimulation; however, this latency becomes less 
significant as the sample rate increases. See the hardware specifications in the 
System 3 Manual for more information on DAC or ADC delays associated with 
each device. 
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Chapter 2   Learning the Basics

Getting Started 

Starting BioSigRP 
 

 

To start BioSigRP 
 Double-click the BioSigRP icon. 

    or 

 Click the Start menu, point to Programs, point to TDT Sys3, and click 
BioSigRP. 

The BioSigRP main window opens.  

You are now ready to acquire data with BioSigRP. 

Getting to Know the BioSigRP Main Window 
BioSigRP’s main window is designed to provide customizable visual displays of 
the stimulus signal, raw response signals, running averages, history data, and 
reports. 

The Start-up Window 
Upon starting BioSigRP, you will see the main BioSigRP window.  If you are 
running BioSigRP for the first time, the main window will appear in its default 
layout, as seen below. 
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The window contains the following sections: 

Title Bar   Displays “BioSigRP32 Windows Application” and the name of the 
current BioSigRP file. 

Menu Bar   Contains a list of menus used for building, manipulating, and 
saving your BioSigRP file. 

Toolbar   Provides easy-to-use icons for the most common BioSigRP Menu 
commands. 

Multi-Purpose Plot   May be used to display a plot of the stimulus signal, the 
raw A/D signal, the FFT of the signal, the EEG signal, or the running average. 

History Plot Area   Is used to display historical, averaged signal data. 

For a review of the 
SigGenRP Index (SGI) 
see the SigGenRP 
User’s Guide. 

Current Info   Displays the current SigGenRP Index (SGI) plus variable names 
and their current values. 

History Info   Displays Group information.  Responses obtained during the 
same data acquisition session are collectively referred to as a Group.  Groups 
are automatically sequentially numbered.  For each History Plot record, the 
names and values of variables are displayed.   

Calculator   Allows you to perform mathematical operations on one or more 
Worksheet record. 

Worksheet   May be used to store records for use in calculations and to build 
reports. 

Sizing Bars   Allow the user to resize each area of the screen. 

Status Bar   Provides information about the selected command. 

The Customized Window 
BioSigRP provides numerous displays.  Depending on your needs, you may 
wish to enlarge some displays and reduce others.   

Status Bar 

Title Bar 

Menu Bar 

Toolbar 

History 
Info 

History 
Plot Area 

Worksheet 

Sizing 
Bars 

Muli-Purpose Plot 

Calculator 

Worksheet Buttons 

Current Info 
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To enlarge/reduce a display area 
1. Drag the appropriate Sizing Bar. 

Below, the BioSigRP main window is configured to provide more room in the 
Worksheet area.  The Calculator area has been expanded so that most calculator 
and worksheet buttons are visible. 

 

Using the BioSigRP Menus 
BioSigRP provides the user with a full set of menu commands.  From these 
menu commands, you can create, open, and save files; customize screen 
displays; present stimulus signals; acquire response data; and analyze data. 
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The File Menu 

 

The File Menu provides a standard Windows method for creating, saving, 
opening, closing, and printing files. 

New Config.   Resets all screen objects to their default states and clears all plots. 

Open Config. File...   Opens and displays an existing BioSigRP configuration 
file (.acf file). 

Save Config.... and Save Config. As...   These menu options save BioSigRP 
configuration data in a BioSigRP configuration file.  Files saved with this format 
use the default extension .acf.   

Print...   Prints the current Worksheet Area. 

Print Preview   Allows you to view the Worksheet Area as it will be printed. 

Print Setup...   Allows you to select a printer, define the paper size, and choose 
a page orientation. 

The Setup Menu 

 

 
 

From the Setup Menu, you can define stimulus 
and acquisition parameters, calibrate the system, 
schedule stimulus presentation, enter subject 
information, and customize the BioSigRP 
interface. 
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Stimulus...   Opens the Stimulus Setup dialog box.  From this box you can 
specify up to two SigGenRP stimulus signals and define presentation 
parameters. 

Acquisition...   Opens the Acquisition Setup dialog box, from which you can set 
timing parameters, define the default record file (.arf file), and configure up to 
four acquisition channels. 

Calibration...   Not currently supported. 

DB4 Bioamp   Not used for System 3. 

SigGenRP Variables...   Opens the SigGenRP Variable Control dialog box.  
From this dialog box, you can customize stimulus presentation. 

Subject Info...   Opens the Subject Information dialog box.  This dialog box 
contains fields where you may enter identifying information for the subject. 

Default Cursor Strings...   Opens the Specify Default Cursor Text dialog box, 
from which you can customize cursor labels. 

Auto-Cursors...   Allows the user to specify the location of up to 10 cursors.  
These cursors will be automatically placed during data acquisition. 

History Info Window...   Opens the Info-Bar Setup dialog box, from which you 
can customize the History Info display area. 

General Display Ops...   Opens the General Display Options dialog box.  From 
this dialog box, you may customize background colors, plot colors, text colors, 
and other display characteristics of the main window, Multi-Purpose Plot, and 
History Plot. 

Worksheet Display Ops...   Opens the Worksheet Display Options dialog box.  
From this dialog box, you may customize various display features of the 
Worksheet. 

Layout   Allows you to customize the screen layout. 

Use #1, Use # 2, Use #3   Allow you to switch between three custom defined 
screen layouts. 

To Default   Returns the screen layout to its initial, default layout. 

Lock   Allows you to lock the current screen configuration. 
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The Operations Menu 

  

Idle Running 

The Operations Menu provides a list of commands that control the presentation 
of the stimulus signal and the acquisition of response signals.  Menu options 
vary, depending on the current operational mode.  Operational modes consist of 
the following: 

 Idle 
 No stimulus presentation or data acquisition. 

 Running 
 Stimulus is being presented. 

 Averaging 
 Response data is being acquired and averaged. 

 Paused 
 Data averaging has been temporarily suspended. 

Start:  Begins the presentation of the stimulus signal.  This menu option appears 
in Idle mode only. 

Stop:  Discontinues the presentation of the stimulus signal.  This menu option 
appears in Running mode only. 

Begin:  Begins the process of data acquisition and signal averaging.  This menu 
option appears in Running mode only. 

End:  Discontinues data acquisition and signal averaging.  This menu option 
appears in Averaging mode only. 

Pause:  Temporarily halts data averaging.  This menu option appears only in 
Averaging mode. 



   Chapter 2: Learning The Basics 2-7 

  BioSigRP User's Guide 

  

Averaging Paused 

Resume:  Resumes data averaging.  This menu option appears only in Paused 
mode. 

Advance:  Causes the stimulus to advance to the next SGI.  This menu option is 
enabled in Averaging and Paused modes. 

Skip:  Causes the stimulus to skip the current SGI.  This menu option is enabled 
in Averaging and Paused modes. 

Repeat:  Saves the current running average, re-presents the same stimulus, and 
saves the resulting averaged signal.  This menu option is enabled in Averaging 
and Paused modes. 

ReDo:  Discards the current running average, re-presents the same stimulus, and 
saves the resulting averaged signal.  This menu option is enabled in Averaging 
and Paused modes. 

Continuous:  Enables continuous data acquisition.  BioSigRP will continue to 
acquire and average response data for the same stimulus until Continuous is 
disabled or the Advance, Stop, Repeat, ReDo, or End buttons are clicked. 

Repeat Each SGI:  Acquires two averaged signals for each SGI specified in the 
stimulus schedule. 

Threepeat Each SGI:  Acquires three averaged signals for each SGI specified 
in the stimulus schedule. 

Manual SGI Control:  Enables the Next SGI and Previous SGI buttons and 
menu options.  These buttons can be used to manually control the SGI. 

Next SGI:  Advances the stimulus to the next SGI  

Previous SGI:  Moves the stimulus back to the previous SGI. 

Modify Schedule:  Opens the SigGenRP Variable Control dialog box.  From 
this dialog box, you can customize stimulus presentation. 
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Impedance Scan:  Not used with System 3. 

Impedance Check:  Not used with System 3. 

The View Menu 

 

From the View Menu, you can turn various visual displays on or off. 

Tool Bar:  Shows/hides the Tool Bar. 

Status Bar:  Shows/hides the Status Bar. 

Dyn Controls:  Displays all active Dynamic Control windows. 

Expand Scale:  Expands the scale of the focus plot. 

Reduce Scale:  Reduces the scale of the focus plot. 

Auto-Scale:  Automatically scales the focus plot. 

 
 
 
Whenever you click in a 
plot area, that plot 
receives the focus.  
Focus is indicated by a 
thin frame of highlight 
surrounding the plot 
area.  Plot commands 
affect the focus plot, 
only. 

Toggle Chan – 1:  Shows/hides Channel 1 on the focus plot. 

Toggle Chan – 2:  Shows/hides Channel 2 on the focus plot. 

Toggle Chan – 3:  Shows/hides Channel 3 on the focus plot. 

Toggle Chan – 4:  Shows/hides Channel 4 on the focus plot. 

Only Chan-1:  Shows only Channel 1 on the focus plot. 

Only Chan-2:  Shows only Channel 2 on the focus plot. 

Only Chan-3:  Shows only Channel 3 on the focus plot. 

Only Chan-4:  Shows only Channel 4 on the focus plot. 
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The Multi-Plot Menu 

 

From the Multi-Plot menu, you can specify which signal you would like to 
display in the Multi-Purpose Plot. 

Nothing:  Causes no plot to be displayed in the Multi-Purpose Plot. 

Stimulus:  Causes the current stimulus to be displayed in the Multi-Purpose 
Plot. 

Raw Input:  Causes one or more channels of raw (unprocessed) input signal to 
be displayed in the Multi-Purpose Plot. 

Time/Freq:  Performs an FFT on the incoming time-domain signal, producing 
frequency-domain response data. 

EEG: Causes one or more channels of EEG signal to be displayed in the Multi-
Purpose Plot.  EEG signals are created by applying the specified acquisition 
setup parameters to raw input signals. 

Running Average:  Causes the running average to be displayed. 

Show Comparison:  Causes the currently defined comparison plot to be 
displayed superimposed with the running average.  Running Average must be 
selected in order to view the comparison plot. 
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The History Menu 

 

From the History Menu, you can load history records and perform various 
operations on records displayed in the History Plot. 

Access Record File:  Loads previously saved BioSigRP records from files 
known as BioSigRP record files.  These files use the default extension, .arf.  
BioSigRP records are displayed in the History Plot Area. 

Previous Group:  Scrolls the History Plot to the top of the previous group. 

Next Group:  Scrolls the History Plot to the top of the next group. 

To Top:  Scrolls the History Plot to the top. 

To End:  Scrolls the History Plot to the bottom. 

Clear Selection:  Clears all selected records from the History Plot. 

Clear All:  Clears all records from the History Plot. 

Edit Cursors:  Accesses the BioSigRP Cursor Edit dialog box.  From this 
dialog box, you may place cursors and obtain signal information. 

Toggle Cursor:  Marks the most recently selected history record for use as a 
comparison when viewing records details from the history area. 

To Worksheet:  Allows you to place the most recently selected history record 
in the Worksheet. 

Export to ARF File:  Saves the currently selected history records in a user-
defined BioSigRP record file (.arf file). 

Export to ASCII File:  Saves the currently selected history records in a user-
defined ASCII file (.txt file). 

Export to CSV: Saves the currently selected history records in a user-defined 
CSV file. 

Show Cursors:  Displays any cursors placed in History Plot records. 
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Pile Channels:  Overlays multiple channel history data. 

AutoCursor:  Applies the selected auto cursor to the selected history record. 

The Worksheet Menu 

 

Clear Worksheet:  Clears the entire Worksheet. 

Open Worksheet:  Opens a Worksheet file (.awf file). 

Save Worksheet:  Saves an existing Worksheet file. 

Save Worksheet As:  Save a new Worksheet file. 

Export to Ascii:   Saves the currently selected records in a user-defined ASCII 
file (.txt file). 

Export to CSV: Saves the currently selected records in a user-defined CSV file. 

Configure 

Worksheet Defaults:  Allows you to set Worksheet preferences such as colors, 
plot size, and grid resolution. 

Trace:  Displays a message describing how to edit a trace. 

Token:  Displays a message describing how to edit a token. 

Space Evenly:  Spaces selected plots evenly throughout the Worksheet. 

Spread Apart:  Spreads selected plots apart.  Spread Apart may be used 
repeatedly.  Each use continues to further spread apart all selected plots. 

Squash Together:  Squashes selected plots together.  Squash Together may be 
used repeatedly.  Each use continues to further squash together all selected plots. 

Pile:  Piles selected plots on top of one another. 

UnPile:  Unpiles selected plots. 
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Delete:  Deletes the currently selected Worksheet records. 

Select All:  Selects all Worksheet records. 

Deselect All:  Deselects all Worksheet records. 

Toggle Comparison:   Marks the most recently selected worksheet record for 
use as a comparison in the worksheet. 

The Calculator Menu 

 

The Calculator Menu provides mathematical operations that may be applied to 
one or more records displayed in the Worksheet. 

Scale:  Multiplies each point in the selected Worksheet record(s) by a specified 
constant. 

Invert Trace:  Multiplies each point in the selected Worksheet record(s) by -1. 

Shift Baseline:  Creates a DC offset by adding a specified constant to each point 
in the selected Worksheet record(s). 

Remove Baseline:  Removes the DC offset. 

Zero Points:  Sets all points within a specified time range to zero. 

Crop Trace: Crops the selected trace from the specified starting point (ms) to 
the specified ending point (ms). 

Add:  Adds two or more Worksheet records. 

Subtract:  Subtracts one Worksheet record from another. 

Average:  Computes the average of two or more Worksheet records. 
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Time Align: Aligns all selected records with the first record in the selected 
group. 

Time Shift:  Shifts the selected Worksheet record(s) along the time axis. 

Smooth:  Applies a smoothing algorithm to the selected Worksheet record(s). 

Lowpass Filter:  Applies a low-pass filter to the selected Worksheet record(s). 

Highpass Filter:  Applies a high-pass filter to the selected Worksheet record(s). 

Bandpass Filter:  Applies a band-pass filter to the selected Worksheet 
record(s). 

Notch Filter:  Applies a notch filter to the selected Worksheet record(s). 

Hanning Window:  Generates a Hanning window for use with the magnitude 
spectrum. 

Cosine^2 Window:  Generates a Cosine^2 window for use with the magnitude 
spectrum. 

Mag Spectrum:  Does a FFT and generates a magnitude spectrum of the data. 

AutoCursor:  Applies the selected auto cursor to the selected worksheet record. 

The Help Menu 

 

From the Help Menu, you can access the About BioSigRP dialog box.  On-line 
help is not available as of this version. 
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The Toolbar 
On the BioSigRP Toolbar, you can find quick point-and-click access to the most 
common commands.      

Click  To 
 

 

 

New  
 

Clear all plots and reset BioSigRP to its default 
configuration 

 
Open Open an existing BioSig file 

 
Save Save a BioSig file 

 
BioSig 
Records 

Load records stored in a .arf file 

 
Worksheet 
Records 

Load an .awf file 

 
Setup 
Stimulus 

Define stimulus parameters 

 
Setup 
Acquisition 

Define acquisition parameters 

 
Setup 
Bioamp 

Not used with System 3 

 
Calibrate Not currently supported 

 
Modify 
Schedule 

Modify the Stimulus Schedule 

 

 

 

General 
Display 

 

Configure general display fonts and colors 

 
Worksheet 
Display 

Configure Worksheet display fonts and colors 

 
Setup #1 Switch the screen layout to #1 

 
Setup #2 Switch the screen layout to #2 

 
Setup #3 Switch the screen layout to #3 

 
Clear All Clear all plots and screen areas 

 
Lock Lock the screen layout 

 
Print Print the current history plot 

 
Help Access on-line help 

 
Context-
Sensitive Help 

Access context-sensitive help 

    

 



   Chapter 2: Learning The Basics 2-15 

  BioSigRP User's Guide 

 
 
Whenever you click in a 
plot area, that plot 
receives the focus.  
Focus is indicated by a 
thin frame of highlight 
surrounding the plot 
area.   

The Plot Control Toolbar 
The various BioSigRP plot areas are controlled through the use of the Plot 
Control Toolbar.  This toolbar is normally invisible.   

The Plot Control Toolbar may be used to control the plot area that currently has 
the focus.   

To display the Plot Control Toolbar 
 Place the mouse pointer within the plot area of interest and hold down the 

right mouse button. 

The Plot Control Toolbar will remain displayed while the right mouse 
button remains depressed. 

 

To click a Plot Control Toolbar button 
1. With the right mouse button depressed, place the mouse pointer above the 

desired toolbar button. 

2. Release the right mouse button. 

The button will be clicked.  With the release of the right mouse button, the 
Plot Control toolbar will disappear. 

Common Plot Control Toolbar Features 

 
Scaling Customization Channels 

The Plot Control Toolbar is customized for each BioSigRP plot area.  However, 
there are certain common features found in all Plot Control Toolbars.  Each 
toolbar consists of the following sections. 

 Scaling Section 

 Customization Section 

 Channels Section 
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Scaling Section 

 
Located on the far left of the Plot Control Toolbar, the scaling section consists 
of three buttons that may be used to alter plot scaling.  These scaling commands 
may also be accessed from the View Menu. 

Scaling buttons are mutually exclusive.  That is, clicking one scaling button 
turns that function “on” and turns all other scaling functions “off.”  “On” buttons 
appear depressed. 

Auto-Scale 
When Auto-Scale is chosen, BioSigRP will automatically scale the plot that 
currently has the focus. 

To enable Auto-Scale 
1. Access the Control Plot Toolbar. 

2. Click   or press * on the numeric pad. 

Expand Scale 
Choosing Expand Scale causes the scale of the focus plot to expand.  You may 
continue to expand the scale by repeatedly choosing Expand Scale. 

 

To expand the scale 
1. Access the Control Plot Toolbar. 

2. Click   or press + on the numeric pad. 

Reduce Scale 
Choosing Reduce Scale causes the scale of the focus plot to be reduced.  You 
may continue to reduce the scale by repeatedly choosing Reduce Scale. 



   Chapter 2: Learning The Basics 2-17 

  BioSigRP User's Guide 

 

To reduce the scale 
1. Access the Control Plot Toolbar. 

2. Click   or press - on the numeric pad. 

These functions are 
described in the 
sections “The Multi-
Purpose Plot,” “The 
History Plot,” and “The 
Comparison Plot.”   

Customization 
Each plot area has its own specialized plot control functions.  Buttons 
controlling these functions are found in the center of the Plot Control Toolbar. 

Channels 

 
You may wish to display some or all channels in the current plot.  Located on 
the far right of the Plot Control Toolbar, the channels section consists of four 
buttons that may be used to show/hide channels.  These channel commands may 
also be accessed from the View Menu. 

Channel buttons are independent.  That is, more than one channel button may be 
“on” at one time.  Channel buttons act like toggle switches.  Clicking a button 
that is “on” turns it “off.”  Clicking a button that is “off” turns it “on.”  As with 
Scaling buttons, “on” buttons appear depressed. 

Channels are indicated in Roman numerals, I, II, III, and IV. 

To show/hide a channel 
1. Access the Control Plot Toolbar. 

2. Turn the channel “on” or “off” by clicking its button. 

Note:  If none of the channel buttons are turned “on,” no plot will be displayed.  
The plot area will appear blank.   
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Multi-Purpose Plot 

 

The Multi-Purpose Plot may be used to display a variety of signals during 
stimulus presentation and data averaging.  The plot is controlled through the use 
of the Plot Control Toolbar.   

As with all other plots, you may control the scaling and channel display through 
use of the Plot Control Toolbar.  Functions specific to the Multi-Purpose Plot are 
found in the center of the Plot Control Toolbar.  These functions may also be 
accessed from the Multi-Plot menu. 

Types of Displays 

 

The buttons located in the center of the Plot Control Toolbar control the Multi-
purpose signal display.  The Multi-purpose Plot may be used to display the 
following signals: 

 Stimulus   EEG 

 Raw A/D  Running Average 

 Frequency Domain  None 

 

Plot display buttons are mutually exclusive.  That is, clicking one display button 
turns that function “on” and turns all other display functions “off.”  “On” 
buttons appear depressed. 

Stimulus 

 

Choosing Stimulus causes the current stimulus signal to be displayed.  BioSigRP 
allows up to two channels of stimulus output.   
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To display the Stimulus signal 
1. Access the Control Plot Toolbar. 

2. Click   or press ‘S’ on the keyboard. 

Raw A/D 

 

Choosing Raw A/D Input causes unprocessed A/D input to be display.  Raw 
input is not affected by currently defined acquisition setup parameters such as 
gain (See Chapter 3). 

To display the raw A/D signal 
1. Access the Control Plot Toolbar. 

2. Click   or press ‘R’ on the keyboard. 

Frequency Domain 

 

Choosing Frequency Domain causes the Multi-purpose Plot to display the A/D 
input in the frequency domain. 

To display the frequency-domain A/D signal 
1. Access the Control Plot Toolbar. 

2. Click   or press ‘T’ on the keyboard. 
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EEG 

 

Choosing EEG causes processed input to be displayed.  EEG data is affected by 
currently defined acquisition setup parameters such as gain (See Chapter 3). 

To display the EEG signal 
1. Access the Control Plot Toolbar. 

2. Click   or press ‘E’ on the keyboard. 

Running Average 

 
Choosing Running Average causes the current averaged EEG signal to be 
displayed. 

To display the running average 
1. Access the Control Plot Toolbar. 

2. Click   or press ‘A’ on the keyboard. 

None 
Choosing None causes no signal to be displayed. 

Note:  If None is chosen, the plot area will appear blank.   

To display no signal 
1. Access the Control Plot Toolbar. 

2. Click   or press ‘N’ on the keyboard. 
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The History Plot 

 
The History Plot is used to display historical averaged signal data.  The plot is 
controlled through the use of the Plot Control Toolbar.   

As with all other plots, you may control the scaling and channel display through 
use of the Plot Control Toolbar.  Functions specific to the History Plot are found 
in the center of the Plot Control Toolbar.  These functions may also be accessed 
from the History menu. 

Scrolling Functions 

 

History Plot data is organized into groups.  Each time you tell BioSigRP to 
begin collecting data, it begins a new group.  Data records are appended to the 
end of the group until you halt data collection.  When data collection is resumed, 
a new group is appended to the end of the History Plot. 

You may quickly scroll to the top or bottom of a group by using the scrolling 
buttons. 

To scroll to the top of the previous group 
1. Access the Control Plot Toolbar. 

2. Click  or press Page Up on the keyboard. 

To scroll to the top of the next group 
1. Access the Control Plot Toolbar. 

2. Click   or press Page Down on the keyboard. 

 



2-22 Chapter 2: Learning The Basics 

BioSigRP User's Guide   

Editing Functions 

 

You may edit the History Plot through the use of the editing buttons.  You may 
perform editing functions on all records or just those that are selected.  Selected 
records appear surrounded by a frame of highlight. 

Selecting Records 
You may select one record, multiple contiguous records, or multiple non-
contiguous records for editing. 

To select a single record 
 Click the desired record. 

To select multiple, non-contiguous records 
 Ctrl+Click the desired records. 

To select a group of contiguous SGIs 
1. Click the first record. 

2. Shift+Click the last record. 

To deselect a record 
3. Ctrl+Click the desired record. 

Editing 

To clear selected History Plot records 
1. Access the Control Plot Toolbar. 

2. Click   

To clear all History Plot records 
1. Access the Control Plot Toolbar. 

2. Click   or hit Ctrl-X. 

Note:  BioSigRP maintains a file of historical records knows as the BioSigRP 
record file (.arf file).  As history records are acquired, they are appended to this 
file.  Clearing a record from the History Plot does not remove the record from 
the BioSigRP record file.  Records stored in the BioSigRP record file can be 
retrieved and viewed in the History Plot by choosing Access Record File from 
the History menu. 
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The Calculator and Worksheet Buttons 

 

For more information 
about the Calculator, 
see Chapter 5, “Using 
the Calculator.” 

BioSigRP provides mathematical functions that may be applied to one or more 
Worksheet record.  These functions may be accessed from the Calculator menu 
or from buttons displayed in the area of the main window known as the 
Calculator.  Calculator functions are described in detail in a later section. 

Calculator Functions 
Button Menu Option Action 

 
Scale Multiplies each point in the selected Worksheet 

record(s) by a specified constant. 

 
Invert Trace Multiplies each point in the selected Worksheet 

record(s) by -1. 

 
Shift Baseline Creates a DC offset by adding a specified constant 

to each point in the selected Worksheet record(s). 

 
Remove 
Baseline 

Removes the DC offset. 

 
Zero Points Sets all points within a specified time range to 

zero. 

 
Crop Select a crop point for the selected record  

 
Add Add two or more Worksheet records 

 
Subtract Subtracts one Worksheet record from another. 

 
Average Computes the average of two or more Worksheet 

records. 

 
Time Align Lines up selected Worksheet records along the 

time axis. 

 
Time Shift Shifts the selected Worksheet record(s) along the 

time axis. 

 

 

Calculator Buttons 

Worksheet Buttons 
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Button Menu Option Action 

 
Smooth Applies a smoothing algorithm to the selected 

Worksheet record(s). 

 
Lowpass Filter Applies a low-pass filter to the selected Worksheet 

record(s). 

 
Highpass Filter Applies a high-pass filter to the selected 

Worksheet record(s). 

 
Bandpass Filter Applies a band-pass filter to the selected 

Worksheet record(s). 

 
Notch Filter Apply a notch filter to the selected Worksheet 

record(s). 

 
Hanning 
Window 

Applies a Hanning window to the selected 
worksheet record for use with the magnitude 
spectrum. 

 
Cosine^2 
Window 

Applies a Cos^2 window to the selected worksheet 
record (smoothes the start and end of the 
waveform).  Used with magnitude spectrum. 

 
Mag Spectrum Generates an FFT of the data using 1024-8192 

points per FFT. 

 
Auto Cursor Applies the selected auto cursor to the selected 

worksheet record. 
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Worksheet Functions 
Located below the Calculator, the five Worksheet buttons can be used to format 
and organize the Worksheet (see Chapter 5).  These functions may also be found 
in the Worksheet menu. 

Button Menu Option Action 

 
Space Evenly Spaces all selected plots evenly throughout the 

Worksheet. 

 
Spread Apart Spreads all selected plots apart.   

 
Squash 
Together Squashes all selected plots together. 

 
Pile Piles all selected plots on top of one another. 

 
UnPile Unpiles all selected plots. 

 
Delete Deletes the currently selected Worksheet records. 
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The Worksheet 

 

For more information 
about the Worksheet, 
see Chapter 5, “Using 
the Worksheet.” 

The Worksheet is an area of the main window where you can place records for 
reporting.  Calculator functions may also be applied to records in the 
Worksheet. 

Working with Files in BioSigRP 
BioSigRP uses or writes to five types of files: 

 SigGenRP files 

 BioSigRP configuration files 

 BioSigRP record files 

 ASCII text files 

 BioSigRP worksheet files 

 CSV files 
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SigGenRP Files 
Stimulus signals are designed with TDT’s signal generation package, 
SigGenRP.  The information necessary to reconstruct these signals may be saved 
in a SigGenRP file.  All TDT signal processing applications, including 
BioSigRP, can reconstruct a SigGenRP signal by reading its SigGenRP file.  
The default extension for SigGenRP files is .sig. 

Specifying a SigGenRP File 
Prior to presenting a stimulus signal, it is necessary to specify the SigGenRP file 
from which the stimulus signal will be generated.   

To specify a SigGenRP file 
1. Choose Stimulus... from the Setup menu. 

a. Type the file name in the SigGenRP File field of the desired stimulus 
channel. 

or 

b. Click the Find File button and select the desired file name. 

Modifying SigGenRP Files 
You may modify SigGenRP variables from within BioSigRP.  These 
modifications are not saved in the original SigGenRP file, however.  All 
modifications to original SigGenRP files must be made in SigGenRP. 

BioSigRP Configuration Files 
Prior to presenting a stimulus signal and acquiring response data, you must 
specify stimulus and data acquisition parameters.  These parameters may be 
saved for future use in a BioSigRP configuration file.  The default extension for 
BioSigRP configuration files is .acf. 

Opening BioSigRP Configuration Files 

To open an existing BioSigRP file 
1. Choose Open Config. File... from the File menu. 

2. Click on the desired file name. 

3. Click the OK button. 

The selected file must be in BioSigRP format.  By default, BioSigRP 
configuration files have the extension, .acf. 

To open a recently updated file 
1. Choose the File menu. 

BioSigRP displays the names of the last 4 BioSigRP configuration files 
saved. 

2. Click the desired file name. 
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Saving BioSigRP Configuration Files 

To save a new file in BioSigRP format 
 Choose Save Config. or Save Config. As... from the File menu. 

The File Save As dialog box will be displayed.  You may assign a name to 
your new signal.  It is best to use the default .acf file extension. 

To save an existing file 
 Choose Save Config. from the File menu. 

The file will be saved with its current name. 

BioSigRP Record Files 
For every stimulus interval, or SigGenRP Index (SGI), BioSigRP acquires 
response signals and computes an average.  The resulting averaged waveforms 
are collectively stored in a BioSigRP record file.  These waveforms may be 
retrieved for analysis in later sessions.  Waveforms retrieved from BioSigRP 
record files are displayed in the History Plot.  The default extension for these 
files is .arf. 

Specifying a BioSigRP Record File 
Immediately prior to stimulus presentation, BioSigRP will ask you to supply the 
name of the BioSigRP record file.  You may, however, optionally define a 
default BioSigRP record file ahead of time.   

To specify a default BioSigRP record file 
1. Choose Acquisition from the Setup menu. 

a. Type the file name in the Response Record File Name field. 

or 

b. Click the Find File button and select the desired file name. 

It is best to use the default file extension, .arf. 

Loading a BioSigRP Record File 

To load a BioSigRP record file 
1. Choose Access Record File from the History menu. 

2. Choose the group. 

3. Choose the desired records. 

The BioSigRP record(s) will be displayed in the History Plot. 
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For more information 
about exporting ASCII 
text files, see Chapter 5, 
“Using the History Plot 
and BioSigRP record 
files.” 

ASCII Text Files 
You may wish to export BioSigRP record information to an ASCII text file for 
use by another application.  BioSigRP allows you to export record information 
in ASCII text format.  These files are saved with the default extension, .txt. 

Information may be saved from both the History Plot and the Worksheet.   

BioSigRP Worksheet Files 
BioSigRP allows you to build custom reports.  Custom reports are created by 
placing desired History Plot records in the Worksheet.  These reports may be 
saved in BioSigRP Worksheet files.  The default extension for these files is .awf. 

Opening BioSigRP Worksheet Files 

To open an BioSigRP worksheet file 
1. Choose Open Worksheet... from the Worksheet menu. 

2. Click on the desired file name. 

3. Click the OK button. 

Saving BioSigRP Worksheet Files 

To save a new BioSigRP Worksheet file 
 Choose Save Worksheet or Save Worksheet As... from the File menu. 

The File Save As dialog box will be displayed.  You may assign a name to 
your new signal.  It is best to use the default .awf file extension. 

To save an existing file 
 Choose Save Worksheet from the Worksheet menu. 

The file will be saved with its current name. 

CSV Files 
BioSigRP allows you to export raw trace data along with descriptors into a 
standard spreadsheet file (CSV files).  Each row in the spreadsheet file contains 
all of the data for one record. 

Information may be saved from both the History Plot and the Worksheet.  (See 
Chapter 5 for more information.)
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Customizing Your Display 
BioSigRP is designed to provide various types of visual data on one easy-to-use 
main window.  Depending on your data display needs and your type of monitor, 
you may find it useful to alter the default BioSigRP screen configuration.  Some 
common screen configuration problems and their solutions are listed below. 

Problem Solution 

Plot text seems too big or too small. Change the size of the font. 

Plots cannot be seen clearly against 
the plot background. 

Change the plot background color 
and/or the plot color. 

One or more plot is not large enough. Maximize the window and/or change 
one or more plot sizes. 

Multi-purpose plots cannot be 
differentiated from one another. 

Change one or more plot colors. 

You may customize two areas of the main window: 

 The Worksheet 

 All other areas 

To customize the Worksheet 
 Choose Worksheet Displays 

Ops... from the Setup menu. 

You will see the Worksheet Display 
Options dialog box. 

To customize all other areas 
 Choose General Displays Ops... from the Setup 

menu. 

 

You will see the General Display Options dialog Box. 
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From either Display Options dialog box you may configure the following: 

 Font types and sizes 

 Colors 

Customizing Fonts 
You may customize the screen font used by BioSigRP components.   

To access the Font dialog box 
Click the appropriate font button. 

 
From the Font dialog box, you may select any screen font type, style, and size 
currently available in Windows. 
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Customizing Colors 
You can customize the color of numerous screens and plot elements. 

To access the Color dialog box 
 Click the appropriate Color button. 

 

You may wish to design your own Custom colors. 

To design custom colors 
 Click the Define Custom Colors button. 

The Color dialog box will expand to provide a color palette from which you 
can design your custom colors. 
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Customizing the Layout 
You may wish to re-size screen display areas.  This can be accomplished in two 
ways: 

 Manual customization 

 Using setups 

Manual Customization 

To manually customize a screen area 
 Drag one or more Sizing Bars until the desired size is reached. 

Using Setups 
You may configure up to three layout setups.   

To use a setup 
 Choose the desired Setup # from the Layout sub-menu of the Setup menu. 

To configure a setup 
1. Choose the desired Setup # from the Layout sub-menu of the Setup menu. 

2. Manually customize the layout. 

3. Choose Lock from the Layout sub-menu of the Setup menu. 

This layout is now associated with the chosen Setup #. 

Returning to the Default Layout 

To return to the default layout 
 Choose To Default from the Layout sub-menu of the Setup menu. 

Customizing Cursor Strings 
BioSigRP provides a means for placing cursors in history/worksheet records.  
This process is known as Cursor Editing.   

When a history or worksheet record is selected for Editing, it is possible to place 
up to 10 cursors within the signal.  Each cursor is associated with a text label.  
You may customize the first five labels.  These labels are known as cursor 
strings. 

To customize a default cursor string 
 Choose Default Cursor Strings... from the Setup menu. 

You will see the Default Cursor Text dialog box. 
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Cursor strings may be defined as follows: 

 One set for all acquisition channels. 

 One set for each acquisition channel. 

To specify one set of cursor strings for all acquisition channels 
1. Check the One Set Only check box. 

2. Type in the desired cursor strings. 

3. Click OK. 

To specify one set of cursor strings for each acquisition 
1. Make sure the One Set Only check box is not checked. 

2. Choose the desired acquisition channel. 

3. Type in the desired cursor strings. 

4. Click OK. 

5. Repeat for each acquisition channel. 

How BioSigRP Works 
BioSigRP enables you to acquire and process bioelectric signal data in response 
to a customized stimulus signal.  The process is as follows: 

1. Design the stimulus signal using SigGenRP. 

2. Acquire and process response signal data using BioSigRP. 
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Designing the Stimulus Signal 
TDT’s signal generation package, SigGenRP, provides a simple, yet powerful, 
means for designing your stimulus signals.  Signals generated with SigGenRP 
may be saved as SigGenRP files (.sig files) for use with other TDT signal 
processing applications, including BioSigRP. 

Acquiring and Processing Response 
Signal Data 
BioSigRP is an easy-to-use tool for acquiring and processing response signal 
data.  The process is relatively simple: 

1. Configure BioSigRP. 

2. Present the stimulus signal. 

3. Acquire response data. 

4. Analyze and process the response data. 

Configure BioSigRP 
Configuration settings include: 

 Specification of stimulus signal parameters. 

 Specification of data acquisition parameters.  

 Specification of the stimulus schedule. 

 Configuration of the Multi-Purpose Plot. 

Present the Stimulus Signal 
BioSigRP will present the stimulus signal beginning at the SigGenRP Index 
(SGI) you specify.  All signal parameters associated with variables will vary as a 
function of the SGI. 

Begin Acquiring Response Data 
During the configuration process, you will have specified the value of Number 
Averages, n.  For each SGI, the stimulus signal is presented until  n response 
signals have been acquired and averaged.  The resulting averaged waveform will 
be displayed in the History Plot. 

Analyze the response data 
Signals displayed in the History Plot are known as history records.  Any history 
record may be viewed in greater detail.  You may: 

 Place cursors and measure x and y coordinate values.  

 Place a record in the Comparison Plot for future reference. 

 Place a record in the Worksheet as part of a report. 

 Perform calculations involving one or more record. 
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Chapter 3   Configuration 
Prior to presenting a stimulus signal and acquiring response data, it is necessary 
to complete the following steps: 

 Define stimulus signal parameters. 

 Define data acquisition parameters.  

 Calibrate the system (optional). 

 Specify the stimulus schedule (optional). 

Defining Stimulus Parameters 
Stimulus parameters are defined from the Stimulus Setup dialog box. 

To access the Stimulus Setup dialog box 
 Choose Stimulus from the Setup menu. 
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Presentation 

 

Temporal parameters associated with the presentation of the stimulus signal are 
defined in the Presentation section of the Setup Stimulus dialog box. 

The Presentation parameters consist of the following: 

 Presentation Rate (stimuli/second)  

 Presentation Period (milliseconds) = 1000/Presentation Rate (sec) 

 Ext. Trigger 

 Continuous 

Presentation Rate 
You may define the Presentation Rate by entering a value in the Presentation 
Rate field.  When you leave this field, the value of the Presentation Period field 
will be calculated automatically. 

Presentation Period 
You may define the Presentation Period by entering a value in the Presentation 
Period field.  When you leave this field, the value of the Presentation Rate field 
will be calculated automatically. 

When Continuous is enabled (see below), the presentation period is 
automatically defined as the length of the SigGenRP signal assigned to stimulus 
channel #1.  When continuous is enabled, you may not edit the Presentation 
Rate or Presentation Period. 

Note:  When Continuous (see below) is not enabled, the Presentation Period 
must be 1.25 times longer than the stimulus and acquisition duration.   

Ext. Trigger 
An external trigger can be used with some modification of the RCO file. Contact 
TDT for assistance. 
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Continuous 
When Continuous is checked, the stimulus will be played continuously.  Upon 
reaching the end of the signal, BioSigRP will loop back to the beginning of the 
buffer and replay the signal.  This cycle will continue throughout continuous 
signal play.  

Note: When selecting continuous record the SigGenRP file must be designed for 
continuous stimulus presentation. 

Defining the Stimulus 
 
 

You may define a single or dual channel 
stimulus.  Defining the stimulus signal is the 
same for Channels 1 and 2, with a couple of 
exceptions.   

 

 

 

 

Specifying the SigGenRP File 
BioSigRP does not provide a means for designing stimulus signals.  Instead, 
BioSigRP generates a stimulus signal based on signal parameters read from 
previously defined SigGenRP signal files (.sig files).  To define a stimulus 
signal, you simply specify the appropriate SigGenRP file. 

To specify the stimulus file 
1. Click Find File. 

a. Choose the desired file. 

or 

b. Type in the desired file name in the SigGenRP File field. 
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Stimulus Refresh 
BioSigRP generates a stimulus signal based on the parameters specified in the 
SigGenRP file.  The generated signal is stored in a buffer.  This buffered signal 
is then presented as a stimulus.  A stimulus refresh occurs whenever the signal 
currently stored in the buffer is replaced with a freshly generated stimulus 
signal. 

In theory, a stimulus signal could be refreshed:  (1) prior to each presentation or 
(2) prior to a new SGI. 

In practice, however, the ability to perform a stimulus refresh is limited by 
processing considerations.  The real time processing of incoming response data 
must take precedence over the refresh of the stimulus signal.  BioSigRP 
performs a stimulus refresh as follows: 

 The stimulus signal is always refreshed prior to a new SGI. 

This automatic refresh is necessary in order to reflect any changes in 
stimulus signal parameter values associated with the new SGI. 

 The stimulus signal may be refreshed when possible within an SGI.  This 
option is enabled by selecting Freshen when possible. 

Refreshing Non-Noise Stimuli.  Within an SGI, non-noise stimulus signals, 
such as clicks and periodic waveforms, remain constant.  These signals need 
only be refreshed prior to a new SGI.  For these signals, do not check Freshen 
when possible. 

Refreshing Noise Stimuli.  It may be desirable to refresh noise stimuli.  While 
BioSigRP cannot guarantee that a noise signal will be refreshed for every 
presentation within an SGI, it will attempt to refresh the signal when possible.  If 
the Freshen when possible option is chosen, the noise stimulus will be refreshed 
whenever there are no processing demands being made by incoming data.  If 
you wish the noise stimulus to remain constant throughout all presentations in a 
given SGI, do not specify Refresh when possible. 

To refresh the stimulus whenever possible 
 Check the Freshen when possible check box. 

 

Enabling the Channel 
By default, BioSigRP assumes that Channel #1 will be active.  No such 
assumption is made concerning Channel #2.  Specifying a SigGenRP file is not 
sufficient to activate Channel #2.  You must also enable the channel. 

To enable Channel #2 
 Check the Enable check box. 

 
Note:  The SigGenRP file specified for Channel 2 will use the variables defined 
in the SigGenRP file specified for Channel 1. 
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Reloading the SigGenRP Stimulus File 
SigGenRP files are automatically loaded: 

 When the file name is specified (see below). 

 When an existing BioSigRP configuration file (.acf file) is loaded. 

SigGenRP files may also be manually loaded in the following ways: 

 Reload with variables 

 Reload without variables 

Included in the SigGenRP file is information defining how variables will change 
as a function of the SGI.  Once a SigGenRP file has been loaded, this 
information is available to the BioSigRP application and will be saved in the 
BioSigRP configuration file (.acf file).  In some cases, it may be necessary to 
modify these stimulus variables.  BioSigRP allows you to make local changes to 
stimulus variables for Channel #1, only.  (Note that with a two channel system, 
both SigGenRP files should have the same variables. BioSigRP only implements 
variables in the file for Channel 1.) The modified variable information will be 
saved in your BioSigRP file (.acf file).  The original SigGenRP file, however, 
will not be modified.  Modified variable information remains in the BioSigRP 
file until the SigGenRP file is reloaded by as defined above. 

Reloading with Variables.  When you reload a SigGenRP file with variables, 
the variable schedule currently defined in BioSigRP will be replaced with the 
schedule stored in the SigGenRP file. 

Reloading without Variables.  When you reload a SigGenRP file without 
variables, the variable schedule currently defined in BioSigRP will not be 
replaced with the schedule stored in the SigGenRP file. 

To reload a SigGenRP file with variables 
 Click the Reload WITH Variables button. 

To reload a SigGenRP file without variables 
 Click the Reload W/O Variables button. 

 

Defining Data Acquisition Parameters 
Data Acquisition parameters are defined from the Acquisition Setup dialog box. 

To access the Acquisition Setup dialog box 
 Choose Acquisition from the Setup menu. 

The Acquisition Setup dialog box opens.   
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In the Acquisition Setup dialog box the RPx device can be selected.   

Use Sys3 
The Use Sys 3 check box should be selected to allow users to access RCO files 
for acquisition on an RPx device. RCO circuits are included with the program 
for data acquisition and signal averaging.  

If the Use Sys 3 check box is cleared users can access System II modules such 
as the DB4 and use the System II timing functions.   

Device Select 
Users must select the device type (such as RP2, Medusa, or RX6) and the 
module number.  

Device type:  All device types are accessible from the Dialog box, however, the 
user should be familiar with the devices in their system and choose the 
appropriate device.  See Acquire RCO below for more information.  

Index:  Many systems have multiple RPx modules.  To select the RPx module 
for acquisition use the device’s index.  Devices are numbered logically 
beginning with one.  A device index of zero means that module type is not 
selected.  The logical device numbers may not correspond to the physical device 
organization.  When using TDT’s USB interface make sure that devices are 
turned on in the same order each time the system is turned on to ensure that the 
devices are ordered consistently each time the system is used.  To check that the 
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devices have been properly selected use the zBUSmon software to check the 
order of the logical devices.   

Acquire RCO 
A standard RCO file can be selected or a custom RCO file can be used.  

Standard Files:  Standard files that come with the system where designed for 
the RP2.1 and RA16 Medusa BioAmp System, but not all standard files support 
both devices. When selecting a file, consider hardware specific factors such as 
the sampling rates supported by your acquisition module and the number of 
acquisition channels available. 

The RP2.1 supports up to two acquisition channels.  

Note: the Stingray runs at ½ the speed of the RP2.1. When using the 
Stingray, the user can use files designed for the RP2.1, if the RCO 
sample period is changed accordingly. 

The Medusa supports up to four acquisition channels and is limited to a 25 kHz 
sampling rate.  

Note: the RA16SD Medusa Sigma-Delta Preamp introduces delays 
which must be accounted for in the RCO file. Contact TDT for 
assistance when using this device. 

If using an RX device for either stimulation or acquisition, see page 1-7 for 
information on RCO files for these devices.  

ABR Protocols 

Sweep Rec, 2 at 25 kHz  used by either an RP2.1 module or a Medusa system. 

Sweep Rec, 4 at 25 used with the Medusa amplifier.   

Sweep Rec, 2 x 50 used with an RP2.1 module.  

Sweep Rec, 1 x 100 kHz used with an RP2.1 module. Artifact rejection is 
disabled.  

DPOAE Protocols 

The DPOAE continuous record protocols use sample rates above 25 kHz, so are 
used with the RP2.1 module. 

RCO File: RCO files not found in the standard list can be selected by browsing 
for the file.  

Timing 
Onset Delay.  The value in the Onset Delay field defines the time delay in 
milliseconds from the time of stimulus onset to the beginning of response signal 
acquisition.  This field is set to zero and disabled when continuous signal 
presentation is enabled. 

SG Variable.  Onset delay may be defined as a constant or as a SigGenRP 
variable.  This box is disabled when continuous signal presentation is enabled. 

Bioamp Group Delay.  Not available when using System 3. 

UseDB4.  Not available when using System 3. 
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Duration.  The value in the Duration field specifies the length in milliseconds of 
the acquired response signal.  When continuous signal presentation is enabled, 
this value will default to the duration of the SigGenRP signal.  The field will be 
disabled. 

Sub-Folds.  You may divide the acquired signal into subunits that are folded 
onto each other.  These sub-folds are added to one another.  The resulting 
composite signal is averaged.  For example, if an acquired signal of 50 
milliseconds is assigned 2 sub-folds, the result is two 25 millisecond sub-folds.  
The first 25 millisecond sub-fold will be added to the second 25 millisecond 
sub-fold. 

Sub-folds may be used with non-continuous and continuous signals. 

Zero Onset.  Zero Onset defines a duration beginning at 0 milliseconds during 
which the acquired signal will be set to zero.  For example, if Zero Onset is 
defined as 20 milliseconds, the first 20 milliseconds of the acquired signal will 
be set to zero. 

Sample Period.  Not available when using System 3. 

Use DAC Clock.  Not available when using System 3. 

Response Record File 
Response record files, or history record files, (.arf files) are continuously 
maintained during data acquisition.  Each averaged record is appended to the 
history record file. 

Name.  This will be the default history record file name.  It is recommend that 
you use the file extension, arf.   

Prompt for File Name.  When this box is checked, BioSigRP will always 
prompt you for a file name before stimulus presentation begins, allowing you to 
override the default file name. 

Setting-up Acquisition Channels 
You must define configuration parameters for each acquisition channel. 

 

To setup acquisition channels 
 Click the appropriate acquisition channel button. 

The Acquisition Channel Setup dialog box opens. 
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Configuration 
No. Averages.  The value of Number Averages determines the number of 
response signals acquired and averaged for every SGI.  Number Averages must 
be at least 1 and cannot exceed 3000. 

Gain.  The value specified in the Gain field is used to adjust the voltage of the 
acquired data signal in the following manner:  

• If you are using a Medusa amplifier with the low impedance headstage 
(serial number less than 2000) the Gain should be set to 10. 

• If you are using a Medusa amplifier with the low impedance headstage 
(serial number greater than 2000) the Gain should be set to 20. 

• If you are using the Medusa amplifier directly, the gain should be set to 
1. 

• Otherwise determine the gain based on the Gain of your amplifier.  

BioSigRP voltage = acquired signal voltage/Gain 

Gain may be used to remove the effects of signal amplification.  For example, 
let’s say you used a bio-amplifier to increase the level of an evoked potential by 
a gain of 50,000.  Specifying a gain of 50,000 in the Gain field causes an evoked 
potential of the original level to be displayed. 

Preprocessing 
AC Couple.  Checking this box enables AC Coupling.  AC Coupling removes 
the DC component by subtracting the signal average. 
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Artifact Rejection 
In some cases, anomalous amplitude values may indicate an artifact in the 
acquired data signal.  BioSigRP provides a means for detecting and rejecting 
signals with such artifacts, Artifact Rejection.  By enabling Artifact Rejection, 
you can specify at which peak amplitude you wish to reject an acquired signal.  
This amplitude is specified as a percentage of the threshold relative to the 
maximum voltage input (10 Volts or input signal).   

Signals rejected through Artifact Rejection are not included in the average for 
each SGI. 

To enable Artifact Rejection 
1. Check Enabled under Artifact Rejection. 

2. Enter the percentage in the Threshold field. 

 

or 

1. Display Raw A/D Input in the Multi-Purpose Plot. 

2. Place the mouse pointer in the plot. 

3. Hold down the left mouse button and CTRL. 

A threshold line appears. 

4. Drag until the desired artifact rejection is reached. 

 

The threshold percentage will be 
displayed in the Mode field.  
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Enabling/Disabling a Channel 

 
Acquisition channels can be enabled or disabled.   

By default, Channel #1 is always enabled.  The other three channels can be 
defined as either enabled or disabled. 

To enable a channel 
 Click OK. 

To disable a channel 
 Click Disable. 

Once you have enabled or disabled a channel, you will be returned to the 
Acquisition Setup screen.  By examining the Edit Acquisition Channels buttons, 
you can quickly determine which channels are enabled.  Enable channels display 
[X] on their buttons. 
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Post Processing 

 

You may apply various types of post-processing to the acquired signal.   

To apply post processing 
 Click Post Processing. 

You will see the Post Processing dialog box.  From this box you may enable a 
variety of post processing options. 

 

Hanning Window.  Applies a hanning window to the acquired signal. The 
default is a Hamming window.  

Truncate to Rad-2.  Truncates the number of data points to radix 2. 
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Mag Spectrum (dB).  Displays intensity in the logarithmic units of decibels. 

Phase Spectrum (rads).  Displays the phase spectrum in radians. 

Specifying the Stimulus Schedule 
TDT’s signal generation package, SigGenRP, allows you to build signals that 
vary one or more signal parameter from one SGI to another.  Such variation is 
accomplished through the definition and use of signal variables.  Values of these 
variables change as a function of the SGI.  This stimulus schedule information is 
stored within the SigGenRP file.  BioSigRP and other TDT applications use the 
information stored in the SigGenRP file to generate stimulus signals and to 
control parameter variation across SGIs. 

Viewing the Current Stimulus Schedule 
To view the current stimulus schedule 
From the main window, 

 Choose SigGenRP Variables... from the Setup menu. 

or 

 Choose Modify Schedule from the Operations menu. 

or 

 Click the Modify Schedule button. 

The SigGenRP Variable Control dialog box opens.

  
The SigGenRP Variable Control dialog box displays the current stimulus 
schedule.  Variable values are shown for each SGI.   
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You may scroll through the stimulus schedule as follows: 

To scroll up and down 
 Use the vertical scroll bar. 

To scroll to the right 
 Hit the >>> button. 

To scroll to the left 
 Hit the <<< button. 

Once you have viewed the stimulus schedule, you may: 

 Accept the current stimulus schedule. 

 Modify the current stimulus schedule. 

 Modify variables. 

To accept the current stimulus schedule 
 Click OK. 

Modifying the Stimulus Schedule 
You may wish to present a subset of the current stimulus schedule.  To do so, 
just select the SGIs to be included in the subset for presentation.  When no SGIs 
are selected, BioSigRP will present the entire stimulus schedule.  Otherwise, 
BioSigRP will present only the selected SGIs. 

To select a single SGI 
 Click the desired SGI. 

To select multiple, non-contiguous SGIs 
 Ctrl+Click the desired SGIs. 

To select a group of contiguous SGIs 
1. Place the mouse pointer over the first SGI. 

2. Hold down the left mouse button. 

3. Drag the mouse pointer to the last SGI. 

4. Release the left mouse button. 

or 

1. Click the first SGI. 

2. Shift+Click the last SGI. 

To select all odd SGIs 
 Click the Do Odd button. 
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To select all even SGIs 
 Click the Do Even button. 

To deselect a single SGI 
 Ctrl+Click the desired SGI. 

To deselect all SGIs 
 Click the Clear Selections button. 

Modifying Variables 
Variables are defined within SigGenRP.   
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Chapter 4   Data Acquisition 
Once the configuration process has been completed, you are ready to present a 
stimulus and acquire data.   

Subject Definition 
You may wish to associate subject information with each group of signals added 
to the history plot.  Such information may be defined in the Subject Information 
dialog box. 

To access the Subject Information dialog box 
 Choose Subject Info... from the Setup menu. 

  
Subject ID.  This subject identifier may be up to 15 characters in length.  The 
Subject ID will be associated with all subsequently acquired data.  The ID will 
be displayed in the history plot immediately above the history data.  It will also 
be stored with the history data in the BioSigRP record file (.arf file). 

Reference 1.  This reference text may be up to 15 characters in length.  The text 
of Reference 1 will be associated with all subsequently acquired data.  The 
character string will be displayed in the history plot immediately above the 
history data.  It will also be stored with the history data in the BioSigRP record 
file (.arf file). 

Reference 2.  This reference text may be up to 15 characters in length.  The text 
of Reference 2 will be associated with all subsequently acquired data.  The 
character string will be displayed in the history plot immediately above the 
history data.  It will also be stored with the history data in the BioSigRP record 
file (.arf file). 

 
See Chapter 5 for more 
information about 
viewing Memo text. 

Memo.  This character string may be up to 49 characters in length.  This text 
will be associated with all subsequently acquired data.  The text will not be 
displayed in the history plot, but will be stored with the history data in the 
BioSigRP record file (.arf file).  Memo text can be viewed from BioSigRP 
Cursor Edit dialog box. 
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Auto-Cursors 
You may specify up to 10 auto-cursors.  Auto-cursors are cursors that are 
automatically placed at specific points in the signal as the signal is acquired.  
Auto-cursor position is determined through specification of an auto-cursor 
equation.  You may specify an auto-cursor equation from the Specify Auto-
Cursor Equation dialog box. 

To access the Specify Auto-Cursor Equation dialog box 
 Choose Auto-Cursors... from the Setup menu. 

 

Select Cursor 
From the Select Cursor group box, you may choose to specify an auto-cursor 
equation for any of the first 10 cursors. 

To specify an auto-cursor 
 Click the desired cursor number in the Select Cursor box. 

Specifying the Algebraic Equation 
Specifying the algebraic equation may be accomplished in three steps: 

 Enabling auto-cursoring. 

 Specifying the equation. 

 Parsing the equation. 
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Enabling Auto-Cursoring 

To enable auto-cursoring 
 Check the Enable box. 

Specifying the Equation 
You may now enter an auto-cursor equation in the Algebraic Equation field.   

Auto-Cursor equations may include one or more SigGenRP Variable.  Instead of 
using the variable name, however, you must use a variable number.  For 
example, if the variable you wish to use is second in the BioSigRP variable list, 
use V2. 

V2 + 100 

You may also use existing auto-cursors as variables in auto-cursor equations.  
Auto-cursor variables are specified by Cn, where n is the number of the auto-
cursors.  For example, if you wish to use auto-cursor #3 in an equation, use 
variable C3. 

C3 - V2 + 100 

Auto-cursors are placed in the time axis in time-domain waveforms and in the 
frequency axis in frequency-domain waveforms.  Thus, the unit of measurement 
for time-domain auto-cursors is milliseconds, while the unit of measurement for 
frequency-domain auto-cursors is Hz. 

Parsing the Equation 
Once you have specified the equation, it must be parsed.  During parsing, the 
equation is evaluated.  Any errors noted during parsing will be reported. 

Note:  All auto-cursor equations must be parsed.  Failure to parse the equation 
will result in a failure to use the equation during data acquisition. 

To parse the equation 
 Hit Parse. 

Accepting an Equation 
Once an equation has been defined, it must be accepted. 

To accept an equation 
 Hit Done. 

To reject an equation 
 Hit Cancel. 
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Auto-Cursor Feature Finding 
The auto-cursor feature will place up to 10 cursors on each acquired trace as a 
mathematical function of a variable or at a specific time or frequency.  
BioSigRP now supports automatic feature finding to minimize the amount of 
manual cursor manipulation that has to be performed after data acquisition. 

 
 

Placement 
The settings under Placement allow you to specify placement of the cursor on 
the feature selected from the drop-down menu.  The Placement will search over 
the specified range around the value calculated by the algebraic equation. 

Absolute 
This corresponds to auto-cursoring by earlier versions of BioSigRP.  The cursor 
will be placed at the position specified by the algebraic equation. 

Peak 
Will place the cursor at the highest peak in the specified range. 

Valley 
Will place the cursor at the lowest valley in the specified range.  
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Max Mag 
Will place the cursor at the maximum + or – value in the specified range.. 

Zero Crossing 
Will place the cursor at the nearest zero crossing in the specified range. 

Rising ZC 
Will place the cursor at the nearest rising (i.e. positive going) zero crossing in 
the specified range. 

Falling ZC 
Will place the cursor at the nearest falling (i.e. negative going) zero crossing in 
the specified range. 

Max Slope 
Will place the cursor on the maximum slope (either positive or negative) in the 
specified range. 

Max Pos Slope 
Will place the cursor on the maximum  positive slope in the specified range. 

Max Neg Slope 
Will place the cursor on the maximum  negative slope in the specified range. 

Search From and To 
This specifies the search range for the feature (e.g. peak, valley etc.).  AC stands 
for AutoCursor.  

For example, if the feature is set to peak and the result of the algebraic equation 
is 5 ms and the search range is From: AC –1.0  To: AC +1.0, the autocursor will 
be placed on the highest peak between 4.0 ms and 6.0 ms. 

Multiplicative 
By default, the range specified in the search box will be added to the result of 
the algebraic equation.  If the multiplicative box is checked, the range will by 
multiplied by the result of the algebraic equation. 

Flag Edge Placements 
If the placement of the cursor occurs at the beginning or end of the search range, 
clicking Flag Edge Placements, will cause the cursor to be flagged as such.  For 
example, if the cursor placement was set for a peak at 5 ms (as in the following 
example), but the peak actually occurred before the search window, the cursor 
would be placed at the Start of the search window and would be flagged.  This 
will let you know that you might want to manually move the cursor to the true 
peak, which was outside the search window. 
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Cursors in the Auto-Cursor Equation 
When an auto-cursor’s value is calculated based on the value of another auto-
cursor, the calculation is performed on the absolute value of the cursors. 

For example if two cursors are placed on the signal and the first one (C1) uses 
peak finding over a 200 Hz range while the second cursor (C2) is calculated as 
C1 + 100 Hz, the second cursor will be placed as a function of the absolute 
value of C1, not the value actually found in the search over the 200 Hz range. 

Understanding BioSigRP Operational Modes 
 
 
 
 
 
 
 
 
For more information 
about modes, see 
Chapter 3, “Using the 
BioSigRP Menus,” “The 
Operations Menu.” 

Functions controlling the presentation of stimuli and the acquisition of data are 
controlled from the Operations Menu or from buttons displayed on the main 
window.  The title and function of these menu options and buttons vary, 
depending on the current operational mode.  Operational modes consist of the 
following: 

 Idle 

 No stimulus presentation or data averaging. 

 Running 

 Stimulus is being presented. 

 Averaging 

 Response data is being acquired and averaged. 

 Paused 

 Data averaging has been temporarily suspended. 

Idle Mode 

 

When BioSigRP is in idle mode, no stimulus signals are presented and no data is 
acquired.  It is during idle mode that you specify parameters and configure 
displays.   

Start is the only operation available in idle mode.  Clicking the Start button 
begins stimulus presentation and causes BioSigRP to enter running mode. 

To present the stimulus 
When in idle mode, 
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 Click the Start button. 

  or 

 Choose Start from the Operations menu. 

Running Mode 

 
When in running mode, BioSigRP continuously presents the stimulus signal 
based on the variable values associated with the current SGI as defined in the 
stimulus schedule.  No data is averaged in running mode. 

Stimulus presentation will continues until:   

 Stimulus presentation is manually halted. 

 The stimulus schedule reaches its termination point. 

During running mode, no data is being averaged.  Consequently, the stimulus 
will continue to be presented at its initial SGI.  The SGI will not be incremented 
until response data has been averaged. 

Stop and Begin are the only operations available in running mode.  Clicking the 
Stop button halts stimulus presentation and returns BioSigRP to idle mode.  
Clicking the Begin button begins data averaging, placing BioSigRP in averaging 
mode. 

 
 
 
See Chapter 3, “The 
Plot Control Toolbar” for 
more information. 

To view the stimulus 
1. Display the Plot Control Toolbar of the Multi-purpose Plot. 

2. Click the Stimulus button. 

You may alter the scale of the display or change the number of displayed 
channels through use of the Plot Control Toolbar. 

To manually halt stimulus presentation 
While in running mode, 

 Click the Stop button. 

   or 

 Choose Stop from the Operations menu. 

To begin averaging data 
While in running mode, 
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 Click the Begin button. 

   or 

 Choose Begin from the Operations menu. 

Averaging Mode 

 
During averaging mode, BioSigRP acquires data and calculates a running 
average.  BioSigRP acquires data from up to four A/D channels according to 
setup specifications.  Data will be acquired until enough records have been 
gathered to compute the final averaged signal.  At that time, the averaged signal 
will be appended to the end of the History Plot, the SGI will be incremented, a 
new stimulus signal will be generated according to the current stimulus 
parameters, and a new average will be computed.  This process continues until 
the termination of the stimulus schedule is reached or until you manually end 
data averaging. 

During averaging mode, the operations End and Pause are available.  In 
addition, you may access four manual control functions:  Advance, Skip, 
Repeat, and ReDo.  These functions are defined in the “Manual Control of Data 
Acquisition” section of this chapter. 

During data acquisition, you may use the Multi-Purpose Plot to view: 

 The stimulus signal  The EEG signal 

 The raw A/D input  The running average 

 

 
 
See Chapter 3, "The 
Multi-Purpose Plot" for 
more information. 

To choose a signal type for display in the Multi-Purpose Plot 
1. Display the Plot Control Toolbar of the Multi-purpose Plot. 

2. Click the appropriate button. 

You may alter the scale of the display or change the number of displayed 
channels through use of the Plot Control Toolbar. 

To manually end data averaging 
While in Averaging mode,  

 Click the End button. 

   or 

 Choose End from the Operations menu. 
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BioSigRP will return to running mode.  The current stimulus signal will 
continue to be presented until manually halted as described previously. 

To pause data averaging 
While in Averaging mode, 

 Click the Pause button. 

   or 

 Choose Pause from the Operations menu. 

Data averaging will pause.  The stimulus signal will continue to be presented. 

Paused Mode 

 
In paused mode, data averaging is temporarily halted.  Stimulus presentation 
continues.   

From paused mode, the operations End and Resume are available.  The four 
manual control functions, Advance, Repeat, Skip, and ReDo are also available.  
These functions are defined in the “Control of Data Acquisition” section of this 
chapter. 

To resume data averaging 
 Click the Resume button. 

   or 

 Choose Resume from the Operations menu. 

To manually end data averaging 
While in Averaging mode,  

 Click the End button. 

   or 

 Choose End from the Operations menu. 

BioSigRP will return to running mode.  The current stimulus signal will 
continue to be presented until manually halted as described previously. 
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Control of Data Acquisition 
You may control data acquisition automatically or in real time. 

Automatic Control 
Automatic control begins with the specification of the stimulus schedule.  Once 
the stimulus schedule has been specified, you may make further modifications to 
automatic stimulus presentation through use of some of the SGI Control features 
shown above. 

Modifying the Stimulus Schedule 
See Chapter 3, 
“Specifying the Stimulus 
Schedule” for more 
information. 

The manner in which stimulus parameter values vary as a function of the SGI is 
initially defined during signal design in SigGenRP.  You may make further 
modifications to the stimulus schedule from within BioSigRP. 

Modify Schedule.  The Modify Schedule button provides access to the 
SigGenRP Variable Control dialog box, from which you may alter the stimulus 
schedule. 

Automatic Repetition of the SGI 
You may wish to repeat an SGI automatically.  BioSigRP allows you to 
automatically present an SGI once, twice, or three times. 

To present an SGI once only 
 Make sure that the Each Twice and Each Thrice boxes are not checked. 

To present an SGI twice 
 Check the Each Twice box. 

To present an SGI three times 
 Check the Each Thrice box. 

Real-Time Control 
You may wish to control data averaging in real time.  BioSigRP provides several 
functions that allow you to override the current stimulus schedule.  These 
functions include: 

 Advance 

 Skip 

 Repeat 

 ReDo 

 Continuous 
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 Manual SGI Control 

 Dynamic Variable Control 

Note:  In some cases, real-time control of data averaging will result in averaged 
signals based on some number < n, where n is the number of signals per average 
that you specified during setup.  The actual number of signals used to compute 
the average is associated with the record and stored in the BioSigRP record file, 
(.arf file).  It may be viewed from the BioSigRP Cursor Edit Screen (See 
“Chapter 5”). 

 

Advance 
The Advance function causes the stimulus to advance to the next SGI specified 
in the stimulus schedule.  This menu option is enabled in Averaging and Paused 
modes, only.  When advance is chosen, the follow process occurs: 

1. Stimulus presentation at the current SGI is halted. 

2. The running average for the current SGI is saved to the BioSig record file 
(.arf file). 

3. The averaged signal is appended to the history plot. 

4. Stimulus presentation is advanced to the next SGI as defined in the stimulus 
schedule. 

5. A new stimulus signal is generated based on the stimulus parameters for the 
new SGI. 

6. Data averaging begins at the new SGI. 

To advance data averaging to the next SGI 
While in Averaging or Paused mode,  

 Click the Advance button. 

   or 

 Choose Advance from the Operations menu. 
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Skip 
The Skip function causes the stimulus to skip the current SGI.  This menu option 
is enabled in Averaging and Paused modes.  The process is as follows: 

1. The average for the current SGI is discarded. 

2. Stimulus presentation is advanced to the next SGI specified in the stimulus 
schedule. 

3. A new stimulus signal is generated based on the stimulus parameters for the 
new SGI. 

4. Data averaging begins at the new SGI. 

To skip the current SGI 
While in Averaging or Paused mode, 

 Click the Skip button. 

   or 

 Choose Skip from the Operations menu. 

Repeat 
The Repeat function repeats the current SGI.  This menu option is enabled in 
Averaging and Paused modes.  The process is as follows: 

1. The running average for the current SGI is saved to the BioSig record file 
(.arf file). 

2. The averaged signal is appended to the history plot. 

3. The stimulus is re-presented at the current SGI. 

4. This second average is also saved to the BioSig record file (.arf file) and 
appended to the history plot. 

To repeat the current SGI 
While in Averaging or Paused mode, 

 Click the Repeat button. 

   or 

 Choose Repeat from the Operations menu. 
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ReDo 
The ReDo function restarts the current SGI.  This menu option is enabled in 
Averaging and Paused modes.  The process is as follows: 

1. The average for the current SGI is discarded. 

2. The stimulus is re-presented at the current SGI. 

3. This second average is saved to the BioSig record file (.arf file) and 
appended to the history plot. 

To re-do the current SGI 
While in Averaging or Paused mode, 

 Click the ReDo button. 

   or 

 Choose ReDo from the Operations menu. 

Continuous 
Choosing Continuous causes BioSigRP to continuously average data.  When 
Continuous is chosen, BioSigRP will continue to average response data 
indefinitely, regardless of n, the number of signals per average that you specified 
during setup. 

To enable continuous data averaging 
 Check the Continuous Avg. box. 

  or 

 Choose Continuous from the Operations menu. 

To disable continuous data averaging  
 Uncheck the Continuous box. 

  or 

 Choose Continuous from the Operations menu. 

This will disable continuous data averaging.  Data averaging will continue based 
on the acquisition parameters that you specified during setup. 

To halt continuous data averaging 
 Click the End button. 

  or 

 Choose End from the Operations menu. 

This will end all data averaging. 
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Manual SGI Control 

 

You may manually advance stimulus presentation through use of Manual SGI 
Control. 

To enable manual control 
 Check the Manual box. 

To advance to the next SGI 
 Click −> 

To return to a previous SGI 
 Click <− 

Dynamic Variable Control 
You may manually control stimulus presentation through the use of dynamic 
variables.  A variable may be defined as dynamic during design in SigGenRP or 
during modification in BioSigRP.  The value of a dynamic variable may be 
changed at any time during stimulus presentation. 

To display all dynamic variables 
1. Choose Dyn Controls from the View menu. 

To change the current value of a dynamic variable 
1. Hit the Current button.   

2. Enter the desired value. 

3. Click OK. 

You may wish to dynamically specify a step value, or Delta value.  A Delta 
value defines how the variable will be modified with each SGI.  The Next button 
displays the projected value of the variable for the next SGI given the current 
Delta value. 

To specify a Delta value 
1. Click the Delta button. 

2. Enter the desired Delta value. 

3. Click OK. 

You may wish to override the value of the variable for the next SGI.   
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To override the next value 
1. Click the next button. 

2. Enter the desired value. 

3. Click OK. 

You may wish to decrement the variable by the specified Delta value.  You may 
reverse the sign of the Delta value by clicking the +/1 Delta button. 



4-16 Chapter 4: Data Acquisition 

BioSigRP User's Guide   



 

  BioSigRP User's Guide 

Chapter 5   Data Analysis 
BioSigRP provides numerous analysis functions.  Using these functions you 
may: 

 Obtain detailed information about specific records. 

 Designate a history record for use as a comparison. 

 Perform calculations involving one or more records. 

 Build and print customized reports. 

Using the History Plot and BioSigRP Record Files 

 

BioSigRP’s History Plot and BioSigRP record files are central to all BioSigRP 
data analysis capabilities.   

The History Plot.  From the History Plot, you may select records for further 
analysis.  Signals are automatically appended to the History Plot as they are 
averaged.   

BioSigRP Record Files.  BioSigRP record files store averaged signals for later 
analysis.  As signals are averaged they are appended to the currently defined 
BioSigRP record file (.arf file).   



5-2 Chapter 5: Data Analysis  

BioSigRP User's Guide   

Through use of the History Plot and .arf files, you may easily average, organize, 
store, retrieve, and analyze signal records.   

 Averaged data is automatically appended to the History Plot. 

 Averaged data is automatically appended to the currently specified .arf file. 

 Records may be retrieved from a specified .arf file for display in the History 
Plot at any time. 

 Records may be saved to a separate .arf file. 

 Records may be saved to an ASCII text file (.txt file) for use by other 
applications. 

 Records may be deleted from an .arf file. 

Specifying the Current BioSigRP Record 
File 

See Chapter 3, 
“Defining Data 
Acquisition Parameters” 
for more information. 

Prior to averaging data, you must specify the BioSigRP record file (.arf file) to 
which averaged data will be appended.  You may specify the .arf file in one of 
two ways: 

 You may specify a default .arf file during acquisition setup. 

 You may define the current .arf file when prompted immediately prior to 
data acquisition. 

Loading Records 
BioSigRP organizes averaged records into groups.  A new group is begun each 
time you "Begin" data averaging and is ended each time you "End" data 
averaging.  From the Access Record Groups dialog box, you may: 

 Retrieve groups of averaged signals. 

 Save specific groups to separate .arf files. 

 Save specific groups to ASCII text files (.txt files). 

 Delete groups of records from the .arf file. 

To access the Access Record Groups dialog box 
1. Choose Access Record File from the History menu. 

2. Specify the desired file name and click OK. 
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The Access Record Groups dialog box displays the following information: 

No.  This column displays the group number. 

Subject ID.   The Subject ID associated with the group of records is displayed 
in this column. 

Reference1.  This column displays the Reference1 information assigned to the 
group. 

Reference2.  This column displays the Reference2 information assigned to the 
group. 

No. Recs.  The number of records in the group is displayed in this column. 

Date/Time.   This column displays the date and time the group of records was 
acquired. 

S.G. File.   The S. G. File column displays the name of the SigGenRP file used 
to generate the stimulus signal. 

Selecting Groups 
 
For a reminder on how 
to select items from a 
list in Windows, see 
Chapter 2.  

Windows provides standard procedures for selecting/deselecting groups.  You 
may use these procedures to select groups from the Access Record Groups 
dialog box. 

To deselect all groups 
 Click the Clear Selections button. 



5-4 Chapter 5: Data Analysis  

BioSigRP User's Guide   

Performing Actions 
Groups may be loaded into the History Plot, deleted from the .arf file, exported 
to another .arf file, or exported to an ASCII text file (.txt file).   

To load, delete, or export a group of records 
1. Select the desired groups. 

2. Click the appropriate button. 

Load.   If the chosen action is Load, then you will see the Select Records to 
Load dialog box. 

 

3. Select the record(s) you wish to load and hit Load Sel. 

    or 

4. Load all the records by hitting Load All. 

You may manually select/deselect records for loading or you may use the 
Select... buttons to automatically select/deselect records. 

Delete.   If the chosen action is Delete, you will be prompted "Are you sure?"  If 
you answer "yes," the selected groups will be deleted from the file.  The Access 
Record Groups dialog box will remain open. 

Export to ARF or Export to ASCII.   If the chosen action is an export, you 
will be asked to supply the export file name.  The selected groups will be saved 
to the designated file.  The Access Record Groups dialog box will remain open.   
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Access Another BioSig Record File 

 

To access another BioSig Record File 
1. Click the Select File button. 

2. Choose the desired file. 

Closing the Load Record Group Dialog Box 

To close the Load Record Group dialog box 
 Click the Done button. 

The History Plot  

  

Customizing History Info 
You may customize the information displayed in the History Info area. 

History Info 
Area 

History Plot 
Area 
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To customize the History Info area 
 Click the right mouse button in the History Info area. 

You will see the Info-Bar Setup dialog box. 

 

From this box you may specify items to be displayed in the History Info area.  
You may also associate a group color with a particular variable.  Group colors 
are created from the General Display Options dialog box (See Chapter 2). 

Display Items...  From the Display Item group box, you may specify all 
information to be displayed in the History Info area.  Display items consist of 
the following: 

 SGI 

 The current SigGen Index. 

 Record No. 

 The current record number. 

 Gain 

 The gain as currently defined in the Acquisition Setup dialog box. 

 No. Averages 

 The number of signals from which the average was calculated. 

 No. Artifacts 

 The total number of signals discarded due to artifact rejection. 

 Start Time 

 The start time of data acquisition. 

 T1 - CompT1 



   Chapter 5: Data Analysis 5-7 

  BioSigRP User's Guide 

 The difference in milliseconds between Cursor 1 of the current record and 
Cursor 1 of the Comparison record.   

 T2 - CompT2 

 The difference in milliseconds between Cursor 2 of the current record and 
Cursor 2 of the Comparison record.   

 dV/CompV 

 Delta V percentage calculated as follows: 

∆V of the current record/ ∆V of the Comparison record * 100 

To select information for display in the History Info area 
 Check the desired box. 

You may check multiple boxes. 

Display Variables.  You may specify which, if any, variables you wish to 
display.  Chosen variable names and current variable values will be displayed 
for each record in the History Plot.  You may also assign a color to a variable.  
Finally, you may customize the variable display by abbreviating the variable 
names or excluding the unit description (e.g., ms, Hz, dB). 

To select variables for display in the History Info area 
 Check the desired variable box. 

You may check multiple boxes. 

To assign a color to a variable 
1. Create the desired Group Color (A or B) from the General Display Options 

dialog box (See Chapter 2). 

2. Check the desired color, Code-A or Code-B. 

To abbreviate variable names 
 Check the Abbreviate Variable Names check box. 

All variable names will be abbreviated. 

To exclude unit descriptions 
 Check the Exclude Unit Descriptions check box. 

All unit descriptions will be omitted from display. 
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Exporting History Plot Records 
 
 
 
 
 
In Chapter 2, the 
procedure used to select 
History Plot records is 
described.  Additional 
History Plot functionality 
is also presented. 

Groups of records can be reorganized through use of the Load Record Group 
dialog box.  Individual records can be reorganized through use of the History 
Plot. 

Individual History Plot records may be exported to another .arf file or exported 
to an ASCII text file (.txt file).   

To export History Plot records 
1. Select the desired records. 

2. Choose the appropriate action from the History menu. 

3. Supply the file name. 

The selected groups will be appended to the designated file.   

Making a Comparison Record 
BioSigRP allows you to choose a record for comparison with other data records.  
Any record currently displayed in the History Plot may be used as a comparison 
record.   

The comparison record may be displayed in the Cursor Edit window.  This 
window is explained in greater detail in the following section, "Viewing 
Records in Detail."  The comparison record may also be displayed in the Multi-
Purpose Plot during data acquisition. 

To make a comparison record 
1. Click the desired record. 

2. Choose Toggle Comparison from the History menu. 

    or 

 Ctrl+Double-click the desired record. 

To display a comparison record in the Multi-Purpose Plot 
1. Choose Show Comparison from the Multi-Plot menu. 

2. Choose Running Average from the Multi-Plot menu. 

The comparison record will be displayed along with the running average. 

Viewing Records in Detail 
You may wish to view individual history records in greater detail.  From the 
Cursor Edit window, you may: 

 View a more detailed plot of the time-domain waveform. 

 View frequency-domain information. 

 View subject information. 

 Place cursors to obtain intensity and time information. 

 View information pertaining to the SGI. 
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To access the Cursor Edit window 
 Double-click the desired History Plot record. 

  or 

1. Click the desired History Plot record. 

2. Choose Edit Cursors from the History menu. 

 

Time-Domain Plot 
The Cursor Edit window contains two waveform plots.  The upper plot displays 
the time-domain waveform.  The x-axis is labeled in units of time.  The y-axis is 
labeled in dB Volts. 

Using Zoom 
You may zoom-in on a portion of the time-domain waveform. 

To zoom-in on a portion of the time-domain waveform 
1. Place the mouse pointer at the beginning of the zoom area. 

2. Hold down the left mouse button. 

3. Drag the mouse pointer to the end of the zoom area. 

4. Release the left mouse button. 
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To return to the original time-domain waveform 
 Click the right mouse button anywhere in the Time-Domain Plot. 

Frequency-Domain Plot 
BioSigRP performs a Fast Fourier Transform (FFT) on the waveform displayed 
in the Time-Domain Plot.  The resulting frequency-domain waveform is 
displayed in the lower plot on the BioSig Cursor Edit window.  The x-axis is 
labeled in Hz.  The y-axis is labeled in dB Volts. 

Using Zoom 
You may zoom-in on a portion of the frequency-domain waveform. 

To zoom-in on a portion of the frequency-domain waveform 
1. Place the mouse pointer at the beginning of the zoom area. 

2. Hold down the left mouse button. 

3. Drag the mouse pointer to the end of the zoom area. 

4. Release the left mouse button. 

To return to the original frequency-domain waveform 
 Click the right mouse button anywhere in the Frequency-Domain Plot. 

Subject Information 
Subject information is displayed in the Group Info group box.  This box displays 
the following information: 

Group Info.  Each time you initiate Averaging mode by choosing Begin, a new 
data group is created and appended to the end of the BioSig record file (.arf file) 
and to the end of the History Plot.  Groups are numbered sequentially.  The 
Group Info title displays the group number of the current record.  

Subject ID:  This read-only field displays the subject ID that you assigned 
during the initiation of Averaging mode. 

Ref1 and Ref2.  These read-only fields display other subject data that you 
assigned during the initiation of Averaging mode. 

Memo.  This read-only field displays any additional text information that you 
assigned during the initiation of Averaging mode.  
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Cursors 
You may place up to 10 cursors in the Time-Domain Plot.  Cursors may be used 
to obtain specific information concerning: 

 Level at a specific point 

 Time at a specific point 

 Change in time (∆T) between two points 

 Change in voltage (∆V) between two points 

Working with Cursors 
Cursors may be manipulated in various ways: 

To place a cursor in the Time-domain Plot 
 Double-click the desired position. 

  or 

1. Click the Add Cursor button. 

2. Move the Cursor to the desired position. 

Note:  Placing a cursor is more precise if you first zoom-in on a portion of the 
signal. 

To move a cursor 
1. Place the mouse above the cursor. 

2. Hold down the left mouse button. 

3. Drag to the desired position. 

Note:  Moving a cursor to a new position is more precise if you first zoom-in on 
a portion of the signal. 

To select a cursor 
1. Click the cursor. 

2. The selected cursor text appears surrounded by a small box. 

To delete a cursor 
1. Select the desired cursor. 

2. Click the Delete Cursor button. 
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Cursor Info 

 

Information about the selected cursor is displayed in the Cursor Info group box. 

Cursor Info.  The title of the Cursor Info group box displays the number of the 
currently selected cursor. 

Time.  The Time field displays the time value associated with the currently 
selected cursor. 

Level.  The Level field displays the instantaneous intensity level associated with 
the currently selected cursor. 

Tn - T1.  This field displays the difference in time (∆T) between the selected 
cursor (Cursor n) and Cursor 1. 

Ln - L1.  This field displays the difference in intensity (∆L) between the 
selected cursor (Cursor n) and Cursor 1. 

RMS 1>2.  This field displays the RMS amplitude as calculated between cursors 
1 and 2. 

Text.  The text field displays the label associated with the currently selected 
cursor.  You may edit this label. 

To edit the cursor label 
1. Type the desired text in the Text field. 

2. Click the cursor. 

The cursor label will be updated. 

To move the cursor label relative to the cursor 
1. Place the mouse pointer over the desired label. 

2. Hold down the left mouse button and drag the label to the desired 
position. 

3. Release the left mouse button. 

Default.  Clicking the Default button causes the label of the currently selected 
cursor to return to its default setting. 
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Hide.  Checking this box hides the label of the currently selected cursor. 

Lock Position.  You may lock the position of the currently selected cursor by 
checking the Lock Position box. 

Comparison Data 

 

Information about the relationship of the current record to the comparison record 
is displayed in the Comparison Data group box. 

To display the comparison record 
Check the Show Comparison box. 

The comparison record will be displayed in the Time-domain plot along with the 
current record.  The location of cursors in the comparison plot will be displayed 
with vertical dashed lines. 

Delta T1.  This field displays the difference in time between Cursor 1 of the 
current record and the comparison record. 

Delta T2.  This field displays the difference in time between Cursor 2 of the 
current record and the comparison record. 

Delta V.  This field displays a percentage value computed as follows: 

∆V of the current record / ∆V of the Comparison record * 100 

Record Information 

 

Information about the current record is displayed in the Record Info group box. 

SigGenRP Index.  The SGI associated with the current record is displayed in 
the SigGenRP Index field. 

Channel.  The current channel is displayed in the Channel field. 
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Time.  The duration of the record is displayed in the Time field. 

Averages.  The number of sweeps included in the average is displayed in the 
Averages field. 

Artifacts.  The number of responses discarded due to artifact rejection is 
displayed in the Artifacts field. 

Variables.  The Variables box contains a list of all signal variables and their 
current values. 

Using the Worksheet 

 

You may use the Worksheet to set aside records for mathematical operation or 
to build and print reports.  The process is simple and straightforward. 

1. Place all desired History Plot records into the Worksheet. 

2. Format tokens and traces. 

3. Select records in the Worksheet for mathematical operations. 

4. Perform mathematical operations using the Calculator. 

5. View Worksheet records in detail. 

5. Organize the report. 

6. Print the report. 

Placing Records 
To place History Plot records into the Worksheet 
1. Select the desired record(s). 

2. Choose To Worksheet from the History menu. 

 A box appears in the Worksheet. 

3. Move the box to the desired location. 

Token Trace 
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4. Click the left mouse button. 

   or 

1. Select the desired record(s). 

2. Drag the selected record(s) from the History Plot to the Worksheet. 

The selected History Plot record(s) will be placed into the Worksheet. 

Formatting Tokens and Traces 
You may customize the following: 

 The general worksheet area 

 Specific tokens 

 Specific traces 

Customizing the General Worksheet 
You may customize the Worksheet area from the Worksheet Preferences dialog 
box.  This dialog box controls the default behavior of the Worksheet. 

To access the Worksheet Preferences dialog box 
 Click the right mouse button anywhere in the Worksheet, but not directly 

above a trace or a token. 

 

The Worksheet Preferences dialog box is divided into two sections: 

 Default Trace/Token Behavior 

 Display Options 
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Preference settings located within the Default Trace/Token Behavior section 
affect trace or token parameters.  These Worksheet preferences affect all records 
subsequently placed into the Worksheet.  You can override these settings by 
specifically customizing tokens and traces as described in the following section, 
"Customizing Specific Tokens." 

Parameter settings located in the Display Options section affect the Worksheet 
as a whole.   

Token Assignments.  You may assign up to five tokens for each Worksheet 
record.  Tokens may consist of a variety of parameters.   

Parameters.  Token Assignment parameters may be selected from the 
Parameter list boxes found in the Token Assignments group box. 

Include Description.  Token Assignment parameters consist of a 
description and a number.  For example, Channel and Record No. consist of 
a description ("Chan:" and "Rn:", respectively) followed by a number.  By 
default, all token descriptions are displayed.  You may choose to omit the 
description from the Worksheet display.  To do so, simply uncheck the 
appropriate Include Description check box. 

Trace Coloring Mode.  You may wish to enhance the Worksheet display 
through the application of trace color.  You may choose one of the following 
Trace Coloring Modes: 

Rotating Colors.  Causes trace colors to rotate.  Rotating colors are 
assigned based on the Trace colors you defined in the Worksheet Display 
Options dialog box. 

Color Piles Only.  Assigns the same color to all records stacked in the same 
pile. 

Color per Channel.  Assigns unique trace colors for each channel. 

Unique Per Trace.  Assigns a unique color to each trace. 

Token Coloring Mode.  Token color may be assigned the following ways: 

Default Token Colors.  Assigns the token colors you defined in the 
Worksheet Display Options dialog box. 

Match to Trace Color.  Overrides the default token color and assigns the 
color of the associated trace. 

Display Options.  You may control the look of the overall Worksheet display 
by specifying the following: 

Vertical Plot Size.  Controls the vertical dimension of the plot. 

Show Cursors.  Displays any cursors placed in the record. 

Show Margins.  Shows/hides the margin lines used to separate Worksheet 
sections. 

Snap Grid.  Controls the fineness of the Snap-to-Grid.  This is the invisible 
grid onto which all Worksheet objects snap into place. 

Visible Grid.  Controls the visible grid.  You may choose no grid or control 
the resolution of the visible grid. 

Adjust Colors.  From the Adjust Colors button, you may modify color settings 
through the Worksheet Display Options dialog box. 
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Change All.  Token and Trace preferences affect all records subsequently 
placed into the Worksheet.  If you wish to change these preferences for records 
currently displayed in the Worksheet, you must click the appropriate Change All 
button.   

Local Change All Buttons.  You may modify existing Worksheet record 
parameters individually by clicking the appropriate "local" Change All 
button.  Local Change All buttons are provided for the following: 

 Token Assignment parameters 

 Trace Coloring Mode settings 

 Token Coloring Mode settings  

Global Change All   You may modify existing Worksheet record 
parameters as a group by clicking the "global" Change All button.  The 
Global Change All button simultaneously updates all parameters located in 
the Default Trace/Token Behavior section. 

Customizing Specific Tokens 

To customize a specific token 
 Click the right mouse button on the desired token. 

You will see the Token Options dialog box.  From here you can modify the 
token, position the token, change its text, or cause it to be hidden. 

 

Parameter and Include Description.  You may change the Parameter and 
show/hide the token description.  For more information, see the above section, 
"Customizing the General Worksheet." 

Text.  You may customize the token by entering the desired text in this field. 

Note: To change a token's text you must first choose User Text from the 
Parameter list. 

Auto-Place.  Realigns the token with its trace. 

Hide.  Hides the token. 

Copy Relative Position.  Copies the position of the token relative to its trace to 
all other traces and tokens. 

Delete.  Deletes the token. 
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Customizing Specific Traces 

To customize a specific trace 
 Click the right mouse button on the desired trace. 

You will see the Response Trace Options dialog box.  From here you can 
modify the trace color, position the trace, edit its token, delete the trace, or cause 
its tokens to be hidden. 

 

Trace Coloring Mode and Token Coloring Mode.  You may set the Trace or 
Token coloring modes.  For more information see the previous section, 
"Customizing the General Worksheet." 

Set Color.  This button accesses the Color dialog box, from which you may set 
custom colors. 

Edit Tokens.  You may edit the tokens associated with a specific trace.  
Clicking the desired token button opens the Token Options dialog box (see 
previous section). 

Hide All.  Hides all tokens associated with the current trace. 

Show All.  Shows all tokens associated with the current trace. 

Auto Position All.  Realigns all associated tokens with the current trace. 

Delete Trace.  Deletes the current trace. 
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Selecting Worksheet Records 
Various Calculator and Worksheet formatting functions require the selection of 
one or more record.   

To select specific records 
 Ctrl+Click the desired trace(s). 

The record's token will appear in reverse video. 

Note: You must Ctrl+Click the trace.  A Ctrl+Click on the token will not select 
the record. 

To select all records 
 Choose Select All from the Worksheet menu. 

   or 

 Hit the Spacebar. 

To select contiguous records 
1. Hold down Ctrl and the left mouse button. 

2. Drag until the box surrounds all desired records 

3. Release the left mouse button and the Ctrl key. 

To deselect specific records 
 Ctrl+Click the desired selected trace(s). 

Note:  You must Ctrl+Click the trace.  A Ctrl+Click on the token will not 
deselect the record. 

To deselect all records 
 Choose Deselect All from the Worksheet menu. 

   or 

 Hit Ctrl+Space bar. 

Performing Mathematical Operations 
You may perform a variety of mathematical operations on Worksheet records.  
These operations are described in detail in the following section, "Using the 
Calculator." 

To perform a mathematical operation 
1. Select the desired Worksheet record(s). 

2. Click the appropriate Calculator button. 

  or 

Choose the appropriate Calculator menu option. 
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Viewing Worksheet Records in Detail 
You may view a worksheet record in detail from the BioSig Cursor Edit dialog 
box. 

To access the BioSig Cursor Edit dialog box 
 Double click on the desired Worksheet record. 

Organizing the Report 

Moving a Record 
You may move individual records.  Moving a record moves both the trace and 
all associated tokens. 

To move a record 
1. Place the mouse pointer over the trace. 

2. Hold down the left mouse button. 

3. Drag the record to the desired position. 

4. Release the mouse button. 

Note:  You must place the mouse pointer over the trace.  Placing the mouse 
pointer over the token will move the token only. 

To move a group of records 
1. Select the desired records. 

2. Place the mouse pointer over a selected trace. 

3. Hold down the left mouse button. 

4. Drag the records to the desired position. 

5. Release the mouse button. 

Note:  Selected records always move as a block.  If you wish to move only one 
record of a selected block, deselect the record, move it, and then re-select the 
record. 

Moving a Token 
You may wish to move a token relative to its associated trace. 

To move a token 
1. Place the mouse pointer over the token. 

2. Hold down the left mouse button. 

3. Drag the token to the desired position. 

4. Release the mouse button. 
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Using the Worksheet Buttons 
Located below the Calculator, the five Worksheet buttons can be used to format 
and organize the Worksheet.  These functions may also be found in the 
Worksheet menu. 

Button Menu Option Action 

 
Space Evenly Spaces all selected plots evenly throughout the 

Worksheet. 

 
Spread Apart Spreads all selected plots apart.   

 
Squash 
Together Squashes all selected plots together. 

 
Pile Piles all selected plots on top of one another. 

 
UnPile Unpiles all selected plots. 

 
Delete Deletes the currently selected Worksheet records. 

Printing a Report 
BioSigRP provides the standard Windows functions:  Print Setup, Print Preview, 
and Print. 

To setup the printer 
 Choose Print Setup... from the File menu. 

To preview the Worksheet 
 Choose Print Preview from the File menu. 

To print the Worksheet 
Choose Print... from the File menu. 

Saving Data to an ASCII File 
All Worksheet data may be saved to an ASCII file.  Such data can be accessed 
by other applications. 

To save Worksheet data to an ASCII file 
 Choose Export to Ascii... from the Worksheet menu. 

You will be prompted to name the file. 
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Worksheet Enhanced File Export 
The Export to CSV option allows you to export raw trace data along with 
descriptors into a standard spreadsheet file.  Each row in the spreadsheet file 
contains all of the data for one record. 

 
 

Selecting Items 
You may select one or more miscellaneous item, SigGen variable, or cursor.   

To select individual items 
 Check the appropriate box. 

To select all items within a box 
 Click All. 

To deselect all items within a box 
 Click None. 

Misc. and SigGen Variables 
Saves the selected fields to the spreadsheet file. 
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Cursors 

X/Y Values 
Exports both X and Y values for cursors. 

X Values 
Exports only X values for cursors.  Does not export Y values. 

Indexes 
Exports the indices of the cursors.  This indicates which sample in the waveform 
the cursor was located on. 

Trace Data 

Sample Period 
Sampling period in microseconds of the acquired data. 

No. Samples 
Number of samples in the trace 

O.S. Time/Freq 
Offset of the first point in waveform in ms for Time or Hz for Frequency. 

Data Samples 
Saves the data for the waveform 

Units 
Scales the output to the units that are selected.  For example, a cursor value that 
is .0001 V, will be output as 100.0 µV if microvolts is selected. 

Output Format 
Sets the output format of the data.  For example #.### will export data to three 
significant digits. 

Template  
Saves the export settings from the CSV File Export dialog box to a file that can 
be reloaded later. 

Report Name 
You must specify how the report is to be formatted.  Additionally, you may give 
the report a title. 

To define a title 
 Enter the title in the Title field. 
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Generating the Report 

To generate the report 
 Press the Generate button. 

Using the Calculator 
The calculator provides numerous mathematical functions that may be applied to 
one or more Worksheet records. 

 

Calculator Functions 
 Scale 

 Invert BioSig 

 Shift Baseline 

 Remove Baseline 

 Zero Points 

 Crop 

 Add 

 Subtract 

 Average 

 Time Align 

 Time Shift  

 Smooth 

 Lowpass Filter 

 Highpass Filter 

 Bandpass Filter 

 Notch Filter 

 Hanning Window 

 Cosine^2 Window 

 Mag Spectrum 

 Auto Cursor 
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Scale 
The Scale function multiples each point in the selected Worksheet record(s) by a 
user-defined constant.  This function may be used to increase or decrease the 
scale of a waveform displayed in the Worksheet.  By specifying a negative scale 
factor, you may also invert the selected Worksheet record(s). 

To scale a Worksheet record 
1. Select the desired record(s). 

2. Click   

  or 

 Choose Scale from the Worksheet menu. 

You will be prompted to enter the desired scale factor.  This factor must be no 
less than -(1010) and no greater than 1010.   

Invert BioSig 
Invert BioSig multiplies each point in the selected Worksheet record(s) by -1, 
thereby inverting the waveform while maintaining its original scale. 

To invert a Worksheet record 
1. Select the desired record(s). 

2. Click   

  or 

 Choose Invert BioSig from the Worksheet menu. 

Shift Baseline 
The Shift Baseline function adds a user-defined constant, or DC offset, to each 
point in the selected records(s), effectively shifting the baseline. 

To add a DC offset to a Worksheet record 
1. Select the desired record(s). 

2. Click   

  or 

 Choose Shift Baseline from the Worksheet menu. 

You will be prompted to enter the DC offset.  This offset must be no less than 
-1000 microvolts and no greater than 1000 microvolts.   
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Remove Baseline 
A DC offset may be removed through the use of Remove Baseline. 

To remove a DC offset from a Worksheet record 
1. Select the desired record(s). 

2. Click   

  or 

 Choose Remove Baseline from the Worksheet menu. 

Zero Points 
The Zero Points function allows you to "zero out" a specific portion of a 
Worksheet record.  Zero Points will convert each point within the specified time 
range to a value of zero. 

To zero a portion of the record 
1. Select the desired record(s). 

2. Click   

  or 

 Choose Zero Points from the Worksheet menu. 

You must specify the time interval within which you wish to convert all level 
values to zero.  You will be prompted to enter a lower time boundary and an 
upper time boundary.   

Add 
The Add function adds two or more Worksheet records. 

To add Worksheet records 
1. Select two or more records. 

2. Click   

  or 

1. Choose Add from the Worksheet menu. 

 A box appears in the Worksheet. 

2. Move the box to the desired location. 

3. Click the left mouse button. 

The resulting record will be added to the Worksheet. 
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Subtract 
The Subtract function allows you to subtract one Worksheet record from 
another. 

To subtract one Worksheet record from another 
1. Select the record from which you wish to subtract. 

2. Select the record you wish to subtract. 

3. Click   

  or 

1. Choose Subtract from the Worksheet menu. 

 A box appears in the Worksheet. 

2. Move the box to the desired location. 

3. Click the left mouse button. 

The resulting record will be added to the Worksheet. 

Average 
The Average function calculates the average of two or more records. 

To average Worksheet records 
1. Select two or more records. 

2. Click   

  or 

1. Choose Average from the Worksheet menu. 

 A box appears in the Worksheet. 

2. Move the box to the desired location. 

3. Click the left mouse button. 

The resulting record will be added to the Worksheet. 
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Time Align 
The Time Align function lines up two or more records according to values on 
the time axis.  Records will be aligned with the first selected record of the group. 

To time align Worksheet records 
1. Select two or more records. 

2. Click   

  or 

 Choose Time Align from the Worksheet menu. 

The records will be aligned in time. 

Time Shift 
The Time Shift function shifts the selected record(s) along the time axis. 

To time shift Worksheet records 
1. Select the desired record(s). 

2. Click   

  or 

 Choose Time Shift from the Worksheet menu. 

You will be prompted to enter the amount of time shift in milliseconds.  This 
number can be no less than -100 ms and no greater than 100 ms. 

Note:  Once data points have been time-shifted off the Worksheet display, they 
cannot be retrieved.  These points in effect no longer exist.  All such points will 
appear as zero. 

Smooth 
The Smooth function smoothes a selected Worksheet through application of an 
averaging algorithm.  The record is averaged with a shifted version of itself. 

To smooth a Worksheet record 
1. Select the desired record(s). 

2. Click   

  or 

 Choose Smooth from the Worksheet menu. 
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You will be prompted to enter the number of smooth points.  This is the number 
of points to be included in the average.  For example, specification of 2 smooth 
points will cause the record to be average with a second version of itself shifted 
by one point.  Specification of 3 smooth points will result in an average based on 
the original record, a version of the record shifted by one point, and a version of 
the record shifted by two points.   

The resulting record will be added to the Worksheet. 

Filtering 
BioSig provides functions allowing you to lowpass, highpass, bandpass filter, or 
notch filter Worksheet records.  BioSig performs filtering through use of a 
Butterworth filter.   

In order to specify a filter, you must define certain filter parameters.  These 
parameters include: 

 Corner frequency 

 Frequency at which the level has decreased by 3 dB.   

 Center frequency 

 The center frequency of a bandpass filter.   

 Filter Bandwidth 

 The bandwidth between lower and upper corner frequencies of a bandpass 
filter.  Filter bandwidth is defined in octaves.  Filter bandwidth must be at 
least 0.01 octave and no greater than 10 octaves. 

 Filter order 

 The number of poles necessary to achieve a desired roll-off rate.  Roll-off 
rate = 6 dB per octave per pole.  Number of poles must be an even number.  
Number of poles must be at least 2 and no greater than 20. 

Example:  Specifying a Filter 

You may wish to specify a lowpass filter with a -3 dB frequency of 4000 Hz and 
a roll-off of 120 dB per octave.  You would define the following parameters: 

Corner frequency = 4000 Hz 

Filter order = 20 poles. 

120 dB per octave/ 6 dB per octave = 20 poles 

To filter a Worksheet record 
1. Select the desired record(s). 

Lowpass/Highpass Filter Bandpass or Notch Filter 

2. Click  or  2. Click  or  

3. Enter corner frequency. 3. Enter center frequency. 

4. Enter filter order. 4. Enter filter bandwidth. 

 5. Enter filter order. 
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Chapter 6   Quick Start Examples 
The Quick Start examples presented in this section illustrate common 
procedures for collecting ABR audiogram data.  Quick Start examples are 
designed to introduce important concepts.  Ready-to-use application files are 
provided for each Quick Start example. 

 
 
 

 

Learn New Concepts 
Each example in this section provides step-by-step instructions you may use to 
build the Quick Start example from scratch.  Along the way, you will be 
introduced to important concepts.  These concepts are always indicated with the 
icon currently seen in the left margin. 

The examples found in this section are listed below.  Also listed are the concepts 
introduced in each example. 

Example 1  Using a Tone Stimulus 
 Value List 

 Repeat Factor 

 Boundary Control 

 

 Loop  

 Gate Type 

 Gain 

Example 2  Using a Click Stimulus 
 Alternating Variable 

 Combination Variable 

 Uniphasic Click 

 
 
 
 

 

Get a Quick Start 
Completed SigGenRP and BioSigRP files are provided for all examples in this 
section.  If you prefer, you may use these files, bypassing the step-by-step 
instructions.  Quick Start file names are listed at the beginning of each example.  
Look for these files whenever you see the Quick Start icon currently displayed 
in the left margin.  Instructions for accessing these files and running the 
applications appear in boxes and are always located next to a Quick Start icon. 

 

 



6-2 Chapter 6: Quick Start Examples 

BioSigRP User's Guide   



   Chapter 6: Quick Start Examples 6-3 

  BioSigRP User's Guide 

Example 1:   Using a Tone Stimulus 

 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 Value List 

 Repeat Factor 

 Boundary Control 

 Loop 

 Gate Type 

 Gain 

This experiment is designed to gather auditory brainstem response (ABR) data 
in response to a pure tone stimulus.  Five millisecond tones will be presented at 
the following frequencies:  500 Hz, 1000 Hz, 2000 Hz, and 4000.  For each 
frequency, tone level will vary from 80 dB SPL to 5 dB SPL in 5 dB 
decrements.   

The Quick Start files necessary to run this experiment are as follows: 

 SigGenRP signal file 
 C:\TDT\SigGenRP\BioSigRP\Files\TnstRP.sig 

 BioSigRP configuration file
 C:\TDT\SigGenRP\BioSigRP\Files\TnstRP.acf 

To run the experiment, you will need to perform the following steps: 

1. Build the SigGen Signal. 

a. Run SigGenRP. 

b. Define the signal parameters. 

c. Define frequency and level variables. 

d. Create the segment and component. 

e. Save the SigGenRP File. 

2. Run the experiment with BioSigRP. 

a. Run BioSigRP. 

b. Setup the stimulus parameters. 

c. Setup the acquisition parameters. 

d. Save the .acf file. 

e. Run the experiment. 

f. Analyze the data. 

Note:  Only those parameters to be entered or selected are given below.  All 
other parameters will remain according to the default settings. 
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Building the SigGen Signal 
In this example, you will use TDT's signal generation software, SigGenRP, to 
create the stimulus signal.  The duration of the entire stimulus will be 5 
milliseconds. Tones will be presented at the following frequencies:  500 Hz, 
1000 Hz, 2000 Hz, and 4000 Hz.  For each frequency, level will vary from 80 
dB SPL to 5 dB SPL in 5 dB decrements. 

Run SigGenRP 

To run SigGenRP 
 Double-click the SigGenRP icon. 

To build the SigGenRP signal from scratch 
 Choose New from the File menu. 

  
BioSigRP\files\TnstRP.sig 
 

To follow along using a Quick Start file 
1. Choose Open from the File menu. 

2. Select the file listed in the left margin.   

To bypass the SigGenRP signal design process 
 Exit SigGenRP by choosing Exit from the file menu and skip to Running 

the BioSigRP Experiment.  (Look for the Quick Start icon!). 

Configure the RPx device and RCO file 
For System 3 equipment SigGenRP uses the RPx device and  RCO files (See 
RPvds help) to play out signals.  

To configure the RPx device and select the RCO file 

1. Select RP devices|Device A from the Modify menu or click on the “A” icon 
on the tool bar. 

2. Select from the Standard file menu “Sweep Play, 2 Chan 50k (100k max). 

3. Select RP2 Processor as device type. 

4. Select Index 1. 

5. Deselect  “Use sample rate specified in RCO file.” 

Under Bandwidth and Timing change the Standard Sample Rate to 25kHz 
(ignore the number of time slices). 
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The RPx device selected determines what hardware device (RP2.1, RV8, RA16) 
is used to generate the stimulus, the number of channels, and the sample rate.  

Define the Signal Parameters 

To define the signal parameters 
1. Select Signal from the Modify menu of the main window. 

2. Enter or select the following parameters in the Signal Parameters dialog 
box: 

 Name: Tone 
 Timing 
 Duration: 5 milliseconds 
 Calibration 
 Level: 90 dB  = 9 volts 

Note:  This is a temporary calibration setting.  You should set the 
calibration values according to the output of your system. 

Define the Variables 
This example will use two variables.  The first, Freq, will vary the tone 
frequency as follows:  500 Hz, 1000 Hz, 2000 Hz, and 4000 Hz.  The second, 
Level, will cause the tone level to vary from 80 dB SPL to 5 dB SPL in 5 dB 
decrements for each frequency. 
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Controlling Frequency 
 

 

Tone frequency will be controlled through use of the variable, Frequency.  The 
values of this variable will be determined through a method known as Value 
List.  Value List allows you to specify a sequential list of values. 

 
 

 
Because each frequency will be presented at 16 output levels, a Repeat Factor 
of 16 must be defined for the variable Frequency. 

Stimulus presentation will be controlled through the use of a feature called 
Boundary Control.  When boundary control is enabled, data acquisition halts 
once the boundary conditions have been met. 

To define the variable, Freq 
1. Select Signal from the Modify menu of the main window. 

2. Click the Edit button in the Variables group box of the Signal Parameters 
dialog box. 

3. Enter or select the following parameters in the Signal Variable dialog box: 

 General 
 Name: Freq 
 Method: Value List 
4. Click Edit List and enter the following: 500 

1000 
2000 
4000 

5. Set the remaining parameters as follows: 

 Value Limits 
 Default/Start: 500 
 Minimum: 500 
 Maximum: 4000 

 SGI Modifiers 
 Repeat Factor: 16 
 Termination Control 
 Boundary Control:  

 



   Chapter 6: Quick Start Examples 6-7 

  BioSigRP User's Guide 

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 

 
 
 
 
 
 
 
 
 

 
 

Controlling Output Level 
Output level can be controlled by employing one of two types of attenuation:  
digital attenuation or analog attenuation.  When using digital attenuation, level 
is controlled by modifying the signal parameters through SigGenRP.  When 
using an analog attenuator such as a PA5, level is controlled via the hardware 
device.  In this example, digital attenuation is used.  For an example of analog 
attenuation, see Chapter 7. 

Tone level will be controlled digitally through the use of the variable, Level.  
For each tone frequency, Level will vary from 80 dB to 5 dB in 5 dB 
decrements.  Because the values of Level must repeat for each value of 
Frequency, Level must be defined with a Termination Control of Loop. 

To define the variable, Level 
1. Click on 2.  .......... in the Variables list box. 

2. Enter or select the following parameters in the Signal Variable dialog box: 

 General 
 Name: Level 
 Units: dB 
 Method: Linear Step 
 

 Value Limits 
 Default/Start: 80 
 Step Size: -5 
 Minimum: 5 
 Maximum: 80 
 Termination Control 
 Loop:  

 

To accept the variable parameters and return to the Signal 
Parameter dialog box 
 Click the OK button in the Signal Variable dialog box. 
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To accept the signal parameters and return to the SigGenRP 
main window 
 Click the OK button in the Signal Parameters dialog box. 

Create the Segments and Components 
Each SigGen signal consists of at least one segment.  Each segment in turn 
consists of one to three components.  In this example, the tone consists of one 
segment which in turn consists of one component. 

Creating the Segment 
You will be creating a segment that consists of one component, a pure tone.  
SigGenRP provides a method for gating the pure tone segment, Gate Type.  You 
will be defining a Gate Type of Cos2 and a Gate Time of 2 milliseconds. 

To create the segment 
1. Choose Segment... from the Modify menu. 

2. Enter or select the following parameters in the Edit Signal Segments dialog 
box: 

 Select: Seg[1] 
 Gate Type: Cos2 
 Gate Time: 2 msec 
 Duration: 5 msec 

Creating the Component 
You may generate a tone in either the time domain or the frequency domain.  
Generation method is specified in the Gen. Meth field.  Time is the default 
generation method.  Time domain generation is employed in this example. 

 

To create a component for the segment 
1. Click the first button in the Components group box. 

2. Enter or select the following parameters in the Component Parameters 
dialog box: 

 Call: Tone 
 Level: Choose the variable, Level 
 Frequency: Choose the variable, Freq 
 Phase: 270 

Note:  Phase is specified in degrees Cosine.  In order 
to generate a signal with a zero crossing onset, Phase 
must be defined as 270 degrees. 

3. Click the OK button to accept the component parameters. 
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To return to SigGenRP's main window 
 Click OK in the Edit Signal Segments dialog box. 

 

Save the SigGen File 
You will be using this SigGen file to generate a stimulus signal through 
BioSigRP.   

To save the SigGen file 
1. Chose Save from the File menu. 

2.    Enter in C:\TDT\SigGenRP\BioSigRP\Files\tnst2.sig in the File Name field. 
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Running the BioSigRP Experiment 
 Once you have designed the stimulus signal with SigGenRP and saved the 

SigGenRP file, you are ready to setup BioSigRP and begin collecting ABR data.  
In this example, you will present the single-channel stimulus signal via 
headphones and acquire single-channel response data.  This example assumes 
that you will amplify and filter the ABR response data prior to digitization.  
BioSigRP will collect 10 milliseconds of ABR data for each stimulus 
presentation.  Averaged ABR data will be computed using an N of 500. 

Run BioSigRP 

To run BioSigRP 
Double-click the BioSigRP icon. 

Note:  To run this experiment, you must either create the BioSigRP file by 
following along with the step-by-step instructions or open the existing Quick 
Start file. 

 
BioSigRP\files\TnstRP.acf 

To use a Quick Start file 
1. Choose Open from the File menu. 

2. Select the file listed in the left margin.   

To bypass experiment setup and begin running the experiment 
 Skip to Run the Experiment. 

Setup the Stimulus Parameters 
During stimulus setup, you will define the presentation rate, and specify the 
SigGenRP file. 

The Presentation Rate is the number of times the stimulus will be presented per 
second.  The Presentation Period, measured in milliseconds, is the inverse of 
the Presentation Rate.  The Presentation Period must be at least 1.25 times the 
total amount of time required to present the stimulus signal and acquire response 
data.  For this example, a rate of 20 presentations per second, or a period of 50 
milliseconds, will be sufficient. 

 
 
 
 

 

Previously, you saved the stimulus signal parameters in a SigGenRP file called 
tnst2.sig.  Now you must specify the stimulus channel in BioSigRP.  You may 
use the file you created, tnst2.sig, or the one provided, tnst.sig.  You must 
specify one of these two files in the Channel 1 SigGenRP File field.  The 
stimulus parameters found in the SigGenRP file will be read by BioSigRP and 
used to generate the stimulus signal.  Later, when you save the BioSigRP 
configuration file (.acf file), these parameters will be saved within that file.   
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To setup the stimulus parameters 
1. Select Stimulus from the Setup menu of the main window. 

2. Enter or select the following parameters in the Stimulus Setup dialog box: 

 Presentation 
 Rate: 20 /sec 
 Period: 50 milliseconds 
  
 Channel #1 
 SigGen File: C:\TDT\SigGenRP\BioSigRP\Files\TnstRP.sig (or 

tnst2.sig) 

 

To accept the stimulus setup parameters and return to the main 
window 
 Click OK. 
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Setup the Acquisition Parameters 
Prior to running the experiment, you must define the acquisition timing 
parameters and specify a record file (.arf file).   

Acquisition timing parameters include:  Onset Delay, the delay in onset of data 
acquisition from the beginning of stimulus presentation; Duration, the duration 
of the acquired signal; and Sample Period, the time between successive data 
points of the digital response signal. 

During data averaging, completed averages are appended to the end of a file 
know as the BioSig record file (.arf file).  You specify the default .arf file in the 
Response Record File Name field.  When Prompt for File Name is enabled, you 
will be automatically prompted to enter a file name prior to stimulus 
presentation.  This is useful should you wish to use a file other than that 
specified as the default.  You may disable automatic prompting by unchecking 
Prompt for File Name. 

To setup the acquisition parameters 
1. Select Acquisition... from the Setup menu of the main window. 

2. Enter or select the following parameters in the Acquisition Setup dialog 
box: 

 Response Record File  
 Name: C:\TDT\SigGenRP\BioSigRP\Files\TNST.ARF 
Prompt for File Name:  

 
 
 

 
 
The options that you 
have for the acquisition 
circuits are based on 
the number of 
acquisitions and 
maximum sample rate.  
ABR usually require a 
25 kHz sample period.  
For DPOAE use the 
continuous record.  

 



   Chapter 6: Quick Start Examples 6-13 

  BioSigRP User's Guide 

To setup acquisition Channel 1 
1. Click the Chan-1 button. 

2. Enter or select the following parameters in the Acquisition Channel Setup 
dialog box: 

 Configuration 
 Number of Averages: 500 
 Gain: 10 

 

The Gain field is used to remove the effects of hardware amplification of the 
response signal.  Thus, if you have used amplification hardware to apply a gain 
of 100,000 to the response signal, you would specify 100,000 in the Gain field.  
If you use the Medusa amplifier with a low impedance headstage BioSigRP will 
prompt you to set the gain to 10x (or 20 for devices with serial numbers greater 
than 2000) each time you open the acquisition window. While this can be a 
minor annoyance in the beginning once you have set up the system you will not 
have to modify this again. 

Enabling AC Couple causes BioSigRP to remove any DC components from the 
signal by subtracting the signal average. 

You may wish to reject anomalous signals.  By enabling Artifact Rejection,  you 
can specify at which peak amplitude you wish to reject an acquired signal.  This 
amplitude is specified as a percentage of the A/D threshold of + 10 volts.   

 

To accept the Channel 1 acquisition parameters and return to the 
Acquisition Setup dialog box 
 Click the OK button of the Acquisition Channel Setup dialog box. 

To accept the acquisition setup parameters and return to the 
main window 
 Click OK button of the Acquisition Setup dialog box. 
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Save the Configuration File 
You will want to save the configuration file for future experiment sessions. 

To save the configuration file 
1.    Choose Save from the File menu. 

2.    Enter C:\TDT\SigGenRP\BioSigRP\Files\TNST.ACF in the File Name field. 

Run the Experiment 
See the “Hardware 
Configuration” section 
of Chapter 1. 

Before running the experiment, you should check the hardware configuration. 

Running 

To begin stimulus presentation 
 Click the Start button. 

For more information 
about the Multi-Purpose 
Area, see Chapter 2. 
 

You are now in Running Mode.  The stimulus signal is presented according 
to the parameters you specified during setup.   
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Averaging 

To begin data averaging 
 
 
Hint: 
Use the Multi-Purpose 
plot to view acquired 
data in real time. 
 
For more information 
about the Multi-Purpose 
Area, see Chapter 2. 

1. Click the Begin button. 

2. Enter any subject information and click OK. 

You are now in Averaging Mode.  Upon each trigger, the acquired ABR 
response data will be included in the running average until 500 response 
signals have been obtained and averaged.  In the Multi-Purpose plot, you 
may view the current stimulus, the raw A/D signal, the EEG signal, or the 
running average.  As averages are completed (when N=500), the averaged 
ABR records will be appended to the History plot and the .arf file. 
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Real-Time Comparison 
You may view the running average in real-time in the Multi-Purpose Plot.  You 
may choose to overlay the running average with a comparison record selected 
from the History Plot.  For this example, the first ABR obtained will serve as a 
nice comparison, since it was obtained as a response to a tone of large 
amplitude.   

To make the first ABR record a comparison record 
1. Click on the first record displayed in the History Plot. 

Note:  If several records have been obtained, you may have to scroll to the 
top of the History Plot. 

2. Choose Make Comparison from the History menu. 

To view the running average 
1. Click the right mouse button in the Multi-Purpose Plot. 

2. Drag the pointer until it is above . 

3. Release the right mouse button. 

To superimpose the comparison record 
 Check Show Comparison on the Multi Plot menu. 
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Termination 
Because you enabled Boundary Control when creating the stimulus signal in 
SigGen, data averaging will automatically halt once the 4000 Hz tone has been 
presented at all 16 levels.  Stimulus presentation, however, will continue.   

As you monitor ABR acquisition, however, you may decide that data acquisition 
should be manually terminated.  

To manually terminate data acquisition 
 Hit the End button. 

 

At this point, you may halt stimulus presentation or run the experiment again. 

To halt stimulus presentation 
 Click Stop. 

To run the experiment again 
1. Click Begin. 

2. Enter in the new subject information. 
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Analyze the Data 
BioSigRP does not automatically determine threshold levels.  Instead, BioSigRP 
allows the user to place cursors on peaks in selected ABR records.  Each cursor 
will provide the user with peak values and latencies.  The experienced 
clinician/experimenter can use these values to determine when a threshold has 
been achieved. 

Using Cursors 
Once the experiment has been run and ABR data have been obtained, you will 
want to analyze the results.  In this experiment, ABR peak levels and latencies 
are analyzed through the use of cursors.   

To place a cursor 
 Double click the desired record in the History Plot. 

You will see the Cursor Edit dialog box. 

To place cursors on peaks 
 Double click each peak. 

Note:  Cursors have a default number (e.g., 1, 2, 3...) and a default name (e.g., I, 
II, III...).  Cursor numbers and default names are assigned in the order in which 
cursors are created.  Therefore, you should create cursors in ascending order. 

To customize a cursor label 
1. Click the cursor. 

2. Enter the customized text. 

3. Hit TAB to leave the field and update the cursor label. 
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Note that after you click on a cursor, its label is surrounded by a box.  This 
indicates that the cursor is currently selected.  Once a cursor is selected, you can 
view its instantaneous time and level values.  Additionally, you may view the 
time and level difference between the selected cursor and Cursor  1.  In the 
illustration below, time and level differences are shown in the fields labeled T5 - 
T1 and L5 - L1 fields, respectively. 

To view instantaneous time and level values 
 Click on the desired cursor. 

To return to the main BioSig window 
 Click OK. 

Making Comparisons 
Recall that you previously designated the first ABR record as a comparison 
record.  Once you have placed cursors in the comparison record, it is possible to 
compare its cursor values to those of other records. 

To compare cursor values 
1. Double click the desired ABR record 

2. Check the Show Comparison box found in the Comparison Data group box. 
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Select the desired ABR record to compare to, and select Toggle Comparison 
from the History menu. (After this option is selected, the desired ABR record 
should be colored red). 

Double click on any other ABR record to compare it to the red ABR record. 

Note: Any cursors that were designated on the signal that is being compared 
(green) will be displayed in the Cursor Edit window. 

 

 

The comparison record will be simultaneously displayed with the current ABR 
record.  The placement of comparison record cursors 1 and 2 are indicated by 
vertical dashed lines. 
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Note:  In some instances, you will be more interested in comparing values 
associated with higher latency peaks, such as Peak V.  In this case, the cursor 
marking Peak V should be the first or second cursor placed. 

In the Comparison Data group box the following information is displayed: 

Delta T1 The difference in time between current Cursor 1 and comparison 
Cursor 1. 

Delta T2 The difference in time between current Cursor 2 and comparison 
Cursor 2. 

Delta V This parameter is specifically designed for experiments that 
examine the degree of amplitude reduction.   

To return to the main BioSigRP window 
 Click OK. 

Building Reports and Manipulating Data 
You may wish to view specific records in a report format.  You may also wish to 
perform mathematical operations on one or more record.  You may doing so by 
placing specific records in the Worksheet. 

 
 
For more information 
about selecting History 
Plot records, see 
Chapter 2. 

To place a record in the Worksheet 
1.   Select the desired record in the History Plot. 

2.   Drag the record into the Worksheet. 

 

For more information 
about Worksheet 
formatting and 
calculator options, see 
Chapter 5. 

You may format the Worksheet in a variety of ways.  You may also apply 
various calculator functions to Worksheet records.  For our example, it may be 
useful to display the cursors placed in each record. 

To display cursors 
1. Click the right mouse button anywhere in the Worksheet except directly 

over a record or a record label.   

You will see the Worksheet Preferences dialog box. 

2. Check the Show Cursors box. 

3. Click OK. 
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Example 2:   Using a Click Stimulus 

 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 Alternating 

Variable 

 Combination 
Variable 

 Uniphasic Click 

 

This experiment is designed to gather auditory brainstem response (ABR) data 
in response to a rectangular-pulse click stimulus.  During presentation, the 
stimulus will alternate between a condensation click and a rarefaction click,  
thereby canceling any artifacts such as electromagnetic stimulus effects and 
cochlear microphonic effects.  Click level will vary from 80 dB SPL to 5 dB 
SPL in 5 dB decrements.   

The Quick Start files necessary to run this experiment are as follows: 

 SigGen signal file 
 SigGenRP\BiosigRP\Files\ClickRP.sig 

 BioSig configuration file
 SigGenRP\BioSigRP\Files\ClickRP.acf 

To run the experiment, you will need to perform the following steps: 

1. Build the SigGen Signal. 

a. Run SigGenRP. 

b. Define the signal parameters. 

c. Define polarity and level variables. 

d. Create the segment and component. 

e. Save the SigGen file. 

2. Run the experiment with BioSigRP. 

a. Run BioSigRP. 

b. Setup the stimulus parameters. 

c. Setup the acquisition parameters. 

d. Calibrate the system. 

e. Save the .acf file. 

f. Run the experiment. 

g. Analyze the data. 

Note:  Only those parameters to be entered or selected are given below.  All 
other parameters will remain according to the default settings. 
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Building the SigGenRP Signal 
 In this example, you will use TDT’s signal generation software, SigGenRP, to 

create the stimulus signal.  The duration of the entire stimulus will be 5 
milliseconds.  A 0.1 millisecond, single channel, rectangular-pulse click will be 
presented.  With each successive presentation, the click phase will alternate.  
Thus, the click will alternate between a condensation click and a rarefaction 
click.  Click level will vary from 80 dB SPL to 5 dB SPL in 5 dB decrements. 

Run SigGenRP 

To run SigGenRP 
 Double-click the SigGenRP icon. 

To build the SigGen signal from scratch 
 Choose New from the File menu. 

 
BioSigRP\files\ClickRP.sig 

To follow along using the Quick Start file 
1. Choose Open from the File menu. 

2. Select the file listed in the left margin.   

To bypass the SigGen signal design process 
 Exit SigGenRP by choosing Exit from the File menu and skip to Running 

the BioSigRP Experiment.  (Look for the Quick Start icon!) 

Configure the RPx device and RCO file 
For System 3 equipment SigGenRP uses the RPx device and  RCO files (See 
RPvds help) to play out signals.  

To configure the RPx device and select the RCO file 

1. Select Rp devices|Device A from the Modify menu or click on the “A” icon 
on the tool bar. 

2. Select from the Standard file menu “Sweep Play, 1 Chan 100k (200k max). 

3. Select RP2 Processor as device type 

4. Select Index 1. 
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Define the Signal Parameters 

Define the Signal Parameters 

To define the signal parameters 
1. Select Signal from the Modify menu of the main window. 

2. Enter or select the following parameters in the Signal Parameters dialog 
box: 

 Name: Click 
 Timing 
 Duration: 5 milliseconds 
 Calibration 
 Level: 90 dB  = 9 volts 

Note:  This is a temporary calibration 
setting.  You should set the calibration 
values according to the output of your 
system. 
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Define the Variables 
This example will use two variables.  The first, Polarity, will cause the stimulus 
to alternate between a condensation click and a rarefaction click.  The second, 
Level, will cause click level to vary from 80 dB SPL to 5 dB SPL in 5 dB 
decrements. 

Controlling Polarity 

 

You will alternate the variable Polarity through the use of the Variable Method: 
Alternating.  Variables assigned the method Alternating switch between the 
values specified in the Minimum and Maximum fields with each presentation 
trigger. 

To define the variable, Polarity 
1. Select Signal from the Modify menu of the main window. 

2. Click the Edit button in the Variables group box of the Signal Parameters 
dialog box. 

3. Enter or select the following parameters in the Signal Variable dialog box: 

 General 
 Name: Polarity 
 Method: Alternating 

 Value Limits 
 Default/Start: 1 
 Step Size: 0 
 Minimum: -1 
 Maximum: 1 

 

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 
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Controlling Output Level 
In this example, click level will vary from 80 dB SPL to 5 dB SPL in 5 dB 
steps.  In the previous example, you accomplished a similar variation digitally 
through SigGenRP variable manipulation.  However, when digital attenuation is 
used, signal level is attenuated while noise remains constant, resulting in output 
signal-to-noise ratios that decrease as signal level decreases.  On the other hand, 
when analog attenuation is employed, both noise and signal are attenuated at the 
same rate, holding signal-to-noise ratio constant as signal level decreases.  
Therefore, in this example analog attenuation is employed through use of a PA5 
programmable attenuator.   

The PA5 attenuation level is programmed as follows: 

Attenuation level = click level - Level 

where click level equals 90 dB (or whatever output a 9 volt click produces on 
your system) and Level is a SigGenRP variable that varies from 80 dB SPL to 5 
dB SPL in 5 dB decrements.  The attenuation level will be calculated through 
the use of a combination variable. 

To define the variable, Level 
1. Click on 2.  .......... in the Variables list box. 

2. Enter or select the following parameters in the Signal Variable dialog box: 

 General 
 Name: Level 
 Units: dB 
 Method: Linear Step 
 Combination Variable 
 Variable: Constant 
 Operation: = Vcomb - V 
 Value: 90 

 Value Limits 
 Default/Start: 80 
 Step Size: -5 
 Minimum: 5 
 Maximum: 80 
 Termination Control 
 Boundary Control:  

 

When Level = 80 dB, the combination variable = Vcomb-V 
= 90-Level 
= 10 dB (which is the attenuation 

applied to the PA5). 
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To accept the variable parameters and return to the Signal 
Parameter dialog box 
 Click the OK button in the Signal Variable dialog box. 

To define the programmable attenuator and set it's level 
1. Set Attenuator Device = PA5 - 1. 

2. Set Attenuator Level = Level. 

To accept the signal parameters and return to the SigGen main 
window 
 Click the OK button in the Signal Parameters dialog box. 

Create the Segments and Components 
Each SigGen signal consists of at least one segment.  Each segment in turn 
consists of one to three components.  In this example, the click consists of one 
segment which in turn consists of one component. 

Creating the Segment 

To create the segment 
1. Choose Segment... from the Modify menu. 

2. Enter or select the following parameters in the Edit Signal Segments dialog 
box: 

 Select: Seg[1] 
 Gate Type: None 
 Start: 0.1 msec 
 Duration: 1 msec 
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Creating the Component 
The call Click has been designed to create a bi-phasic click.  To design a 
uniphasic click, simply leave null values in the fields Level Two and Dur Two.  
This will effectively remove the second portion of the bi-phasic click. 

To create a component for the segment 
1. Click the first button in the Components group box. 

2. Enter or select the following parameters in the Component Parameters 
dialog box: 

 Call: Click 
 Level One: 90 dB (or whatever output is produced by a 9 volt 

click) 
 Level Two: 0 dB 
 Polarity: Choose the variable, Polarity 
 Dur. One: 0.1 ms 
 Dur Two: 0 ms 

3. Click the OK button to accept the component parameters. 

 

To return to SigGenRP's main window 
 Click OK in the Edit Signal Segments dialog box. 
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Save the SigGenRP File 
You will be using this SigGenRP file to generate a stimulus signal through 
BioSigRP.   

To save the SigGen file 
1.  Chose Save from the File menu. 

2.  Enter in C:\TDT\SigGenRP\BioSigRP\Files\click2.sig in the File Name field. 

Running the BioSigRP Experiment 
 Once you have designed the stimulus signal with SigGenRP and saved the 

SigGenRP file, you are ready to setup BioSigRP and begin collecting ABR data.  
In this example, you will present the single-channel stimulus signal via 
headphones and acquire single-channel response data.  This example assumes 
that you will amplify and filter the ABR response data prior to digitization.  
BioSigRP will collect 10 milliseconds of ABR data for each stimulus 
presentation.  Averaged ABR data will be computed using an N of 500. 

Run BioSigRP 

To run BioSigRP 
 Double-click the BioSigRP icon. 

Note:  To run this experiment, you must either create the BioSigRP file by 
following the step-by-step instructions or open the existing Quick Start file. 
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BioSigRP\Files\ClickRP.acf 

To follow along using the Quick Start file 
1. Choose Open from the File menu. 

2. Select the file listed in the left margin.   

To bypass experiment setup and begin running the experiment 
 Skip to Run the Experiment 

Setup the Stimulus Parameters 
During stimulus setup, you will define the presentation rate, and specify the 
SigGenRP file. 

The Presentation Rate is the number of times the stimulus will be presented per 
second.  The Presentation Period, measured in milliseconds, is the inverse of 
the Presentation Rate.  The Presentation Period must be at least 1.25 times the 
total amount of time required to present the stimulus signal and acquire response 
data.  For this example, a rate of 20 presentations per second, or a period of 50 
milliseconds, will be sufficient. 

 
 
 
 
 

You may have previously saved the stimulus signal parameters in a SigGenRP 
file called Click2.sig.  Now you need to specify either Click2.sig or the file 
provided by TDT, ClickRP.sig, in the Channel 1 SigGenRP File field.  The 
stimulus parameters found in this SigGenRP file will be read by BioSigRP and 
used to generate the stimulus signal.  Later, when you save the BioSigRP 
configuration file (.acf file), these parameters will be saved within that file. 

 
To setup the stimulus parameters 
1. Select Stimulus from the Setup menu of the main window. 

2. Enter or select the following parameters in the Stimulus Setup dialog box: 

 Presentation 
 Rate: 20 /sec 
 Period: 50 milliseconds 
 Channel #1 
 SigGen File: C:\TDT\SigGenRP\BioSigRP\Files\ClickRP.sig (or 

click2.sig) 
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To accept the stimulus setup parameters and return to the main 
window 
 Click OK. 

Setup the Acquisition Parameters 
Prior to running the experiment, you must define the acquisition timing 
parameters and specify a record file (.arf file).   

Acquisition timing parameters include:  Onset Delay, the delay in onset of data 
acquisition from the beginning of stimulus presentation; Duration, the duration 
of the acquired signal; and Sample Period, the time between successive data 
points of the digital response signal. This is grayed out and indicates the sample 
period of the RCO circuit. 

During data averaging, completed averages are appended to the end of a file 
known as the BioSigRP record file (.arf file).  You specify the default .arf file in 
the Response Record File Name field.  When Prompt for File Name is enabled, 
you will be automatically prompted to enter a file name prior to stimulus 
presentation.  This is useful should you wish to use a file other than that 
specified as the default.  You may disable automatic prompting by unchecking 
Prompt for File Name. 

To setup the acquisition parameters 
1. Select Acquisition... from the Setup menu of the main window. 

2. Enter or select the following parameters in the Acquisition Setup dialog 
box: 
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Acquire RCO 
 RCO File: C:\TDT\SigGenRP\BioSigRP\bsRCO\Record25Kx4 

 Response Record File   
 Filename: C:\TDT\SigGenRP\BioSigRP\Files\CLICK.ARF 
Prompt for File Name:  

 
 
 

 
 
Use the proper RCO 
circuit for your required 
data acquisition.  In 
general this would be 2-
channel or 4-channel 
acquisition at 25 kHz. 

 

To setup acquisition Channel 1 
1. Click the Chan-1 button. 

2. Enter or select the following parameters in the Acquisition Channel Setup 
dialog box: 

 Configuration 
 Number of Averages: 500 
 Gain: 20 

Enabling AC Couple causes BioSig to remove any DC components from the 
signal by subtracting the signal average. 

You may wish to reject anomalous signals.  By enabling Artifact Rejection,  you 
can specify at which peak amplitude you wish to reject an acquired signal.  This 
amplitude is specified as a percentage of the A/D threshold of + 10 volts. 
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To accept the Channel 1 acquisition parameters and return to the 
Acquisition Setup dialog box 
 Click the OK button of the Acquisition Channel Setup dialog box. 

To accept the acquisition setup parameters and return to the 
main window 
 Click OK button of the Acquisition Setup dialog box. 

Save the Configuration File 
You will want to save the configuration file for future experiment sessions. 

To save the configuration file 
1.    Choose Save from the File menu. 

2. Enter C:\TDT\SigGenRP\BioSigRP\Files\CLICK.ACF in the File Name 
field. 

Run the Experiment 
See the “Hardware 
Configuration” section 
of Chapter 1. 

Before running the experiment, you should check the hardware configuration.   

Running 

To begin stimulus presentation 
 Click the Start button. 
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For more information 
about the Multi-Purpose 
Area, see Chapter 2. 
 

 

You are now in Running Mode.  The stimulus signal is presented according 
to the parameters you specified during setup.  You may view the stimulus 
signal in the Multi-Purpose area.  Previously you defined the variable 
Polarity using the Variable Method: Alternating.  Variables assigned the 
method Alternating, switch between the value specified in the Minimum 
field and the value specified in the Maximum field with each presentation 
trigger.  In this example, the variable Polarity will alternate between 1 and -
1 with each presentation trigger. 
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Averaging 

To begin data averaging 
 
 
Hint: 
Use the Multi-Purpose 
plot to view acquired 
data in real time. 
 
For more information 
about the Multi-Purpose 
Area, see Chapter 2. 

1. Click the Begin button. 

2. Enter any subject information and click OK. 

You are now in Averaging Mode.  Upon each trigger, the acquired ABR 
response data will be included in the running average until 500 response 
signals have been obtained and averaged.  In the Multi-Purpose plot, you 
may view the current stimulus, the raw A/D signal, the EEG signal, or the 
running average.  As averages are completed (when N=500), the averaged 
ABR records will be appended to the History plot and the .arf file. 

 

Real-Time Filtering  

During averaging you can adjust filter setting on the fly using the RP Filter 
Settings boxes in the lower left corner of the BioSigRP main window. To 
change the filter settings, select a value from the drop down list for the built-in 
highpass (HP), lowpass (LP), or notch (NT) filters.
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Real-Time Comparison 
You may view the running average in real-time in the Multi-Purpose Plot.  You 
may choose to overlay the running average with a comparison record selected 
from the History Plot.  For this example, the first ABR obtained will serve as a 
nice comparison, since it was obtained as a response to a click of large 
amplitude.   

To make the first ABR record a comparison record 
1. Click on the first record displayed in the History Plot. 

Note:  If several records have been obtained, you may have to scroll to the 
top of the History Plot. 

2. Choose Make Comparison from the History menu. 

To view the running average 
1. Click the right mouse button in the Multi-Purpose Plot. 

2. Drag the pointer until it is above . 

3. Release the right mouse button. 

To superimpose the comparison record 
 Check Show Comparison on the Multi Plot menu. 
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Termination 
Because you enabled Boundary Control when creating the stimulus signal in 
SigGenRP, data averaging will automatically halt once the value of the variable 
Level reaches 30 dB SPL, the defined minimum value.  Stimulus presentation, 
however, will continue.   

As you monitor ABR acquisition, however, you may decide that data acquisition 
should be manually terminated.  

To manually terminate data acquisition 
 Hit the End button.  

  
At this point, you may halt stimulus presentation or run the experiment again. 

To halt stimulus presentation 
 Click Stop. 

To run the experiment again 
1. Click Begin. 

2. Enter in the new subject information. 
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Analyze the Data 
BioSigRP does not automatically determine threshold levels.  Instead, BioSigRP 
allows the user to place cursors on peaks in selected ABR records.  Each cursor 
will provide the user with peak values and latencies.  The experienced 
clinician/experimenter can use these values to determine when a threshold has 
been achieved. 

Using Cursors 
Once the experiment has been run and ABR data have been obtained, you will 
want to analyze the results.  In this experiment, ABR peak levels and latencies 
are analyzed.  This is accomplished through the placement of cursors.   

To place a cursor 
 Double click the desired record in the History Plot. 

You will see the Cursor Edit dialog box. 

To place cursors on peaks 
 Double click each peak. 

Note:  Cursors have a default number (e.g., 1, 2, 3...) and a customizable name.  
Numbers are assigned in the order in which cursors are created.  It is a nice idea 
to synchronize the default numbers with peak numbers.  Therefore, you should 
create them in ascending order. 

To customize a cursor label 
1. Click the cursor. 

2. Enter the customized text. 

3. Hit TAB to leave the field and update the cursor label. 
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Note that after you click on a cursor, its label is surrounded by a box.  This 
indicates that the cursor is currently selected.  Once a cursor is selected, you can 
view its instantaneous time and level values.  Additionally, you may view the 
time and level difference between the selected cursor and Cursor 1.  In the 
illustration above, time and level differences are shown in the fields labeled T5 - 
T1 and L5 - L1 fields, respectively. 

To view instantaneous time and level values 
 Click on the desired cursor. 

To return to the main BioSigRP window 
 Click OK. 

Making Comparisons 
Recall that you previously designated the first ABR record as a comparison 
record.  Once you have placed cursors in the comparison record, it is possible to 
compare its cursor values to those of other records. 

To compare cursor values 
1. Double click the desired ABR record 

2. Check the Show Comparison box found in the Comparison Data group box. 
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Select the desired ABR record to compare to, and select Toggle Comparison 
from the History menu. (After this option is selected, the desired ABR record 
should be colored red). 

Double click on any other ABR record to compare it to the red ABR record. 

Note: Any cursors that were designated on the signal that is being compared 
(green) will be displayed in the Cursor Edit window. 

 

 

The comparison record will be simultaneously displayed with the current ABR 
record.  The placement of comparison record cursors 1 and 2 are indicated by 
vertical dashed lines. 
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Note:  In some instances, you will be more interested in comparing values 
associated with higher latency peaks, such as Peak V.  In this case, the cursor 
marking Peak V should be the first or second cursor placed. 

In the Comparison Data group box the following information is displayed: 

Delta T1 The difference in time between current Cursor 1 and comparison 
Cursor 1. 

Delta T2 The difference in time between current Cursor 2 and comparison 
Cursor 2. 

Delta V This parameter is specifically designed for experiments that 
examine the degree of amplitude reduction.  It is used for that 
purpose in the example presented in Chapter 7.   

To return to the main BioSigRP window 
 Click OK. 

Building Reports and Manipulating Data 
You may wish to view specific records in a report format.  You may also wish to 
perform mathematical operations on one or more record.  You may doing so by 
placing specific records in the Worksheet. 

 
 
For more information 
about selecting History 
Plot records, see 
Chapter 2. 

To place a record in the Worksheet 
1. Select the desired record in the History Plot. 

2. Drag the record into the Worksheet. 

 

For more information 
about Worksheet 
formatting and 
calculator options, see 
Chapter 5. 

You may format the Worksheet in a variety of ways.  You may also apply 
various calculator functions to Worksheet records.  For our example, it may be 
useful to display the cursors placed in each record. 
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To display cursors 
1. Click the right mouse button anywhere in the Worksheet except directly 

over a record or a record label.   

You will see the Worksheet Preferences dialog box. 

2. Check the Show Cursors box. 

3. Click OK. 
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Chapter 7   Advanced Examples 
The examples in this section use the powerful features of SigGenRP and 
BioSigRP to construct experiments using paradigms taken from the auditory 
sciences literature.  They are not intended to support any particular paradigm, 
but to illustrate how SigGenRP and BioSigRP may be used to design complex 
experiments. 

The examples found in this section are listed below.  Also listed are the concepts 
introduced in each example. 

Example 3  Tone in Continuous Notched Noise 
 Continuous Noise 

 Dual Channel Signals 

Example 4  Tone-on-Tone Forward Masking 
 Constant Variables 

 Repeat Factor 

 Loop 

Example 5  Distortion Product Otoacoustic Emission 
 Radix-2 

 Continuous Stimulus 

 Post Processing 

 Auto-Cursors 
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Example 3:   Tone in Continuous Notched Noise 

 

 
 Continuous Noise 
 Dual Channel 

Signals 
 

In this experiment, ABR data will be collected in response to a tone presented during 
continuous notched noise.  The method used is similar to that described by Stapells, 
et al.1 According to these authors, notched noise can be used to restrict the 
responsiveness of the cochlea to only those frequencies found within the notch.   

Using SigGenRP and RPvdsEx you can design a variety of short duration stimuli.  
You can also control the generation of continuous signals through SigGenRP.  This 
example uses a tone presented in continuous notched noise to illustrate the process 
of designing and controlling an experiment utilizing both short duration and 
continuous signal components.  Masking noise will also be presented to the non-test 
ear. 

To run the experiment, you will need to perform the following steps: 

1. Build the stimulus signal. 

a. Configure the hardware. 

b. Run SigGenRP. 

c. Define the signal parameters. 

d. Define the signal variables. 

e. Specify analog attenuation. 

f. Define the peripheral devices. 

g. Create the segment and 
component. 

h. Save the SigGenRP File. 

2. Build the masking signal and 
continuous notched signal using 
RPvdsEx. Note this circuit is 
already designed for you. 

3. Run the experiment with BioSigRP. 

a. Check the hardware 
configuration. 

b. Run BioSigRP. 

c. Setup the stimulus parameters. 

d. Setup the acquisition parameters. 

e. Save the .acf file. 

f. Run the experiment. 

g. Analyze the data to determine 
threshold levels. 

Note:  Throughout this example, only those parameters to be entered or selected 
are given below.  Parameters not specifically mentioned will remain at their 
default settings. 

                                                           
1Stapell, D. R., Picton, T. W., Durieux-Smith, A., Edwards, C. G., and Moran, L. M. (1990). 

Thresholds for short-latency auditory-evoked potentials to tones in notched noise in normal-
hearing and hearing-impaired subjects.  Audiology, 29, 262-274.  
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Building the SigGenRP Signal 

Configuring the RCO circuit 
In this experiment, you will be generating a stimulus signal consisting of two 
components:  a tone and continuous notched noise.  Additionally, you will want 
to mask the non-test ear by presenting a second channel of continuous noise.  To 
do this it is necessary to modify an Existing SigGenRP circuit.  Each circuit has 
several constructs that are required by SigGenRP and BioSigRP in order to run. 
The first controls the stimulus presentation.  The construct below is part of the 
TINNRP.rco file that comes with BioSigRP. 

SigGenRP can use the parameter tags generated by an RCO file. These 
parameter tags are then maped to a SigGenRP variable.  The variable can have 
all the functionality of a regular SigGenRP variable.  It is even possible to use 
RPvdsEx to generate a circuit that does not require a Signal to be generated in a 
segment window. 
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The first part includes several components that control stimulus presentation and 
duration.  The bottom middle is used by other software to indicate that status of 
each Signal. The bottom section is used to load the signal waveform to the serial 
buffer. These parts of the file should NEVER be modified.   

Run SigGenRP 

To run SigGenRP 
 Double-click the SigGenRP icon. 

To open a new signal window 
 Choose New from the File menu. 

Configure the RPx device and RCO file 
For System 3 equipment SigGenRP uses the RPx device and  RCO files (See 
RPvds help) to play out signals.  

To configure the RPx device and select the RCO file 

1. Select RP devices|Device A from the Modify menu or click on the “A” icon 
on the tool bar. 

2. Select the (…) and choose from the sgRCO folder TINNRP.rco 

3. Select RP2 Processor as device type 

4. Select Index 1. 

5.    Select  “Use sample rate specified in RCO file.” 
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Define the Signal Parameters 
Prior to performing the experiment, you should calibrate the system.  In this 
experiment, level will be measured in dB SPL.  For illustration purposes, we 
will assume that a 9 volt 1000 Hz tone produces an output of 90 dB SPL.  We 
will use this calibration throughout the example.  You should determine the 
actual characteristics of your system. 

To define the signal parameters 
1. Select Signal from the Modify menu of the main window. 

2. Enter or select the following parameters in the Signal Parameters dialog 
box: 

 Name: Tone 
 Timing 
 Duration: 15 milliseconds 
 Calibration 
 Level: 90 dB  = 9 volts 
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Define the Variables 
In this example, you will be defining the parameters of a tone.  You will also 
specify the characteristics of continuous notched noise, including:  noise level, 
notch center frequency, and notch bandwidth.  Finally, you will specify the 
output noise level of the non-test ear masker. 

The parameters necessary to build the tone and to control the notched noise and 
non-test ear masker are presented below. 

 Parameter Variable Method Combination 

Tone Frequency CenterFreq Log Step (base 2) None 
 Level ToneLevel Linear Step None 
 Attenuation 

Level 
ToneAtten Constant = 90 dB  ToneAtten - ToneLevel 

 Phase Phase Constant = 270 None 
 Rise Time RiseTime Log Step (base 2) None 
 Duration Duration Log Step (base 2) None 

Notched Noise Center 
Frequency 

CenterFreq see above None 

 Bandwidth Bandwidth Constant = 1 oct None 
 Level NoiseAtten Constant = 113 NoiseAtten - ToneLevel 

Masker Level MaskerLevel Value List 90 dB - MaskerLevel 

Building the Tone 
Frequency.  Tone frequency will be controlled by the variable, CenterFreq.  
Thresholds will be obtained at the following frequencies:  500 Hz, 1000 Hz, 
2000 Hz, and 4000 Hz.  Fortunately, these frequencies can be computed using a 
logarithmic (base 2) formula.  Specifying a Minimum value of 500, a Maximum 
value of 4000, and a Step value of 1 will generate the following CenterFreq 
values:  500, 1000, 2000, and 4000.  For each value of CenterFreq, the stimulus 
will be repeated while the level varies from 90 dB SPL to 10 dB SPL in 5 dB 
decrements.  Thus, it will be necessary to repeat each frequency 17 times. 



7-8 Chapter 7: Advanced Examples 

BioSigRP User's Guide   

To define the variable, CenterFreq 
1. Double-click 1.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: CenterFreq 
 Units: Hz 
 Method: Log Step (base 2) 
 Value Limits 
 Default/Start: 500 
 Minimum: 500 
 Maximum: 4000 
 SGI Modifiers 
 Repeat: 17 
 Termination Control 
 Boundary Control:  

To accept the variable parameters and return to the Signal Parameters 
dialog box 
 Click the OK button in the Signal Variable dialog box. 

Level.  In order to provide maximum possible signal to noise ratios, Tone level 
will be controlled through analog attenuation.  You will generate a SigGen tone 
with a peak amplitude of 90 dB SPL.  Using a PA4 programmable attenuator, 
you will vary the peak amplitude from 90 dB SPL to 10 dB SPL in 5 dB 
decrements.  To do so, you will use two variables, ToneLevel and ToneAtten. 

To define the variable, ToneLevel 
1. Double-click 2.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: ToneLevel 
 Units: dBSPL 
 Method: Linear Step 
 Value Limits 
 Default/Start: 90 
 Step Size: -5 
 Minimum: 10 
 Maximum: 90 
 Termination Control 
 Loop:  

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 
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To define the variable, ToneAtten 
1. Double-click 3.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: ToneAtten 
 Units: dBSPL 
 Method: Constant 
 Combination Variable 
 Variable: ToneLevel 
 Operation: V - VComb 
 Value Limits 

 Default/Start: 90 

To accept the variable parameters and return to the Signal 
Parameters dialog box 

 Click the OK button in the Signal Variable dialog box. 

Phase.  Tone phase will remain constant at 270 degrees (cosine). 

To define the variable, Phase 
1. Double-click 4.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: Phase 
 Units: deg 
 Method: Constant 
 Value Limits 
 Default/Start: 270 

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 

Rise Time and Duration.  As described by Stapell, et al.,2 rise time and duration 
will vary with frequency.  For each frequency, a tone will have a 2 cycle rise, 
and 1 cycle peak, and a 2 cycle fall.  Since frequency is being controlled through 
the use of a logarithmic (base 2) calculation, both rise time and duration may 
also be controlled through a logarithmic calculation.  At 500 Hz, a 2-cycle 
rise/fall time will equal 4 milliseconds.  A peak duration of 1 cycle will equal 1 
millisecond.  Total duration of the signal will equal 10 milliseconds.  At 4000 
Hz, the rise/fall time will equal .5 milliseconds.  The peak duration will equal 
.25 millisecond.  Total signal duration will equal 1.25 milliseconds.  All values 
between these two extremes may be calculated through use of a logarithmic 
(base 2) function. 

                                                           
2Stapell, D. R., Picton, T. W., Durieux-Smith, A., Edwards, C. G., and Moran, L. M. (1990). 
Thresholds for short-latency auditory-evoked potentials to tones in notched noise in normal-hearing 
and hearing-impaired subjects.  Audiology, 29, 262-274.  
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To define the variable, RiseTime 
1. Double-click 5.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: RiseTime 
 Units: ms 
 Method: Log Step (base 2) 
 Value Limits 
 Default/Start: 4 
 Step: -1 
 Minimum: 0.5 
 Maximum: 4 
 SGI Modifiers 
 Repeat: 17 

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 

To define the variable, Duration 
1. Double-click 6.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: Duration 
 Units: ms 
 Method: Log Step (base 2) 
 Value Limits 
 Default/Start: 10 
 Step: -1 
 Minimum: 1.25 
 Maximum: 10 
 SGI Modifiers 
 Repeat: 17 

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 

Controlling the Notched Noise 
The notched noise will be generated through the RCO file.  A gaussian noise 
with a base level of 90 dB SPL will be generated.  Noise level will be controlled 
through variable, NoiseAtten.  The center frequency of the notch will be 
controlled through use of the previously defined variable, CenterFreq.  The 
bandwidth of the noise will be controlled through the variable, Bandwidth.   

NoiseAtten.  Programming the noise attenuation level is a simple process.  The 
desired output noise level is as follows: 

 Output noise level : = ToneLevel - 23 dB 
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The continuous noise will begin with a level of 90 dB SPL.  The nois must be 
attenuated as follows: 

 Level of attenuation: = 90 dB - Output noise level 

  = 90 dB - (ToneLevel - 23 dB) 

  = 113 dB - ToneLevel 

To define the variable, NoiseAtten 
1. Double-click 7.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: NoiseAtten 
 Units: dB 
 Method: Constant 
 Value Limits 
 Default/Start: 113 
 Combination Variable 
 Operation: V - Vcomb 
 Variable: ToneLevel 

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 

Bandwidth.  Bandwidth will remain constant at 1 octave. 

To define the variable, Bandwidth 
1. Double-click 8.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: Bandwidth 
 Units: oct 
 Method: Constant 
 Value Limits 
 Default/Start: 1 

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 



7-12 Chapter 7: Advanced Examples 

BioSigRP User's Guide   

Controlling the Non-test Ear Masker 
The non-test ear masker will be generated through the RCO file.  A white noise 
with a base level of 90 dB SPL will be generated.  Noise level will be controlled 
through use of the variable, MaskerAtten.  The level of attenuation will be 
frequency specific. 

NoiseAtten.  Programming the noise attenuation level is a simple process.  The 
desired output noise level is as follows: 

Frequency in Hz Level in dB SPL 

 500 Your choice 

 1000 Your choice 

 2000 Your choice 

 4000 Your choice 

The continuous noise will be generated with a base level of 90 dB SPL.  The 
noise must be attenuated as follows: 

 Level of attenuation = 90 dB - Output noise level 

You can easily define a variable that perform this calculation using the correct 
output noise levels for each frequency.  To do so, create a combination variable, 
MaskerLevel. 

To define the variable, MaskerLevel 
1. Double-click 9.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: MaskerLevel 
 Units: dBSPL 
 Method: Value List 
  Your choice 
  Your choice 
  Your choice 
  Your choice 
 Combination Variable 
 Variable: Constant 
 Operation: Vcomb - V 
 Value: 90 
 SGI Modifiers 
 Repeat Factor: 17 

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 

To accept the signal parameters and return to the SigGen 
main window 
 Click the OK button in the Signal Parameters dialog box. 
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Create the Segment and Component 
To create the tone, you must define the parameters for one segment. 

To create the segment 
1. Choose Segment... from the Modify menu. 

2. Enter or select the following parameters in the Edit Signal Segments dialog 
box: 

 Select: Seg[1] 
 Gate Type: Cos2 
 Gate Time: RiseTime 
 Level: 0 dB 
 Gen. Meth.: Time 
 App. Meth.: Add 
 Start: 0 
 Duration: Duration 

To create a component for the segment 
1. Click the first button in the Components group box. 

2. Enter or select the following parameters in the Component Parameters 
dialog box: 

 Call: Tone 
 Level: 90 dB 
 Frequency: CenterFreq 
 Phase: Phase 

3. Click the OK button to accept the component parameters. 

To return to SigGenRP's main window 
 Click OK in the Edit Signal Segments dialog 

box.
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Save the SigGen File 
You will be using this SigGen File to generate a stimulus signal through BioSig.  
Save it with the name tinn.sig (tone in noise). 

To save the SigGen file 
1. Chose Save from the File menu. 

2. Enter in C:\TDT\SigGenRP\BioSigRP\Files\tinn.sig in the File Name field. 

Running the BioSigRP Experiment 
Now that you have created the SigGen file that will be used to generate the tone 
and control the continuous notched noise and non-test ear masker, you are ready 
to run the experiment. 

Check the Hardware 
Prior to running BioSigRP, make sure that all hardware is properly configured.   

Run BioSig 

To run BioSig 
 Double-click the BioSigRP icon. 
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Setup the Stimulus Parameters 
During stimulus setup, you will define the presentation rate and specify the 
SigGenRP file. 

To setup the stimulus parameters 
1. Select Stimulus from the Setup menu of the main window. 

2. Enter or select the following parameters in the Stimulus Setup dialog box: 

 Presentation 
 Rate: 40/sec 
 Period: 25 milliseconds 
 Lock SigGen Files  
 Channel #1 

SigGenRP File: C:\TDT\SigGenRP\BioSigRP\Files\tinn.sig 

 

To accept the stimulus setup parameters and return to the main 
window 
 Click OK. 
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Setup the Acquisition Parameters 
Prior to running the experiment, you must define the acquisition timing 
parameters and specify a record file (.arf file).   

To setup the acquisition parameters 
1. Select Acquisition... from the Setup menu of the main window. 

2. Choose the correct RCO file (sweep Rec 4 channel acquisition) From the 
Acquisition setup menu. 

2. Enter or select the following parameters in the Acquisition Setup dialog 
box: 

 Timing  
 Duration: 20 milliseconds 
Response Record File 

Name: C:\TDT\SigGenRP\BioSigRP\Files\TINN.ARF 
Prompt for File Name:  
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To setup acquisition Channel 1 
1. Click the Chan-1 button. 

2. Enter or select the following parameters in the Acquisition Channel Setup 
dialog box: 

 Configuration 
 Number of Averages: 2000 
 Gain: 20 

 

To accept the Channel 1 acquisition parameters and return to the 
Acquisition Setup dialog box 
 Click OK. 

To accept the acquisition setup parameters and return to the 
main window 
 Click OK. 

Save the Configuration File 
You will want to save the configuration file for future experiment sessions. 

To save the configuration file 
1.   Choose Save from the File menu. 

2.   Enter C:\TDT\SigGenRP\BioSigRP\Files\TINN.ACF in the File Name field. 

Run the Experiment 
You are now ready to run the experiment. 
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Running 

To begin stimulus presentation 
 Click the Start button. 

 You are now in Running Mode.  The tone in continuous notched noise and 
non-test ear masker will be generated according to the parameters you 
defined during SigGenRP and BioSigRP setup. 

 

Averaging 
BioSigRP provides several features that allow you to modify the stimulus 
schedule.  For example, you may wish to obtain multiple averaged responses for 
each stimulus condition.  Such modification may be accomplished through use 
of the SGI Control features displayed in the left portion of the SigGenRP main 
window. 

To repeat each SGI twice 
 Check Each Twice. 

 

To begin data averaging 
1. Click the Begin button. 

2. Enter any pertinent subject information and click OK. 

 You are now in Averaging Mode.  Upon each trigger, the acquired auditory 
brainstem response data will be included in the running average until 2000 
response signals have been obtained.  If you checked Each Twice, two 
averaged responses will be collected for each stimulus condition.   
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Termination 
Once the boundary conditions have been met, BioSigRP will automatically 
terminate data averaging.  However, you may manually terminate data averaging 
at any time. 

To manually terminate data averaging 
 Click the End button. 



7-20 Chapter 7: Advanced Examples 

BioSigRP User's Guide   

You will be returned to Running mode. 

 

To halt stimulus presentation 
 Click Stop. 

Analyze the Data 
As mentioned in previous examples, BioSigRP does not automatically determine 
threshold levels.  Instead, BioSigRP allows the user to place cursors on peaks in 
selected ABR records.  Each cursor provides the user with peak values and 
latencies.  The experience clinician\researcher may use these values to 
determine whether or not a threshold has been achieved. 

To analyze the data 
1. Create a comparison record, if desired. 

a. Select the desired record. 

b. Choose Make Comparison from the History menu. 

2. Double-click in turn on each interesting experimental record in the History 
Plot. 

3. Place cursors on the peaks or valleys of interest. 

4. Enable Show Comparison. 
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Below, a comparison record is displayed superimposed upon an experimental 
record.  The comparison record was obtained in response to a tone of large 
amplitude.  The experimental record is being compared to the comparison record 
to determine whether or not threshold has been reached.  The researcher may use 
any standard technique for determining threshold.  In this case, the amplitude 
difference between P1 and N1 is being examined.  The dashed vertical lines 
indicate the placement of P1 and N1 in the comparison sample.   

Amplitude and latency values may be compared between the two signals.  In this 
illustration, cursor 2, located at N1, is selected.  It’s latency and amplitude 
values are presented in the Time and Level fields.  The difference in amplitude 
and time between the second cursor, N1, and the first cursor, P1, are reported in 
the fields, T2-T1 and L2-L1, respectively.  The RMS amplitude between P1 and 
N1 is reported in the RMS 1>2 field.  The difference in latency between P1 of 
the comparison signal and P1 of the experimental signal is reported in the Delta 
T1 field.  The difference in latency between N1 of the comparison signal and N1 
of the experimental signal is reported in the Delta T2 field.  The percentage 
computed by dividing the difference in amplitude between P1 and N1 of the 
experimental signal by the difference in amplitude between P1 and N1 of the 
comparison record is provided in the Delta V field. 
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Building a Report 
You might want to build a report showing the comparison record and 
experimental records.   

To build the report 
1. Drag the desired History Plot records into the Worksheet. 

2. Drag individual records to the desired location within the Worksheet. 

To display cursors 
1. Click the right mouse button anywhere in the Worksheet except directly 

over a record or a record label.   

You will see the Worksheet Preferences dialog box. 

2. Check the Show Cursors box. 

3. Click OK. 
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Example 4:   Tone-on-Tone Forward Masking 

 

 
 Constant Variables 

 Repeat Factor 

 Loop 

This experiment has been designed to obtaine an ABR masking recovery function 
using tone-on-tone forward masking.  It is assumed that an ABR audiogram has 
already been obtained and that the system has been calibrated.   

Prior to collecting the experimental data, you will obtain an averaged ABR 
waveform in response to an non-masked, 12 kHz tone presented at 20 dB SL for 5 
msec with a 1 msec cosine-shaped rise-fall time.  The P5 amplitude (P5 - N5) of this 
waveform will be used as a reference in the experiment.  You will then conduct a 
tone-on-tone masking experiment.  The probe will consist of a 5 msec 12 kHz tone 
burst presented with a level of 20 dB SL and a 1 msec cosine-shaped rise-fall time.  
The masker will consist of a 5 msec 12 kHz tone burst with a 1 msec cosine-shaped 
rise-fall time.  The masker will precede the probe by ∆Ts of 2, 4, 8, 16, 32, 64, and 
100 msec.  For each ∆T, masker level will be varied in 3 dB increments until the P5 
amplitude, P5 - N5, is reduced from the non-masked P5 amplitude by 50%. 

To run the experiment, you will need to perform the following steps: 

1. Build the non-masked and masked 
SigGen Signals. 

a. Run SigGenRP. 

b. Define the signal parameters. 

c. Define the variables, DeltaT, 
MaskerLevel, AltPhase, and 
ToneDuration. 

d. Create the segment and 
components. 

e. Save the SigGen files. 

 

2. Run the experiment with BioSigRP. 

a. Run BioSigRP. 

b. Setup the stimulus parameters. 

c. Setup the acquisition parameters. 

d. Save the .acf file. 

e. Obtain the reference ABR 
waveform and save it as a 
comparison record. 

f. Mark P5 and N5 on the 
comparison record. 

g. Redefine the SigGen signal. 

h. Run the experiment. 

i. Compare experimental ABR 
records to the comparison 
waveform. 

Note:  Only those parameters to be entered or selected are given below.  All 
other parameters will remain according to the default settings. 

Building the Non-masked Signal 
For reference purposes, you will need to obtained an averaged ABR waveform 
in response to a non-masked signal.  The signal will consist of a 5 msec 12 kHz 
tone presented at 20 dB SL with a 1 msec cosine-shaped rise-fall time. 
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This signals response will then be compared to the response acquired from the 
masked signal which will be created later in the example. For now follow these 
steps to construct the non-masked signal. 

Run SigGenRP 

To run SigGenRP 
 Double-click the SigGenRP icon. 

To open a new signal window 
 Choose New from the File menu. 

Define the Signal Parameters 
Prior to performing the experiment, you should calibrate the system.  In this 
case, it would be best to calibrate the system in dB SL.  For illustration 
purposes, we have assumed that presenting a 9 volt 12 kHz SigGen pure tone 
results in a 90 dB SL output.  We will use this calibration throughout the 
example. 

To define the signal parameters 
1. Select Signal from the Modify menu of the main window. 

2. Enter or select the following parameters in the Signal Parameters dialog 
box: 

 Name: Comparison 
 Timing 
 Duration: 10 milliseconds 
 Calibration 
 Level: 90 dB  = 9 volts 

Configure the RPx device and RCO file 
For System 3 equipment SigGenRP uses the RPx device and  RCO files (See 
RPvds help) to play out signals.  

To configure the RPx device and select the RCO file 

1. Select Rp devices|Device A from the Modify menu or click on the “A” icon 
on the tool bar. 

2. Select the (…) and choose from the sgRCO sweep 50 kHz Tone 

3. Select RP2 Processor as device type 

4. Select Index 1. 

5.    Select  “Use sample rate specified in RCO file.” 
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Define the Variables 
It is necessary to use onset variables to synchronize stimulus play and ABR 
acquisition.  Thus, you should create the onset variable, DeltaT.  For the non-
masked probe, DeltaT will be a constant value of 2 msec.  Additionally, it is 
necessary to alter signal phase so that artifactual data such as cochlear 
microphonic effects may be canceled during averaging.  You should create an 
alternating phase variable, AltPhase. 

 
 
 
 
 
 
 
 
 
 
 

 
 

To define the variable, DeltaT 
1. Select Signal from the Modify menu of the main window. 

2. Click the Edit button in the Variables group box of the Signal Parameters 
dialog box. 

3. Enter or select the following parameters in the Signal Variable dialog box: 

 General 
 Name: DeltaT 
 Units: msec 
 Method: Constant 
 Value Limits 
 Default/Start: 2 
 Minimum: 2 
 Maximum: 100 
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To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 

To define the variable, AltPhase 
1. Double-click 2.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog box: 

 General 
 Name: AltPhase 
 Units: deg 
 Method: Alternating 
 Value Limits 
 Default/Start: 90 
 Minimum: 90 
 Maximum: 270 

Note:  Use of an alternating variable will cause the variable value to alternate 
between the minimum and maximum value with each presentation.   

Note:  Phase is calculated using a cosine function.  Thus, zero crossings occur at 
90 degrees and 270 degrees. 
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To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 

To accept the signal parameters and return to the SigGenRP 
main window 
 Click the OK button in the Signal Parameters dialog box. 

Create the Segment and Component 
Our non-masked reference tone will consist of just one segment.  This segment 
in turn will consist of just one component. 

To create the segment 
1. Choose Segment... from the Modify menu. 

2. Enter or select the following parameters in the Edit Signal Segments dialog 
box: 

 Select: Seg[1] 
 Gate Type: Cos2 
 Gate Time: 1 msec 
 Level: 0 dB 
 Gen. Meth.: Time 
 App. Meth.: Add 
 Start: DeltaT 
 Duration: 5 msec 

To create a component for the segment 
1. Click the first button in the Components group box. 

2. Enter or select the following parameters in the Component Parameters 
dialog box: 

 Call: Tone 
 Level: 20 dB 
 Frequency: 12,000 Hz 
 Phase: AltPhase 

3. Click the OK button to accept the component parameters. 
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To return to SigGenRP’s main window 
 Click OK in the Edit Signal Segments dialog box. 

 

Save the SigGenRP File 
You will be using this SigGenRP file to generate a stimulus signal through 
BioSigRP.   
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To save the SigGen file 
1. Chose Save from the File menu. 

2. Enter in C:\TDT\SigGenRP\BioSigRP\Files\Tont.sig in the File Name field. 

Building the Masked Signal 
The masked signal will be comprised of two segments, a masker and a probe.  
Each segment will consist of a 5 msec 12 kHz tone burst with a 1 msec cosine-
shaped rise-fall time.  The ∆T between the masker and the probe will vary as 
follows: 2, 4, 8, 16, 32, 64, and 100 msec.  For each ∆T, the probe level will 
increase from 20 dB SL in 3 dB increments until a P5 amplitude (P5-N5) of 
50% that seen in the comparison record is achieved. 

Create a New SigGen Signal 

To create a new SigGen signal 
 Choose New from the File menu. 

This will open a new window from which you may design the second SigGen 
signal. 

Define the Signal Parameters 
You should use the shortest sampling period, 5 microseconds.  As in the 
previous signal, a calibration of 90 dB = 9 volts is being assumed for illustrative 
purposes. 

To define the signal parameters 
1. Select Signal from the Modify menu of the main window. 

2. Enter or select the following parameters in the Signal Parameters dialog 
box: 

 Name: ToneOnTone 
 Sample Period: 5 µseconds 
 Timing 
 Duration: 125 milliseconds 
 Calibration 
 Level: 90 dB  = 9 volts 

Define the Variables 
The tone-on-tone masked signal will require the use of four variables, 
ToneDuration, DeltaT, MaskerLevel and AltPhase.   

Defining Component Durations 
The duration of both the masker and the probe will remain at a constant 5 msec.  
You will later be using this duration in a mathematical operation, however.  For 
that reason, you should use a variable, ToneDuration, with a constant value of 5 
msec to define the duration of each component. 
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To define the variable, ToneDuration 
1. Select Signal from the Modify menu of the main window. 

2. Click the Edit button in the Variables group box of the Signal Parameters 
dialog box. 

3. Enter or select the following parameters in the Signal Variable dialog box: 

 General 
 Name: ToneDuration 
 Units: msec 
 Method: Constant 
 Value Limits 
 Default/Start: 5 
 Minimum: -1e10 

 Maximum: 1e10 

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 
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Defining ∆T 
 
 
 
 

 
 

The variable DeltaT will be used to control the variation of the ∆T between the 
masker and the probe.  For each ∆T, the masker level will vary from 20 dB SL 
to 90 dB SL in 3 dB increments, resulting in 24 presentations for each value of 
DeltaT.  You will thus define DeltaT as a Value List variable with values of 2, 
4, 8, 16, 32, 64, and 100 msec.  You will set the Repeat Factor field equal to 24.  
Because you will want averaging to terminate automatically, you will want to 
enable Boundary Control. 

 
For more information 
about combination 
variables, see the 
SigGenRP User's 
Guide. 
 

Note:  In SigGenRP, the temporal placement of a segment is specified in terms 
of onset rather than in terms of its distance in time from the end of a previous 
segment (∆T).  Thus, probe onset must be defined as follows:  
Masker duration + ∆T.  This may be accomplished through use of a 
combination variable.   

To define the variable, DeltaT 
1. Click on 2.  .......... in the Variables list box. 

2. Enter or select the following parameters in the Signal Variable dialog box 

 General 
 Name: DeltaT 
 Method: Value List 

3. Click the Edit List button. 

4. Enter the following: 

 2 
 4 
 8 
 16 
 32 
 64 
 100 

5. Click OK to accept the list 

6. Enter the following parameters: 

Combination Variable 
 Variable: ToneDuration 

 Operation: V + Vcomb 
 SGI Modifiers 

 Repeat Factor: 24 
 Termination Control 
 Boundary Control:  
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Defining the Masker Level 
 

 
 

The variable MaskerLevel will control the variation of the masker level.  Since 
the level of the masker will be varied linearly in steps of 3 dB, MaskerLevel 
may be defined as a linear variable.  Because MaskerLevel will vary for each 
value of the variable DeltaT, it must be assigned a termination control of Loop. 

To define the variable, MaskerLevel 
1. Click on 3.  .......... in the Variables list box. 

2. Enter or select the following parameters in the Signal Variable dialog box: 

 General 
 Name: MaskerLevel 
 Method: Linear Step 
 Value Limits 
 Default/Start: 20 
 Step Size: 3 
 Minimum: 20 
 Maximum: 90 
 Termination Control 
 Loop:  

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 
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Defining Alternating Phase 
To eliminate the effects of artifact such as cochlear microphonic effects, you 
will want to alternate phase through use of the alternating variable, AltPhase. 

Note:  Use of an alternating variable with cause the variable value to alternate 
between the minimum and maximum value with each presentation.   

Note:  Phase is calculated using a cosine function.  Thus, zero crossings occur 
at 90 degrees and 270 degrees. 

To define the variable, AltPhase 
1. Double-click 4.  ........ in the Variables list 

2. Enter or select the following parameters in the Signal Variable dialog box: 

 General 
 Name: AltPhase 
 Unit: deg 
 Method: Alternating 
 Value Limits 
 Default/Start: 90 
 Minimum: 90 
 Maximum: 270 

To accept the variable parameters and return to the Signal 
Parameters dialog box 
 Click the OK button in the Signal Variable dialog box. 
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To accept the signal parameters and return to the SigGenRP 
main window 
 Click the OK button in the Signal Parameters dialog box. 

Create the Segments and Components 
Our SigGen signal will consist of two components, the masker and the probe. 

To create the masker segment 
1. Choose Segment... from the Modify menu. 

2. Enter or select the following parameters in the Edit Signal Segments dialog 
box: 

 Select: Seg[1] 
 Gate Type: Cos2 
 Gate Time: 1 msec 
 Level: 0 dB 
 Gen. Meth.: Time 
 App. Meth.: Add 
 Start: 0 msec 
 Duration: ToneDuration 

To create a component for the masker segment 
1. Click the first button in the Components group box. 

2. Enter or select the following parameters in the Component Parameters 
dialog box: 

 Call: Tone 
 Level: MaskerLevel 
 Frequency: 12,000 Hz 
 Phase: AltPhase 

3. Click the OK button to accept the component parameters. 

 



7-36 Chapter 7: Advanced Examples 

BioSigRP User's Guide   

To create the probe segment 
1. Click the New button. 

2. Enter or select the following parameters in the Edit Signal Segments dialog 
box: 

 Select: Seg[2] 
 Gate Type: Cos2 
 Gate Time: 1 msec 
 Level: 0 dB 
 Gen. Meth.: Time 
 App. Meth.: Add 
 Start: DeltaT 
 Duration: ToneDuration 

To create a component for the probe segment 
1. Click the first button in the Components group box. 

2. Enter or select the following parameters in the Component Parameters 
dialog box: 

 Call: Tone 
 Level: 20 dB 
 Frequency: 12,000 Hz 
 Phase: AltPhase 

3. Click the OK button to accept the component parameters. 

 

 

To return to SigGenRP’s main window 
 Click OK in the Edit Signal Segments dialog box. 
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Save the SigGenRP File 
You will be using this SigGenRP File to generate a stimulus signal through 
BioSigRP.   

To save the SigGen file 
1. Chose Save from the File menu. 

2. Enter in C:\TDT\SigGenRP\BioSigRP\Files\tone.sig in the File Name field. 

Running the BioSigRP Experiment 
Now that you have created both the non-masked and masked probe signal, you 
are ready to setup BioSigRP, collect a reference ABR, and collect ABR data in 
response to the masked probe.  This example assumes that you will use some 
hardware amplification and filtering prior to digitization.  You will collect 10 
milliseconds of ABR data for each stimulus presentation.  Averaged ABR data 
will be computed using an N of 500.   

Run BioSigRP 

To run BioSigRP 
 Double-click the BioSigRP icon. 
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Setup the Stimulus Parameters 
During stimulus setup, you will define the presentation rate and specify the 
SigGenRP file. 

You will be presenting the entire stimulus two times per second.  Thus the 
Presentation Rate will equal 2/sec and its inverse, Presentation Period, will equal 
500 milliseconds. 

You must first obtain a reference averaged ABR waveform in response to the 
non-masked tone.  Previously, you saved the non-masked probe stimulus 
parameters in a SigGenRP file called tone.sig.  Now you must specify this file in 
the Channel 1 SigGenRP File field.  The stimulus parameters found in this 
SigGenRP file will be read by BioSigRP and used to generate the stimulus 
signal.  Later, when you save the BioSigRP configuration file (.acf file), the 
signal generation parameters will be saved within that file.   

To setup the stimulus parameters 
1. Select Stimulus from the Setup menu of the main window. 

2. Enter or select the following parameters in the Stimulus Setup dialog box: 

 Presentation 
 Rate: 2/sec 
 Period: 500 milliseconds 
 Lock SigGen Files  
 Channel #1 

 SigGen File: C:\TDT\SigGenRP\BioSigRP\Files\tone.sig 

 

To accept the stimulus setup parameters and return to the main 
window 
 Click OK. 



  Chapter 7: Advanced Examples 7-39 

  BioSigRP User's Guide 

Setup the Acquisition Parameters 
Prior to running the experiment, you must define the acquisition timing 
parameters and specify a record file (.arf file).   

Acquisition timing parameters include the following:  (1) Onset Delay, the delay 
in onset of data acquisition from stimulus presentation; (2) Duration, the 
duration of the acquired signal; and (3) Sample Period, the time in microseconds 
between successive data points of the digital response signal.   

For both the non-masked and masked SigGenRP signals, you used a variable, 
DeltaT, to indicate probe onset time.  To ensure that you begin ABR data 
acquisition upon presentation of the probe, you should use this same variable to 
specify the onset of data acquisition. 

During data averaging, completed averages are appended to the end of a file 
know as the BioSigRP record file (.arf file).  The default .arf file is specified in 
the Response Record File Name field.  When Prompt for File Name is enabled, 
you will be automatically prompted to enter a file name prior to stimulus 
presentation.  This is useful should you wish to use a file other than that 
specified as the default.  You may disable automatic prompting by unchecking 
Prompt for File Name. 

To setup the acquisition parameters 
1.   Select Acquisition... from the Setup menu of the main window. 

2.   Enter or select the following parameters in the Acquisition Setup dialog box: 

 Timing 

 Onset Delay: 2 
 SG Variable: DeltaT 
 Duration: 10 msecs  
 

Acquire RCO 
 RCO File: C:\TDT\SigGenRP\BioSigRP\bsRCO\Record25Kx4 

 Response Record File   
 Filename: C:\TDT\SigGenRP\BioSigRP\Files\TONE.ARF 
Prompt for File Name:  
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To setup acquisition Channel 1 
1. Click the Chan-1 button. 

2. Enter or select the following parameters in the Acquisition Channel Setup 
dialog box: 

 Configuration 
 Number of Averages: 500 
 Gain: 20 
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To accept the Channel 1 acquisition parameters and return to the 
Acquisition Setup dialog box 
 Click OK. 

To accept the acquisition setup parameters and return to the 
main window 
 Click OK. 

Save the Configuration File 
You will want to save the configuration file for future experiment sessions. 

To save the configuration file 
1.   Choose Save from the File menu. 

2.   Enter C:\TDT\SigGenRP\BioSigRP\Files\TONE.ACF in the File Name field. 

Obtain a Control Record 
You must present the non-masked probe and obtain a response ABR for use as a 
comparison. 

Running 

To begin stimulus presentation 
 Click the Start button. 

You are now in running mode.  The non-masked 12 kHz probe tone will be 
presented according to the parameters you defined during the setup procedure. 
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Averaging 

To begin data averaging 
1. Click the Begin button. 

2. Enter any pertinent subject information and click OK. 

 You are now in Averaging Mode.  Upon each trigger, the acquired auditory 
brainstem response data will be included in the running average until 500 
averaged response signals have been obtained.  In the Multi-Purpose plot, 
you may view the current stimulus, the raw A/D signal, the EEG signal, or 
the running average.  As averages are completed (when N=500), the 
averaged ABR records will be appended to the History plot and to the .arf 
file. 
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Termination 
Once BioSig has averaged 500 ABR records, the resulting average will be 
displayed in the History Plot.  You may then terminate data averaging and 
stimulus presentation.  Or, if you would like additional reference records, you 
may continue to obtain ABR data. 

To terminate data averaging 
 Click the End button. 

You will be returned to Running mode. 

 

To halt stimulus presentation 
 Click Stop. 

Make a Comparison Record 
You now should have one or more reference ABR records.  Choose one to use 
as a comparison.  For this experiment, you will want to place two cursors in the 
comparison record, one at P5 and another at N5. 

 
 
For more information 
about selecting History 
Plot records, see 
Chapter 2. 

To make a comparison record 
1. Select the desired record. 

2. Choose Make Comparison from the History menu. 

To place cursors 
1. Double click the comparison record. 

2. Double click the left mouse button on P5. 

3. Type P5 in the Text field. 

4. Double-click the left mouse button on N5. 

5. Type N5 in the Text field. 

6. Click OK to return to the BioSig main window. 
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Run the Experiment 
You are now ready to run the experiment, with the exception of one small detail.  
Currently, the SigGen file is defined as tone.sig, the file containing the 
parameters necessary to create the non-masked tone stimulus.  You must define 
the SigGen file as tont.sig, the file containing the parameters necessary to create 
the probe and masker stimulus. 

To change the SigGen file 
1.   Choose Stimulus from the Setup menu. 

2. Enter C:\TDT\SigGenRP\BioSigRP\Files\tone_mask.sig in the SigGenRP 
File field. 

3.   Click OK to return to the BioSigRP main window. 

Running 
You are now ready to run the experiment. 

To begin stimulus presentation 
 Click the Start button. 

 You are now in Running Mode.  The 12 kHz probe and masker will be 
presented according to the parameters you defined during setup. 
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Averaging 

To begin data averaging 
1. Click the Begin button. 

2. Enter any pertinent subject information and click OK. 

 You are now in Averaging Mode.  Upon each trigger, the acquired auditory 
brainstem response data will be included in the running average until 500 
response signals have been obtained.  In the Multi-Purpose plot, you may 
view the current stimulus, the raw A/D signal, the EEG signal, or the 
running average.  As averages are completed (when N=500), the averaged 
ABR records will be appended to the History plot and the .arf file. 

 

Real-Time Comparison 
You have already defined a comparison record.  You may wish to view the 
running averaged superimposed upon the comparison record.   

To view the running average 
1. Click the right mouse button in the Multi-Purpose Plot. 

2. Drag the pointer until it is above . 

3. Release the right mouse button. 

To superimpose the comparison record 
 Check Show Comparison on the Multi Plot menu. 
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Termination 
Once the boundary conditions have been met, BioSigRP will automatically 
terminate data averaging.  However, you may manually terminate data averaging 
at any time. 

To manually terminate data averaging 
 Click the End button. 

You will be returned to Running mode. 

 

To halt stimulus presentation 
 Click Stop. 

Analyze the Data 
In this example, the probe is considered to be masked when the value of P5 - N5 
is reduced to 50% of that seen in the comparison ABR record.  Recall that the 
comparison record was an averaged ABR record obtained in response to a non-
masked probe. 
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You have already placed cursors at P5 and N5 of the comparison record.  Now 
to analyze the data, you must compare the Peak V amplitude (P5 - N5) of the 
comparison record to that of the experimental data.  To do so, you must place 
cursors at P5 and N5 of the experimental data.  It should not be necessary to 
place cursors in all of the experimental records.  A quick visual scan of the 
History Plot should help you determine which records are most likely to exhibit 
a 50% reduction in Peak V amplitude.   

To analyze the data 
1. Double-click in turn on each interesting experimental record in the History 

Plot. 

2. Double-click on P5. 

3. Enter P5 in the Text field. 

4. Double-click on N5. 

5. Enter N5 in the Text field. 

6. Check the Show Comparison box. 

7. Examine the value of Delta V. 

 When this value is 50% or less, masking has been achieved. 

Note: Delta V displays a percentage calculated as follows: ∆V of the 
current record / ∆V of the Comparison record * 100, where ∆V equals the 
level of Cursor 2 minus the level of Cursor 1.  Since you have defined 
Cursor 2 to be N5 and Cursor 1 to be P5, Delta V will display the percent of 
P5 - N5 reduction. The figure shown below illustrates the steps described 
above. It does not reflect the actual ABR response to the applied stimulus. 
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Building a Report 
You might want to build a report showing the comparison record and 
experimental records.   

To build the report 
1. Drag the desired History Plot records into the Worksheet. 

2. Drag individual records to the desired location within the Worksheet. 

To display cursors 
1. Click the right mouse button anywhere in the Worksheet except directly 

over a record or a record label.   

You will see the Worksheet Preferences dialog box. 

2. Check the Show Cursors box. 

3. Click OK. 
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Example 5:   Distortion Product Otoacoustic 
Emission 

 

 
 Radix-2 

 Continuous 
Stimulus 

 Post Processing 

 Auto-cursors 
 

In this experiment, distortion-product otoacoustic emission (DPOAE) data will be 
collected in response to a combination tone presented continuously.  Distortion-
product data will be collected every 167.7 milliseconds.  In this experiment, it is 
assumed that the distortion product reflects the integrity of the cochlea at a 
frequency located at the geometric mean between F1 and F2 where F1 is the 
frequency of primary 1 and F2 is the frequency of primary 2.3  Throughout this 
example the measurement frequency of the cochlea will be referred to as the 
audiometric frequency.  The integrity of the cochlea will be measured at the 
following audiometric frequencies:  250 Hz, 500 Hz, 1000 Hz, 2000 Hz, 4000 Hz, 
and 8000 Hz.  The frequencies of primary 1, named Tone 1, and primary 2, named 
Tone 2, will be geometrically centered about the audiometric frequency.  The 
frequency of Tone 2 will be determined as follows: F2 = 1.2 * F1.  Level of the two 
primary tones will remain equal and will vary with each frequency from 80 dB SPL 
to 50 dB SPL in 10 dB decrements. 

To run the experiment, you will need to perform the following steps: 

1. Build the primary tones. 

a. Configure the hardware. 

b. Run SigGenRP. 

c. Define the signal parameters. 

d. Define the signal variables. 

e. Create the segment and 
component. 

f. Save the SigGenRP file. 

 

2. Run the experiment with BioSigRP. 

a. Check the hardware 
configuration. 

b. Run BioSigRP. 

c. Setup the stimulus parameters. 

d. Setup the acquisition parameters. 

e. Define auto-cursors. 

f. Save the .acf file. 

g. Run the experiment. 

h. Analyze the data to determine 
threshold levels. 

                                                           
3Osterhammel, P. A. and Rasmussen, A. N. (1992).  Distortion product otoacoustic emissions:  

Basic properties and clinical aspects.  The Hearing Journal, 45(11), 38-41. 
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Configuring the Hardware 
In this experiment, you will be using SigGenRP to generate two signals, one for 
each primary tone.  The dual channel stimuli will be presented via a probe.  
Single channel emission data will be collected.   

Configure the RPx device and RCO file 
For System 3 equipment SigGenRP uses the RPx device and  RCO files (See 
RPvds help) to play out signals.  

To configure the RPx device and select the RCO file 

1. Select RP devices|Device A from the Modify menu or click on the “A” icon 
on the tool bar. 

2. Select the continous acquire at 50kHz 

3. Select RP2 Processor as device type 

4. Select Index 1. 

5. Select  “Use sample rate specified in RCO file.” 

Building Tone 1 

Run SigGenRP 

To run SigGenRP 
 Double-click the SigGenRP icon. 

To open a new signal window 
 Choose New from the File menu. 

Define the Signal Parameters  
Prior to performing the experiment, you should calibrate the system.  In this 
experiment, level will be measured in dB SPL.  For illustration purposes, we 
will assume that a 1 volt 1000 Hz tone produces an output of 80 dB SPL.  We 
will use this calibration throughout the example.  You should determine the 
actual characteristics of your system. 

 
 
 
 
 
 
 

 
 

It is often useful to define signal length so that the number of data points in the 
digital signal is specified in terms of radix-2.  This is particularly important if the 
signal is to be played continuously by looping through the signal buffer.  SigGenRP 
provides a function that truncates an original length and returns a radix-2 length.  In 
this example, let's assume that you want a signal length of approximately 200 
milliseconds.  By using the radix-2 function, SigGenRP will calculate the next 
longest duration so that the signal consists of a number of data points specified in 
terms of radix-2.  Use of radix-2 is illustrated below. 
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To define the signal parameters 
1. Select Signal from the Modify menu of the main window. 

2. Enter or select the following parameters in the Signal Parameters dialog 
box: 

 Name: Tone 1 
 Timing 
 Duration: 200 milliseconds 
3. Click the Rad-2 button. 

 The duration will be recalculated as 167.772 milliseconds.  Using the 
sampling period of 20 microseconds, the number of data points in the signal 
will be 8192. 

4. Enter the remaining signal parameter information: 

 Calibration 
 Level: 80 dB  = 1 volts 

Define the Variables 
In this example, you will be creating two separate signals, Tone 1 and Tone 2.  
These signals will be created with two separate SigGen files.  In cases where 
stimuli are generated from two separate files, one file must be chosen as 
dominant, and must contain definitions for all variables used in the generation of 
both signals.   

You should create the following variables for Tone 1:   

 Parameter Variable Method Combination 

Tone 1 Audiometric 
frequency 

AudFreq Log Step (base 2) None 

 Tone 1 frequency F1 .909 .909 * AudFreq 

 Tone 2 frequency F2 1.09 1.09 * AudFreq 

 Level Level Linear Step 80 - Level 

Note:  Previously, it was stated that the frequencies of Tone 1 and Tone 2 would 
be geometrically centered about the audiometric frequency.  Also, it was stated 
that the frequency of Tone 2 would equal 1.2 times the frequency of Tone 1.  
Multiplying the audiometric frequency by .909 and 1.09 calculates the desired 
frequencies for Tone 1 and Tone 2, respectively.  These frequencies meet both 
conditions stated above. 

 

Audiometric frequency.  The audiometric frequency will be controlled by the 
variable, AudFreq.  Thresholds will be obtained at the following frequencies:  
250 Hz, 500 Hz, 1000 Hz, 2000 Hz, 4000 Hz, and 8000 Hz.  These values are 
computed through the application of a logarithmic (base 2) step.  Specifying a 
Minimum value of 250, a Maximum value of 8000, and a Step value of 1 will 
generate the desired frequencies.  For each value of AudFreq, the stimulus will 
be repeated while the level varies from 80 dB SPL to 50 dB SPL in 10 dB 
decrements.  Thus, it will be necessary to repeat each frequency 4 times. 
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To define the variable, AudFreq 

1. Double-click 1.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: AudFreq 
 Units: Hz 
 Method: Log Step (base 2) 
 Value Limits 
 Default/Start: 250 
 Step Size: 1 
 Minimum: 250 
 Maximum: 8000 
 SGI Modifiers 
 Repeat: 4 
 Termination Control 
 Boundary Control:  

To accept the variable parameters and return to the Signal Parameters 
dialog box 
 Click the OK button in the Signal Variable dialog box. 

Tone 1 frequency.  The frequency of Tone 1 will be controlled by the variable, 
F1.  The value of F1 will be computed as a function of the audiometric 
frequency such that F1 = .909AudFreq. 

To define the variable, F1 

1. Double-click 2.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: F1 
 Units: Hz 
 Method: Constant 
Combination Variable: 
 Variable: AudFreq 
 Operation: V*Vcomb 
 Value Limits 

 Default/Start: .909 

To accept the variable parameters and return to the Signal Parameters 
dialog box 
 Click the OK button in the Signal Variable dialog box. 

Tone 2 frequency.  The frequency of Tone 2 will be controlled by the variable, 
F2.  The value of F2 will be computed as a function of the audiometric 
frequency such that F2 = 1.09AudFreq. 
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To define the variable, F1 

1. Double-click 3.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: F2 
 Units: Hz 
 Method: Constant 
Combination Variable: 
 Variable: AudFreq 
 Operation: V*Vcomb 
 Value Limits 
 Default/Start: 1.09 

To accept the variable parameters and return to the Signal Parameters 
dialog box 
 Click the OK button in the Signal Variable dialog box. 

Level.  In this example, analog attenuation is used.  Analog attenuation ensures 
that signal-to-noise ratio remains constant as the signal level decreases.  The 
PA4 programmable attenuator will be controlled through the use of the 
combination variable Level.   

To define the variable, Level 

1. Double-click 4.  ........ in the Variables list. 

2. Enter or select the following parameters in the Signal Variable dialog 
box: 

 General 
 Name: Level 
 Units: dBSPL 
 Method: Linear Step 
 Combination Variable 
 Variable: Constant 
 Value: 80 
 Operation: Vcomb - V 
 Value Limits 
 Default/Start: 80 
 Step Size: -10 
 Minimum: 50 
 Maximum: 80 
 Termination Control 

      Loop:        

To accept the variable parameters and return to the Signal 
Parameters dialog box 

 Click the OK button in the Signal Variable dialog box. 

Now that the variable Level has been defined, it must be assigned to the 
appropriate programmable attenuator. 
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To enable analog attenuation 
 Enter the following: 

 Attenuation 
 Device: PA5-1 
 Level: Level 

To accept the signal parameters and return to the main 
SigGenRP window 
 Click OK. 

Create the Segment and Component 
To create Tone 1, you must define the parameters for one segment consisting of 
one component. 

Because the tone will be played continuously by looping through the signal 
buffer, it must be generated in the frequency domain.  Generation of the signal 
in the time domain will result in a discontinuity upon looping.  Such a 
discontinuity typically introduces a click into the signal. 

To create the segment 
1. Choose Segment... from the Modify menu. 

2. Enter or select the following parameters in the Edit Signal Segments dialog 
box: 

 Select: Seg[1] 
 Gate Type: None 
 Level: 0 dB 
 Gen. Meth.: Freq: (4096) 
 App. Meth.: Add 
 Start: 0 
 Duration: 163.84 

To create a component for Tone 1 
1. Click the first button in the Components group box. 

2. Enter or select the following parameters in the Component Parameters 
dialog box: 

 Call: Tone 
 Level: 80 
 Frequency: F1 
 Phase: 0 

3. Click the OK button to accept the component parameters. 

To return to SigGenRP’s main window 
 Click OK in the Edit Signal Segments dialog box. 
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Save the SigGenRP File 
You will be using this SigGenRP file to generate a stimulus signal through 
BioSigRP.  Save it with the name dpoaef1.sig. 

To save the SigGenRP file 
1.   Chose Save from the File menu. 

2.   Enter in C:\TDT\SigGenRP\BioSigRP\Files\dpoaef1.sig in the File Name  
field.  

Building Tone 2 
Tone 2 will differ from Tone 1 only in frequency and the definition of a 
programmable filter.  The file for Tone 2 may be created by copying the 
information from Tone 1. 

Copy Tone 1 
If you have not already saved C:\TDT\SigGenRP\BioSigRP\Files\dpoaef1.sig, 
do so now following the instructions above. 

To copy the information from Tone 1 to Tone 2  
1.   Chose Save As from the File menu. 

2. Enter in C:\TDT\SigGenRP\BioSigRP\Files\dpoaef2.sig in the File Name 
field. 

Modify the Attenuation Information 
You must specify a programmable attenuator for Tone 2. 
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To specify the programmable attenuator 
1. Choose Signal from the Modify Menu. 

2. Enter the following information: 

 Attenuation: 
 Device: PA5-2 
 Level: Level 

Modify the Segment and Component 
You must modify the frequency so that it is appropriate for Tone 2. 

To modify the component 
1. Choose Segment... from the Modify menu. 

2. Click the first button in the Components group box. 

3. Enter or select the following parameters in the Component Parameters 
dialog box: 

 Call: Tone 
 Level: 80 
 Frequency: F2 
 Phase: 0 

4. Click the OK button to accept the component parameters. 

To return to SigGenRP's main window 
 Click OK in the Edit Signal Segments dialog box. 

 

Save the modified SigGenRP File 
Now that you have made changes to dpoaef2.sig, you must save these changes. 

To save the SigGenRP file 
 Chose Save from the File menu. 
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Running the BioSigRP Experiment 
Now that you have created the SigGen files that will be used to generate the 
primary and secondary tones, you are ready to run the experiment. 

To run BioSigRP 
 Double-click the BioSigRP icon. 

Setup the Stimulus Parameters 
 
 
 

 

During stimulus setup you will define the presentation as continuous and specify the 
SigGen file. 

Continuous presentation provides a means for presenting a continuous SigGen 
stimulus.  When presenting a stimulus in continuous mode, BioSigRP repeatedly 
loops through the signal buffer, playing the signal continuously. 

To setup the stimulus parameters 
1. Select Stimulus from the Setup menu of the main window. 

2. Enter or select the following parameters in the Stimulus Setup dialog box: 

 Presentation 
 Continuous  
 Channel #1 
 SigGen File: C:\TDT\SigGenRP\BioSigRP\Files\dpoaef1.sig 
 Channel #2 
 SigGen File: C:\TDT\SigGenRP\BioSigRP\Files\dpoaef2.sig 
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To accept the stimulus setup parameters and return to the main 
window 
 Click OK. 

Setup the Acquisition Parameters 
Prior to running the experiment, you must define the acquisition timing 
parameters and specify a record file (.arf file).   

To setup the acquisition parameters 
1.   Select Acquisition... from the Setup menu of the main window. 

2.   Enter or select the following parameters in the Acquisition Setup dialog box: 

Acquire RCO 
 RCO File: C:\TDT\SigGenRP\BioSigRP\bsRCO\ConRec50Kx2 

 Response Record File   
 Filename: C:\TDT\SigGenRP\BioSigRP\Files\DPOAE.ARF 
Prompt for File Name:  

 

To setup acquisition Channel 1 
1. Click the Chan-1 button. 

2. Select Continous Acquire 50 kHz two channels from the RCO file 

3. Select RP2 device and select Index 2 

2. Enter or select the following parameters in the Acquisition Channel Setup 
dialog box: 

 Configuration 
 Number of Averages: 100 
 Gain: 1 

Note:  In this example, we are assuming that a unity gain has been applied.  
You should enter the appropriate gain based on your system. 

To accept the Channel 1 acquisition parameters and return to the 
Acquisition Setup dialog box 
 Click OK. 
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To apply post processing 
 

 

 

 

 

 

1.   Click Post Processing. 

2.   Enter or select the following 
parameters in the Post Processing 
window: 

 Fourier 

 Hanning Window   

 Mag Spectrum (dB)  

A fast fourier transform (FFT) will be 
applied to the response signal as it is 
acquired.  As frequency domain signals 
are acquired, they will be placed in the 
History Plot. 

 

To accept the acquisition setup parameters and return to the 
main window 
 Click OK. 

Define Auto-Cursors 
 
 

 

BioSigRP’s auto-cursor capability is specifically designed to meet the needs of 
researchers collecting distortion product otoacoustic emission data.  Through 
specification of a simple equation, the researcher may direct BioSigRP to 
automatically place cursors in all acquired data, whether such data is in the time or 
frequency domains. 

In this example, a cursor will be placed automatically at the anticipated 
frequency of the distortion product, 2F1 - F2, where F1 is the frequency of Tone 
1 and F2 is the frequency of Tone 2.  This is accomplished by the specification 
of an auto-cursor equation.   

Variable names are not used in auto-cursor equations.  Instead, auto-cursor 
equations use a variable numbering system where Vn defines the variable that 
appears in the nth position in the SigGenRP variable list.  In this example, F1 
was the second variable defined, and thus will be denoted by the auto-cursor 
variable, V2.  Because F2 was the third variable defined it will be denoted by the 
auto-cursor variable, V3. 
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To define the auto-cursor equation 
1. Choose Auto-Cursors... from the Setup menu. 

2. Click  #1 to select auto-cursor one. 

3. Check  Enable to enable the Algebraic Equation field. 

4. Enter the equation 2*V2-V3 in the Algebraic Equation field. 

5. Click the Parse button to parse the equation. 

6.    Parse the other two auto-cursors as shown in the figure below. 

7. Click Done. 

 

Save the Configuration File 
You will want to save the configuration file for future experiment sessions. 

To save the configuration file 
1.   Choose Save from the File menu. 

2. Enter C:\TDT\SigGenRP\BioSigRP\Files\DPOAE.ACF in the File Name 
field. 

Run the Experiment 
You are now ready to run the experiment. 

Running 

To begin stimulus presentation 
 Click the Start button. 
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 You are now in Running Mode.  The two primary tones will be generated 
according to the parameters you defined during SigGenRP and BioSigRP 
setup. 

 

Averaging 

To begin data averaging 
1.   Click the Begin button. 

2.   Enter any pertinent subject information and click OK. 

You are now in Averaging Mode.  Upon each trigger, the acquired distortion 
product signal will be included in the running average until 100 response signals 
have been obtained.    
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Termination 
Once the boundary conditions have been met, BioSigRP will automatically 
terminate data averaging.  However, you may manually terminate data averaging 
at any time. 

To manually terminate data averaging 
 Click the End button. 

You will be returned to Running mode. 

 

To halt stimulus presentation 
 Click Stop. 

Analyze the Data 
As mentioned in previous examples, BioSigRP does not automatically determine 
threshold levels.  Instead, BioSigRP allows the user to place cursors on peaks in 
selected data records.  Each cursor provides the user with peak values and 
latencies.  The experienced clinician/researcher may use these values to 
determine whether or not a threshold has been achieved.  In this example, a 
cursor has been automatically placed at the suspected distortion product 
frequency. 
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To analyze the data 
1. Create a comparison record, if desired. 

a. Select the desired record. 

b. Choose Make Comparison from the History menu. 

2. Double-click in turn on each interesting experimental record in the History 
Plot. 

3. Enable Show Comparison if you wish to overlay a comparison plot. 

In the below example, the auto-cursor function has placed  cursor II at 
14539.35 Hz.  The peak has an amplitude that is reduced from the primary 
tone’s amplitude by approximately 60 dB. 

 

Building a Report 
The worksheet provides you with three basic functions. First, it allows you to 
graphically organize acquired data.  Second, it allows you to perform 
mathematical manipulations of the acquired data.  Third, by choosing to 
generate a report, you may output data for use by other applications. 

To build the report 
1.   Drag the desired History Plot records into the Worksheet. 

2.   Drag individual records to the desired location within the Worksheet. 
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To display cursors 
1. Click the right mouse button anywhere in the Worksheet except directly 

over a record or a record label.   

You will see the Worksheet Preferences dialog box. 

2. Check the Show Cursors box. 

3. Click OK. 

 

 

Generating a Report 

To save worksheet data to a report file 
1.   Choose Export toCSV file ... from the Worksheet menu. 

2.   Select and enter all desired information. 

3.   Choose Generate Report. 
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Appendix A Using BioSigRP with 
System II 

This appendix provides the information needed to use BioSigRP with System II 
Hardware.  

While SigGenRP and BioSig continue to support System II hardware we 
recommend continuing to use the version of SigGen and BioSig that was 
purchased with System II hardware whenever possible. SigGenRP and 
BioSigRP are configured for System 3 by default. If you decide to use them with 
System II contact TDT for assistance with reconfiguring the software. 

Requirements 
In order to run BioSigRP with System II hardware, you must have the following: 

 TDT's AP2 Array Processor 

 APOS ONBOARD software (latest version available) 

 TDT's XBUS hardware  

Minimum 
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The minimum System II configuration is illustrated above.  This system consists 
of analog to digital conversion (AD1), digital to analog conversion (DA1), and a 
transducer (HB6).  Please note that a TG6 is also included in the illustration.  A 
TG6 is required to run BioSigRP and must be connected as shown. 
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Basic 
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Most BioSigRP systems require more functionality than that provided by the 
minimum configuration.  A typical System II configuration is illustrated above.  
With this system, the TG6 can be used to trigger the following: an optional 
scope, single or dual channel stimulus presentation through the DA1, and data 
acquisition through the AD1.  The FT5 is used as an anti-aliasing filter for the 
stimulus output.  The two PA4s provide programmable attenuation for both 
stimulus channels.  If the stimulus is to be single channel only, the second PA4 
may be used as a calibration attenuator.  The PC1 is used to provide any 
additional gain and/or filtering to the acquired signal.   
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Complete 
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Some applications will require a more complete System II configuration.  Such a 
configuration is illustrated above.  This system is similar to that presented in the 
previous section with the addition of several components.  The two waveform 
generators (WG2s) may be used to generate masking noise.  The PF1 and two 
additional PA4s may be used to filter and/or attenuate the masking signals.  The 
SW2 programmable cosine switch is used to apply a gate to the masker.  The 
SM3 may be used to mix the masker and stimulus signals.  Finally, the MS1 
may be used to monitor the final output signal.   
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Setting up Acquisition 
Sample Period.  The value defined in the Sample Period field of the Acquisition 
Setup dialog box specifies the sample period, the distance in microseconds 
between successive data points, of the digital response signal.  When continuous 
signal play is enabled, the value of Sample Period defaults to 20 microseconds 
and the field is disabled. 

Use DAC Clock.  When Use DAC Clock is checked, BioSigRP will time 
stimulus presentation and data acquisition using the DAC clock instead of the 
computer’s clock.  This option is disabled when continuous play is enabled. 

TDT Digital Biological Amplifier 
The operation of the TDT Digital Biolocal Amplfier (DB4 and HS4) has been 
fully integrated into BioSigRP. 

To access the DB4 Setup dialog, choose DB4 BioAmp from the Setup Menu.  
Refer to the DB4 manual for an explanation of the DB4 settings.  Note that 
settings made in this dialog box will not appear in the display on the DB4.  The 
Lock Channels box will set the same values for all channels. 

 
 

The DB4 has a 1.0 ms group delay when it is operated in 2-channel mode, and a 
2.0 ms group delay when it is operated in 4-channel mode.  To account for the 
group delay, BioSigRP will delay acquisition by the appropriate duration when 
Use DB4 is checked in the Acquisition Setup. 
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Impedance Scan/Impedance Check 
Impedance scanning and checking can be performed from the Operations menu. 

Impedance scanning measures the impedance on each of the channels and 
compares it to the impedance threshold value.  The light next to the average 
status box will turn red if the impedance is higher than the threshold.  The light 
will be green if it is less than the threshold. Impedance scan measures the 
impedance once. 

Impedance check continuously measures the impedance of the electrodes and 
reports the values to the screen. To turn off impedance checking, select 
Impedance Check from the Operations menu.  





 

   

Appendix B Eliminating 60 Hz Noise 
Noise peaks that occur at regular intervals can occur when the system is affected 
by 60 Hz electrical noise. You might not see the peak at 60 Hz if you have a 60 
Hz notch filter in place, but harmonics can still be present.  There are three 
things you can do to minimize BioSigRP recording problems related to electrical 
noise: 

Record in an environment where the 60 Hz noise is limited (like a Faraday 
cage). 

Ensure that the electrode impedances are as close together as possible. If you are 
using a 2 kHz electrode and a 4 kHz electrode, you will only get a reduction in 
the 60 Hz noise and its multiples by half (as opposed to virtually eliminating it 
in the amplifier). A differential amplifier will eliminate signals that are common 
to both the recording and reference electrodes. If the impedances to these 
electrodes are different, the common signals will have different voltages and not 
be subtracted out. 

Set the stimulus presentation rate at something other than a multiple of 60 Hz. 
For example, if the presentation rate were 20 Hz, then it would line up perfectly 
on the 60 Hz noise, and the noise would not be averaged out. Instead, make the 
stimulus presentation rate something like 21 Hz (or 11 Hz, if you wanted to use 
a 10 Hz presentation rate). 
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